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Thank you very much for choosing Nikon. 
This manual is prepared for users of the CL-Quant Ver.3.10 analysis software. 
For trouble-free operation, read this manual before using the program. 

 

No part of this manual may be reproduced or transmitted in any form without Nikon’s permission. 
The specifications of this software and the content of this manual are subject to change without 
notice. 
Every effort has been made to ensure the accuracy of this manual. If you find that any portion of 
this manual is unclear or incorrect, please contact your nearest Nikon representative. 

 

Trademarks: 

Microsoft® and Windows® are either registered trademarks or trademarks of Microsoft 
Corporation in the United States or other countries. 
Intel® and Pentium® are either registered trademarks or trademarks of Intel Corporation in the 
United States or other countries. 
Products and brand names are either registered trademarks or trademarks of their respective 
companies. 
The “TM” and ® marks are not used to identify registered trademarks and trademarks in this 
manual. 
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  Introduction 

Welcome to Nikon’s CL-Quant 3.10 Analysis Software. CL-Quant provides everything you need 
to create high performance microscopy image recognition analyses, on par with custom written 
code, for your imaging experiment. Whether you are performing image based assays, or 
developing new ones, CL-Quant has the tools to get great results.  

This guide is designed to introduce you to CL-Quant.  

 

Learning CL-Quant 

The software can be used in two primary modes: application execution mode and application 
teaching mode. This guide is divided into three main chapters accordingly.  

- Chapter 1 Getting Started with CL-Quant 

Chapter 1 provides a useful overview of the software. The quick start guidecovering recipe 
and procedure execution, data analysis and procedure teachingmay be the only section you 
need to read. 

- Chapter 2 Using CL-Quant 

Chapter 2 provides detailed description of the software interfaces and functions for image 
viewing, data analysis and procedure execution.  

- Chapter 3 Teaching CL-Quant 

Chapter 3 provides detailed instructions for updating and creating application recipes and 
procedures in CL-Quant. 
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  1.1 Installing the Software 

The software must run on a Windows PC running Microsoft .NET version 4.0 or greater.  

If you have a new Windows PC, it probably already has .NET installed. Otherwise you can 
download it freely over the Internet from Microsoft, or from technical support. The CL-Quant 
installer will automatically detect if .NET is not installed, and will provide you with a link to 
download the free installer.  

Once you have installed .NET, you can install CL-Quant. Double click on the executable 
provided to you, and follow the installation instructions.  

 
 NOTE: 

 
  
 - CL-Quant is available only in 64-bit version. Make sure you have the appropriate version 

for your PC. 

- You must have administrator privileges to install CL-Quant. 

 
 
The software has been tested and characterized on platforms similar to the following: 

 

Recommended Platform 

Processor Intel Core 2 Duo or later 

Processor speed 3.0+ GHz 

RAM 8+ GB high speed memory 

Operating System Windows 7, 64 bit 

Disk space 512 GB minimum 
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  1.2 Usage Guidelines 

The following usage guidelines parallel how the software is tested. The guidelines are size 
limitations for the different types of usage (e.g. processing, displaying, teaching, etc.) that can 
be done with multi-dimensional data sets in the software. The limitations assume you have a PC 
configuration that meets or exceeds the recommended platform specifications. Please see the 
discussion session at the end for a detailed explanation. 

- Limitation for CL-Quant Ver. 3.10 

Dimension Usage Max Supported 

X,Y Load and display 400 MB 

 Examine 400 MB 

 Processing 400 MB 

 Segmentation Teaching 36 MB 

 Stitching 400 MB 

Z Load and display 300 planes 

 Examine 300 planes 

 Processing 300 planes 

 Segmentation Teaching 300 planes 

C Load and display 20 channels  

 Examine 20 channels 

 Processing 20 channels 

 Segmentation Teaching 20 channels 

T Load and display NA 

 Examine NA 

 Processing NA 

 Segmentation Teaching NA 

M Load and display NA 

 Examine NA 

 Processing NA 

 Segmentation Teaching NA 

Additional Max objects per frame 256,000 

 Max tracks per M 256,000 

Total limits Total load and display limit (XYZCM) 16 GB 

 Total examine limit (XYCM) 4 GB 

 Total processing limit (XYC) 2 GB 

 Total teaching limit (XYZCM) 1 GB  

 Total session limit (XYZCTM) 360 GB 

 

Discussion 
Limitations are presented in terms of multi-dimensional image dimensions as well as total limits. 
For example, processing is limited in x,y to 400 MB (20,000 x 20,000 8-bit pixels) while display 
can support up to 400 MB (20,000 x 20,000 pixels). Total limits are defined in terms of their 
relevant dimensions. For example, total examine limits are a function of x,y,c (channel), and m 
(position or FOV), while total processing limit does not include the m dimension. This is 
because examination functions (i.e. LUT, threshold overlay, mask overlay, etc.) can be applied 
to multiple FOVs simultaneously, whereas processing (i.e. procedure execution) is done one 
FOV at a time.  
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CL-Quant’s stitching function is only supported through Nikon’s BioStation CT CSV format. 
Simply load the CSV file, and the stitching is done automatically.  

“Load and display” covers loading a list of FOVs, and navigating (zoom, animate in time or Z) 
them, but without applying examination functions (listed in the examination menu).  
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  1.3 CL-Quant Basics 

1.3.1 Window Layout 

When you open the software, you will see a large blank workspace (the main panel in the figure 
below) and two additional panels on the right. The top panel on the right is the data explorer, a 
repository for data objects including “Fields of View” (FOVs) and “Procedures”. The 
multi-tabbed Controls panel at the bottom contains data object information (“Properties” tab) 
and key controls in the “Properties” and “Controls”. 

 
 

When you display procedures and FOVs they will appear in RecognitionFrames (RFrames). 
RFrames are the primary graphical interface in the software. RFrames are described in Section 
2.1.2, “RecognitionFrame”. 

In this section, we describe the supported data objects and file types. Additional information 
about how to use these features for tasks is presented in Chapter 2, “Using CL-Quant” and 
Chapter 3, “Teaching CL-Quant”. 
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1.3.2 File Types 

CL-Quant generates the following file types: 

- CL-Quant TIFF (*.TIFF) 
CL-Quant FOVs (see next section) are saved to TIFF format. The channel, mask and temporal 
arrangement of the FOV’s images will be maintained. The format is an extension of the Open 
Microscopy Environment (OME). The format should be readable in OME compliant software.  

- CL-Quant Procedure (no extension) 
All CL-Quant procedures can be saved to a data file. 

- CL-Quant Procedure List (no extension) 
A procedure list contains an ordered collection of procedures for a single application. It can be 
saved to a data file that does not have an extension. See the Teaching CL-Quant section for 
instructions on assembling procedure lists. 

- CL-Quant Recipe (no extension) 
Functionally equivalent to a procedure list, a recipe is a finalized collection of procedures. 
Unlike a procedure list, recipe update can only be done in the Recipe Console. 

- BioStation Experiment Files (*.JSON) 
BioStation experiments are saved to the JavaScript Object Notation (JSON) format. The JSON 
file format is a data-interchange format that collects the file paths of all BioStation experiment 
images. When a JSON file is loaded, the BioStation CT viewer mode will be activated. 

 

 

1.3.3 Data Objects 

Data objects include Fields of View (FOVs) and procedures. When loaded, data objects will 
appear in the data explorer where they can be selected and displayed.  

 

(1) Fields of View (FOV) 

The FOV and its objects are the primary units of analysis. An FOV can contain: 

- images, 

- segmentation masks, 

- field measurements, 

- object measurements, 

- object measurement statistics,  

- object regions of interest (ROIs). 

 

The FOV objects may also have multiple subset or class memberships. Initially an FOV 
contains sets of images, aligned in x,y and arrayed in up to three dimensions; time, channel 
and z. 

 

- FOV with time extent (a movie) 
A set of images, aligned in x,y, which show a time course experiment. 
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- FOV with channel extent (multi-channel) 
A set of images, aligned in x,y, where each channel image provides different information 
about the x,y field. These could be images taken where the light has passed through 
different fluorescent emission filters, or through different objectives (fluorescence, phase, 
DIC imaging, etc.). All that matters is that the images have the same x,y dimensions; 
conceptually they should also represent the actual Field of View in the real world under the 
scope.  

- FOV with z extent (z-stack) 
A set of images, aligned in x,y, where each z plane shows an image frame acquired at a 
different depth of focus.  

 

CL-Quant currently supports 5 dimensional imaging (x, y, z, time and channel). When a set of 
FOVs is loaded into an FOV list, a positional dimension is added, which enables users to 
navigate through multiple FOV positions (“M” dimension). 

FOV List 
FOVs can be organized into an FOV list. This can be done via drag and drop in the Data 
Explorer. Also, when sets of FOVs are loaded together they will be organized into an FOV List. 
All the FOVs in the list are presented together in the RFrame. The List enables batch 
procedure execution and group based data analysis. Therefore, you should consider loading 
FOVs from the same type of experiment together into a single FOV list. This will facilitate 
batch processing and integrated data analysis. It is less convenient to process and analyze 
data across RFrames.  

 

(2) Procedures 

Procedures encode the processing rules for analyzing FOVs. Procedures enable the software 
to be general purpose (because they can be taught for any application), and yet also provide 
“one-click” application execution and automation for high volume application.  

We strive to make creation of procedures (what we call procedure teaching) easy and flexible, 
so that any scientist can create powerful and high performance analyses for their application, 
on par with custom written code.  

The software currently provides import, enhancement, segmentation, partition, measurement, 
decision and tracking procedures. 

- Import procedure:  
Automates the importing of images on file into collections of FOVs. 

- Enhancement procedure: 
Automates traditional image and binary mask operations and common actions. 

- Segmentation procedure: 
Automates the innovative, machine-learning based confidence mapping. 

- Measurement procedure: 
Automates the calculation of field and objects measurements. 

- Decision procedure: 
Automates the application of innovative, machine-learning based object classifiers which 
assign FOV objects into non exclusive classes (e.g. live cell, dead cell, responder, non 
responder, artifact, etc.). 
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- Tracking procedure: 
Automates the tracking of objects in movies and calculation of kinetic measurements. 

 

 Your ability to create procedures is controlled by the configuration of the software you 
purchased. 

 

Procedure List 
Procedures can be grouped, saved and reloaded as a procedure list file. The procedure list 
provides a way to group and order a set of procedures for consecutive execution. You may 
have been provided with a procedure list for your application when you purchased the 
software.  

Recipes 
Functionally equivalent to a procedure list, a recipe is a finalized collection of procedures. 
Unlike a procedure list, recipe update can only be done in the Recipe Console. 

 

1.3.4 Definitions 

BMP (Bit-Map) Image file format that separately stores the Red, Green and Blue 
components of each pixel in the corresponding image. Images of this type 
usually have a file suffix of “.bmp”. 
 

Channel An FOV can be composed of multiple channels, which can be processed 
either independent of one another or in combination. A BMP image for 
example, once imported is composed of three separate channels for the 
Red, Green and Blue components of the image. 
 

Decision Module The interface that provides the tools necessary to teach and apply a 
Probabilistic Classification Tree to a series of input data or images. This 
mechanism allows the user to label objects and teach the software so 
that it can differentiate between objects considered to be from different 
categories or classes. 
 

Enhancement 
Module 

The interface that provides the ability to enhance an image using general 
purpose image processing functions such as Add, Subtract, Convolve, 
Erode, Dilate, etc. 
 

FOV 
(Field of View) 

A collection of images, organized by channel / mask, z, and temporal 
“dimensions” that are aligned in x,y. Conceptually, FOVs also contain the 
measurements and objects derived from the images. For example, an 
FOV could contain a two channel phase contrast and GFP fluorescence 
movie, aligned in x,y showing both the morphology and protein 
expression of a moving cell over time. After segmentation processing, a 
mask dimension is added with the same x,y,t extent as the original 
channels that defines the cell boundaries dynamically over time. After 
measurement processing, data and object regions of interest are 
associated with the moving cells and stored in the FOV. 
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Import The process by which images or movies are loaded into the software in 
preparation for processing or viewing. Import can be automated with 
import procedures. 
 

List A data object that contains a collection of procedures or FOVs. The 
procedure list can be saved and loaded as a single file. The procedure list 
allows for ordering and batch execution of individual CL-Quant 
procedures. The FOV list allows for the same processing of groups of 
FOVs as well as integrated image and data review. 
 

Mask A mask is a binary image that is typically used as an overlay for a 
particular FOV channel or image. Each Channel can have any number of 
associated masks defined. These masks can be manipulated using the 
Segmentation and Enhancement modules and can serve as arguments 
for many image processing functions. 
 

Measurement Module The module responsible for performing a variety of quantitative 
measurements on FOV images, channels or movies. For example, this 
module can be called upon to measure the area associated with the 
nucleus of a cell or the area of its corresponding cytoplasm. 
 

Movie An FOV whose channels have temporal extent, meaning a series of x,y 
aligned image frames taken at regular time intervals. The movie, for 
example, may be a time series taken of live cells as they move about on a 
substrate. 
 

Procedure A processing step. There are several types of procedures such as 
enhancement procedure, segmentation procedure, measurement 
procedure, etc. Procedures can be saved and subsequently loaded into 
the software to process new data as necessary. They can also be 
modified to accommodate new operations or a new processing flow. 
 

Recipe An ordered collection of processing or measurement steps that when 
executed and applied to an FOV performs the specified operations in the 
appropriate sequence and stores the results for later manipulation or 
examination. 

RecognitionFrame 
(RFrame) 

A user interface that presents one or more FOVs. Complete application 
processing can be applied to the FOV(s) through this one interface. All 
image and data analysis can be done through the single interface as well. 
Both procedures and FOVs are viewed in the RFrame interface. 
 

TIFF 
(Tagged Image File 
Format) 

Image file format originally created by the company Aldus, jointly with 
Microsoft, for use with PostScript printing, TIFF is a popular format for 
high color depth images, along with JPEG and PNG. 
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1.3.5 Hot Keys 

Hot keys are keyboard shortcuts that allow the user to quickly perform a specific function 
without having to click or navigate. Below is a list of available hot key functions. 

- List of hot keys 

Function Context Hot Key 
Open Global Ctrl+O 
Save as Global Ctrl+S 
Reload Global Ctrl+R 
Print Global Ctrl+P 
Undo Global Ctrl+Z 
Redo Global Ctrl+Y 
Next timeframe Global Right arrow 
Previous timeframe Global Left arrow 
First timeframe Global Up arrow 
Last timeframe Global Down arrow 
Next Z Depth Global Ctrl+Up arrow 
Previous Z Depth Global Ctrl+Down arrow 
Hide bottom/right panel Global Ctrl+H 
Toggle bottom/right panel on/off Global Ctrl+T 
Length Global F7 
Area Global Shift+F7 
Angle Global Ctrl+F7 
Annotation and measurement Global Ctrl+Alt+E 
Histogram Global Ctrl+Alt+H 
Object Histogram Global Ctrl+Alt+O 
Mask edit tool Global Ctrl+Alt+M 
LUTs Global Ctrl+Alt+L 
LUTs on/off Global L 
Maximize RFrame Global Ctrl+Alt+Shift+F 
Zoom in Global = 
Zoom out Global - 
Fit to screen Global ` 
Best fit Global 1 
Zoom actual pixel Global 2 
First channel (red) Global R or Ctrl+1 
Second channel (green) Global G or Ctrl+2 
Third channel (blue) Global B or Ctrl+3 
Delete Global Delete 
Zoom to selected object Global Z 
Swap Z/T Global Ctrl+Shift+Delete+D 
Copy overlays to next timeframe Mask editor A 
Copy selected drawn to next timeframe Mask editor S 
Closed freehand shape tool Mask editor C 
Polygon tool Mask editor P 
Straight line tool Mask editor I 
Freehand line tool Mask editor F 
Confirm current shape Mask editor Enter 
Remove last drawn shape Mask editor Esc 
Go to previous zoom level Zoom to rectangle Esc 
Clear annotations Annotation Ctrl+Shift+Delete 
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Function Context Hot Key 
Set regions as Want Soft Matching W 
Set regions as Don't Want Soft Matching D 
Set regions as Background Soft Matching B 
Cancel region drawing Soft Matching Esc 
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  1.4 CL-Quant Preferences 

CL-Quant preferences are options that can be configured to give you important control over 
CL-Quant performance and usability.  

To access the Options window, select “File > Options” from the “File” menu. At the top level 
are buttons to reset, apply or cancel your changes. The reset button will restore the original 
settings from when you first installed CL-Quant.  

 

1.4.1 General Options 

The top level window of the general options allows you to configure the file opening and display 
policies.  

 Load multiple images and procedures as lists 

When this is checked, if multiple images or procedures are loaded at once, they will be 
grouped into FOV and procedure lists respectively. 

 Display when multiple files not in list 

This determines how files are displayed when they are not loaded in a list. 

First If this is selected, the first file only will be displayed. 

All If selected then all the files loaded will be displayed.  
 

None If this is selected, no files will be displayed. They will appear as FOV data objects in the 
data explorer.  
 

Ask If selected, the user is prompted to choose between displaying all and displaying none. 
 

 Stitching Options 

The software provides automated stitching of Nikon BioStation CSV format composite images 
in three modes: 

Fixed CSV file meta-data, which indicates the expected frame overlap, is used to stitch the 
mosaic image without automatic alignment.  
 

User In this mode you can specify the stitched image overlap. When loading, a window 
will appear in which you can type the desired overlap.  
 

Automatic The software will automatically align the input stitching images to create the stitched 
composite. For multi-channel inputs, the first channel (Channel 0) alignment will be 
used for all channels.  
 

 Load and save objects and data 

When this option is checked, FOV data and object ROIs/tracks are saved when saving FOVs. 
If it is unchecked, only images (channels and masks) will be saved.  

 Splash screen 

If checked, the splash screen will be displayed when the software is launched. 

 Confirm exit 

If checked, the software will prompt the user to confirm that he wishes to exit the software.  
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1.4.2 Graphics and Log 

Sub-sections contain graphics and log settings. 

 

(1) Graphics 

 Overlay mouse margin 

How sensitive the software is to mouse-over detection. If the mouse pointer is within the 
pixel range, it will detect the object of interest.  

 Save displayed image line thickness 

Sets the line thickness of overlain object ROIs and tracks in the saved image when using 
the “save displayed image” function. 

 Colorize component display 

If an image channel has an assigned color other than brightfield, check this option to show 
individual channels in their assigned color. Uncheck this option to show individual channels 
as brightfield image, regardless of assigned color. 

 RGB merge 

This specifies the method that will be used to merge a number of color assigned grayscale 
channels into a single R,G,B channel. Note that while the combined channel is primarily for 
visualization, it can also be processed by segmentation procedures. So the mode of 
combination will affect combined channel segmentation processing.  

Simple Each R,G,B component from the color input channels is summed and truncated at 
a maximum 255 value per component.  
 

Best Fit Each R,G,B component from the color input channels is summed, and then each 
component is scaled so that its maximum intensity is 255.  
 

Saturation 
Best Fit 

Each R,G,B component from the color input channels is summed. The R,G,B 
components are summed and the 95th percentile value is determined. The 
components are then scaled individually to 255 based on the value.  

 

 

(2) Log 

In the log section you can adjust the characteristics of CL-Quant’s log file.  

 Verbosity 

Determines the amount of information recorded to the log file.  

 Log File Enabled 

Determines whether a log file will be saved.  

 Formatting 

If checked, a time-stamp will be added to log file output.  
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1.4.3 Advanced Options 

 

 On demand loading 

When this is checked, CL-Quant will load the images you need into memory when needed, 
rather than up front. This can make CL-Quant large image or large image set loading appear 
more responsive, however batch processing will be slower. Check this when you don’t want to 
wait a long time for a large data set to load, and you are unconcerned about total processing 
time. 

 Always name according to file name 

If checked, FOV data objects will have the same name as the saved file. If unchecked, FOV 
will be named using the image meta-data. 

 Memory usage limit  

Limitation used for AVI export and combined channel display. If the value is greater than zero, 
preset limitations are enforced for recipe apply (64 MB) and stitching (324 MB). 

 Large data working folder 

You can specify the location for CL-Quant’s internal database. This is important if the drive 
your operating system is on is small. 

 ImageJ executable 

You can specify the location for the ImageJ program executable. This is needed in order to 
run ImageJ functions in CL-Quant. 

 Compress saved image 

If checked, compression methods will be applied to saved FOVs to reduce file size. 

 Movie compression 

Options for saving image sequences to AVI format. 

None No compression will be used. 
 

Basic Simple compression will be used. 
 

Prompt You will be prompted to choose between basic and no compression. 
 

 

 



 
 

Chapter 1  Getting Started with CL-Quant 

1.4 CL-Quant Preferences >> 1.4.4 Recipes and Procedures Options 

16 
 

1.4.4 Recipes and Procedures Options 

 Reload recipes and procedures from previous session 

If checked, the recipes and procedures that were loaded when the software was exited will be 
re-loaded when the software is re-started. 

 Save teaching data with recipes and procedures 

When this is checked, recipe or procedure teaching data will be saved, which can get quite 
large. If users only care to apply recipes or procedures rather than understand how they work, 
it is best to turn this off. However, if teaching data is not saved, then the recipe or procedure 
will not be updatable. 

 Compress saved recipes and procedures 

When this is selected the software will automatically compress images saved with recipes and 
procedures. 

 Auto save FOVs data after recipe apply 

If this option is checked, during batch processing a copy of each processed FOV is saved to 
the user specified folder. This provides some protection in case the batch run is disrupted. 
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  Chapter Overview 

This chapter describes using CL-Quant for image examination, applying recipes and 
procedures, and performing data analysis. Creating recipes and procedures is described in 
Chapter 3, “Teaching CL-Quant”. 
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  2.1 User Interface 

When you open the software, you will see three panels: 

- Main panel: 

A large blank workspace 

- Data explorer: 

Top panel on the right. A repository for data objects including “FOVs” (Fields of View), and 
“Procedures” (and also recipes). 

- Controls panel: 

Multi-tabbed panel at the bottom. Contains data object information in the “Properties” tab and 
key controls in the “Properties” and “Controls” tabs. 

 
 

When you display FOVs, they will appear in RecognitionFrames (RFrames). RFrames are the 
primary graphical interface in the software. RFrames are described in Section 2.1.2, 
“RecognitionFrame”. 
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2.1.1 Data Explorer 

The data explorer, pictured below, is the central repository for data objects including FOVs, FOV 
lists, procedures, and procedure lists. Through this interface you can display, hide, save, 
rename, and reload the data objects.  

 

 
(1) Renaming data objects 

Renaming a data object in the data explorer is straightforward: right-click on the data object 
you wish to rename (it does not have to be highlighted) and select “Rename” from the options 
list that appears. 

 

(2) Saving data objects 

To save a select data object in the data explorer, right-click on the object you wish to save and 
click on the “Save” option from the menu. This will launch the save dialog. 

 

(3) Displaying data objects 

To display any data object in the explorer, simply right-click on the object you wish to display, 
and click on the “Display” option from the menu. 

If you have multiple objects highlighted, you may choose the option “Display All”. As the 
name suggests, this option will open new windows in the main panel, each one displaying an 
object that was highlighted when you chose the option. 

 

(4) Hiding data objects 

Right-clicking on any data object in the data explorer will display the “Hide” option. This will 
close the open window containing the data object.  

To hide multiple data objects, select multiple data objects in the data explorer by holding the 
“Shift” or “Ctrl” key while left-clicking them. When finished selecting, right-click on one of the 
selected objects and then left-click on the option “Hide All”. 

 

(5) Reloading data objects 

The reload command allows you to recover a modified data object and restore it to its 
previously-saved state. Right-click on the data object you wish to recover and click on the 
“Reload” option from the context menu. 

 

(6) Removing data objects 

To remove a data object from the data explorer, right-click on the object you wish to remove, 
and select the respective option.  
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 NOTE: 

 
  
 If you have not saved that object to disk, removing it from the data explorer will mean 

losing any changes you made. 

 

To remove multiple data objects, select them in the data explorer, right-click on one of the 
selected objects, and then left-click on the option “Remove”. 

 

(7) Selecting data objects 

Selection in the data explorer is done by left-clicking on any data object or folder. You may 
select all objects under a certain folder at once by right-clicking on the folder and then 
left-clicking on the option “Select All”. 

To specifically select only a few objects, hold down the “Ctrl” key and click on any unselected 
object.  

 
 NOTE: 

  
   
 Using the “Ctrl” key to click on a selected object will deselect it.  

 



 
 

Chapter 2  Using CL-Quant 

2.1 User Interface >> 2.1.2 RecognitionFrame 

22 
 

2.1.2 RecognitionFrame 

When you load one or more multi-dimensional images they will be displayed in the 
RecognitionFrame (RFrame). The RFrame is the primary graphical user interface in the 
software and can display a single FOV, or multiple FOVs in an FOV list. It contains all the 
elements of an imaging experiment in a single window. The primary elements of the interface 
are: 

- Image panel, 

- Content panel,  

- Toolbar. 

The figure below shows the RFrame layout: 
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2.1.3 Toolbar 

The RFrame toolbar provides key functionalities for image and mask examination, manipulation, 
and data analysis. It also provides ways to create enhancement, gating and decision 
procedures. 

 
 

These tools are described in more detail in the sections below. 

 

 Pointing tool - Standard mouse mode. 

 Magnifier glass - Zooms in on the region under your mouse. 

 Zoom to rectangle - Zooms to region specified on the image. 

 View masks - Shows only the mask. 

Pointing tool

Magnifier glass

Zoom to rectangle

View masks

View channels

View overlay

Channel and mask manager

Toggle metadata overlay

Toggle scale overlay

Save threshold to mask

ROI tool

Crop image frames

Align image

Modify frames

MIP tool

Line profiler tool

Mask edit tool

Track edit tool

Track display options

Toggle threshold overlay

Toggle objects

Toggle selected objects

Gate objects

Show labeling

Create annotations
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 View channels - Shows only the image. 

 View overlay - Shows mask overlay on the image. 

 Channel and Mask Manager - Use the Channel/Mask Manager. 

 Toggle metadata overlay - Shows file metadata overlay on the image. 

 Toggle scale overlay - Shows scale bar with calibration (if available) overlay on the image. 

 Save threshold to mask - Saves intensity threshold overlay as binary mask. 

 ROI tool - Specify a region of interest (ROI) for cropping. 

 Crop image frames - Crops the FOV to a specified time window and sampling steps. 

 Align image - Realigns images in a sequence based on ROI inputs. 

 Modify frames - Manipulate T- or Z-stack image sequence. 

 MIP tool - Creates an intensity projection (MIP) image from Z-stack. 

 Line profiler tool - Use the line profiler tool. 

 Mask edit tool - Use the mask editing tool. 

 Track edit tool - Use the track editing tool. 

 Track Display Options - Use the Track Display Options. 

 Toggle Threshold Overlay - Toggles the intensity threshold overlay tool. 

 Toggle objects - Toggles object bounding box or track display. 

 Toggle selected objects - Toggles object bounding box or track display for selected objects. 

 Gate objects - Creates gated object subset from selected objects. 

 Show labeling - Toggles object label display. 

 Create annotations - Generates annotation measurement on user-specified regions. 
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2.1.4 Zoom Controls 

Zoom controls are located at the top of the RFrame. 

 

 

  Turn on / off LUT 

This button will apply the look up table (LUT) to the image. 

 
 NOTE: 

  
   
 Turn LUT on at all times when viewing/processing 16-bit images to ensure best picture 

contrast. 
 

 

  Reset LUT 

This button will reset any LUT settings, and turn off the LUT. 

 

  Toggle LUTs window 

This button will open the LUT panel to the right of the image. 

 

  Zoom to selected object 

This button will zoom into the image to best fit selected objects. 

 

  Zoom in / Zoom out 

Click these buttons to zoom in or out of the image.  

 

  Fit to screen 
The image will be zoomed to fit completely on the screen.  

 

  Best fit 

The image will be zoomed to fit the smaller of its height or width to the screen.  

 

  Zoom 1:1 
This will show the actual pixels, meaning one display pixel for one image pixel, or 100% zoom 
level. 
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  Zoom level drop down 

Here you can select the desired zoom level from the drop down box. 

 

  Column and row settings 

When viewing an FOV list, use the textbox provided to adjust how images are displayed on a 
grid. 

 

  Switch to Main view mode 

This option toggles the default image view mode. 

 

  Switch to Gallery view mode 

This option toggles image view to Gallery View mode. 

 

  Switch to MIP view 

This option toggles image view to mean intensity projection (MIP) view for Z-stacks. 
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2.1.5 Minimap 

Minimap control is located under the zoom controls toolbar in the RFrame. To turn on minimap 
display, click on the minimap control icon.  

 

 
 NOTE: 

 
  
 Minimap display will not appear if the entire image is visible. Zoom in anywhere on the 

image to view. 

 

Minimap display 
When enabled, the minimap display is shown in the upper left corner of the image panel 
overlaid on the image. Note that masks and object overlays on the image are not visible in the 
minimap view. The minimap is an abstract representation of the entire image. The displayed 
region is shown as a neon-green rectangle that shows the current view in relation to the entire 
image. 

 

 

 

On the minimap, you can: 

- click anywhere on the minimap to navigate to a different region; and 

- click-and-drag the display region to pan across the minimap. 
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2.1.6 Metadata Overlays 

In CL-Quant, metadata (such as time and length calibrations) can be overlaid on the image to 
provide additional context information about the files. There are two types of overlay options; 
metadata overlay and scale overlay. 

 

(1) Metadata overlay 

Image metadata provides descriptive information about image context. To toggle metadata 
display, click on the “Toggle metadata” icon on the toolbar (shown below). The metadata 
overlay is displayed on the lower left hand corner of the image. This function supports time 
calibration display. 

 
 

 NOTE: 
  

   
 Metadata information may not be available for all images.  

 

You can burn the metadata overlay display on the image by selecting on the “Burn Metadata” 
option accessed by clicking on the arrowhead below the option with Metadata overlay 
enabled. 

 

 
 NOTE: 

  
   
 This action will modify the image and cannot be reversed. Any pixels and image 

information behind the overlay burnt region will be lost. 
 

 
 

(2) Scale overlay 

The scale overlay displays a scale bar on the image to provide length context within the 
image. If calibrations are specified, the scale bar will display the calibrated distance with the 
scale bar. To toggle scale overlay, click on the “Toggle scale overlay” icon on the toolbar 
(shown below). The scale overlay is displayed on the lower right hand corner of the image. 

 
 

You can burn the scale overlay display on the image by selecting on the “Burn Scale” option 
accessed by clicking on the arrowhead below the option with Scale overlay enabled. 

 

 
 NOTE: 

  
   
 This action will modify the image and cannot be reversed. Any pixels and image 

information behind the overlay burnt region will be lost. 
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2.1.7 ROI Tool 

The ROI tool allows the user to select a region of interest (ROI) by clicking-and-dragging a 
rectangle across the image. Additional options for ROI operations can be selected from the 
context menu by right-clicking on the ROI frame. To use the ROI tool, click on the ROI region 
selection tool from the toolbar (shown below). 

 
 

When selected, click-and-drag over an area on the image to create a region of interest. A pink, 
rectangular border will indicate the selected region of interest. You can move the ROI by holding 
down the left-click while dragging inside the ROI. To resize the ROI, hold down the left-click 
while dragging on the ROI border. 

 

(1) ROI options 

The “ROI” context menu (shown below) is accessed by right-clicking inside a selected ROI. 

 
 

 Copy image 
Copies image inside ROI onto clipboard scaled relative to the actual image size 

 Copy image snapshot 
Copies image inside ROI as-is onto clipboard relative to displayed size 

 Copy ROI 
Copies the ROI frame only 

 Paste ROI 
Pastes ROI at the original location as the copied ROI 

 Paste ROI at cursor 
Pastes ROI at the tip of the cursor 

 Delete ROI 
Deletes the ROI frame 

 ROI properties 
Displays ROI properties in a new window 
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 Crop ROI 
Crops image to ROI frame 

 

(2) ROI properties 

The ROI properties pop-up displays information about the ROI frame and enables the user to 
edit the location and size of the ROI. To display the “ROI Properties” dialog, select “ROI 
Properties” from the “ROI” context menu. 

 
 

 

 Center X 
Horizontal position of the ROI center 

 Center Y 
Vertical position of the ROI center 

 Width 
Width of the ROI 

 Height 
Height of the ROI 

 

Use the textbox to adjust the ROI attributes as needed. Click “Apply” to update ROI position 
and size. 
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  2.2 Loading and Saving Files 

This section covers loading and saving files and other data objects, and exporting FOVs and 
data.  

To learn how to configure import procedures, which can automate the import of FOVs and FOV 
elements (masks and channels), see Chapter 3, “Teaching CL-Quant”. 

 

2.2.1 Loading FOVs 

CL-Quant supports standard image file types such as raw, TIFF, PNG, GIF, BMP, and JPEG. 
CL-Quant supports multi-dimensional formats. CL-Q N dimensional FOVs are saved to CL-Q 
TIFF format (an extension of the OME standard). In addition, CL-Quant can load BioStation CT 
CSV and JSON formats, ICS/IDS and NEX, and AVI.  

Image frames can be imported to create a multi-dimensional FOV (see Section 3.4.1, “FOV 
Import Procedure”).  

To load an FOV, either: 

- Select the file in a Windows Explorer window and drag it into the software. 

or 

- Click on the “File” menu and then click on the “Open” option, which will prompt a dialog 
window that allows you to browse your computer and local network to the FOVs you wish 
to load into the software.  

When you load an FOV into CL-Quant, it will be displayed in an RFrame. It will also appear in 
the data explorer panel under the “FOVs” tab. 

If you load multiple image files, by default they will be loaded into an FOV List. Loading an 
ICS/IDS NEX file will load all of the linked files into an FOV list. Also loading BioStation CT 3.0 
format CSV file will load any linked FOVs (i.e. from a well plate) into an FOV list. You can also 
create an FOV list by right clicking on the FOV list folder. 

You can modify the CL-Quant policy for displaying FOVs when loading, and also for grouping 
FOVs into lists in the CL-Quant general options. 

 

2.2.2 Loading Stitched FOVs 

Large, stitched mosaic FOVs can be loaded and stitched automatically using the BioStation 
CSV format meta-data. Multi-channel FOVs are supported. If the FOV is time-lapse, you will be 
prompted to select just a single time frame for stitching. The arrangement of files into the large, 
stitched mosaic image, and of multiple such stitched images into a multi-channel FOV is 
specified in the BioStation CSV format meta-data.  

The loading of 20 x 20 (1,000 x 1,000 pixels) frame, two channel FOVs has been validated for 
the recommended platform.  
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There are three ways of loading BioStation CSV format stitched images, which are configurable 
in the CL-Quant options settings (under “File > Options”): 

- Fixed stitching: 

Pixel overlap between adjacent frames specified in the CSV format meta-data is used for 
stitching. 

- User stitching: 

The user can specify the pixel overlap amount. 

- Auto stitching: 

CL-Quant will automatically align the input image frames for stitching.  

When you load or import the stitched FOV, a load window will appear that gives you the option 
of selecting a time range or sampling interval for loading, the amount of pixel overlap for 
stitching (when in “User” mode).  

The arrangement of frames into stitched images, and stitched images into multi-channel FOVs 
can also be accomplished through stitched image FOV import (see Section 3.4.1, “FOV Import 
Procedure”).  

 

2.2.3 Loading Other File Types 

 

Loading a recipe 
You can always load recipes by simply dragging and dropping them into the software, or by 
clicking on the “Open..” option found in the “File” menu. 

Loading a procedure 
Procedures can also be opened via drag and drop or “File > Open”. 

If you have to load several procedures at once (and do so several times), you should create a 
list of those procedures. This is described below in Section 2.2.6, “Saving other file types”.  

 

2.2.4 Saving the FOV 

Save an entire FOV by selecting the FOV in the data explorer, and then clicking “File > Save”. 
This will save the FOV to TIFF format, which will preserve the channel, time, z and mask 
structure of the FOV. 

You can also save the FOV to TIFF format by right-clicking on it in the data explorer under the 
“FOVs” tab. Click on the option “Save”, and a save window will open.  

On the “General Options” page you can select the “Load and save objects and data” option, 
which will allow CL-Quant to save FOV’s objects, data and subsets. 

You may save multiple FOVs by selecting multiple FOVs (“Shift” or “Ctrl” click) at once, or by 
selecting the FOV list data object. 
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2.2.5 Saving FOV Images 

You can save individual image frames, thumbnails, masks, and also the displayed image. 

 

(1) Saving a mask 

If you only want to save a specific mask of an FOV, right click on the mask tab and select 
“Save Mask”. This will save the current frame’s mask only. 

 

(2) Saving a displayed image 

If you wish to save whatever is currently being displayed in the RFrame (e.g. masks and / or 
ROIs overlain on the image), navigate to the File menu and click on “Save Displayed Image”. 
You may apply this action to multiple, selected FOVs. In this case whatever would be 
displayed on the FOV, if you displayed it (it is not necessary to display it), is saved shown as 
displayed on the underlying image frame. The images are saved at their actual resolution. 

 

(3) Saving a snapshot 

“File > Save Snapshot...” saves the image panel thumbnails as a “Save Displayed Image” 
format, where all overlaid masks, ROIs etc. are saved to the image. The function saves the 
composite image at the displayed layout and zoom level. All of the thumbnails above the 
displayed position are saved. 
For example, if you have a list of FOVs and you wish to create a thumbnail composite of all of 
them, you would set the zoom level at the level you wish to save, arrange the horizontal width 
appropriately, and the scroll down in image panel to the very last thumbnail. When you 
execute the function, all of the thumbnails above your position in the image panel will be 
saved. 

 
 NOTE: 

  
   
 “Save displayed image” saves one image at its original resolution. “Save Snapshot”

saves multiple FOVs displayed in the RFrame image panel exactly as they appear on
your monitor. 

 

 
 

(4) Saving a movie 

“File > Save Movie...” saves the displayed time-lapse FOV to AVI format. This can be done in 
either “Save displayed image” or “Save snapshot” mode. 
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2.2.6 Saving Other File Types 

(1) Saving a procedure 

In the data explorer you’ll see a tab for procedures. Right-click on any of the procedures you 
wish to save and click on “Save”, which will prompt a window where you can choose where to 
save the procedure. 

Segmentation, measurement and decision procedures can be saved with or without the 
teaching images. This is a configurable option under the options menu. See Section 1.4, 
“CL-Quant Preferences”. 

If you save and reload the procedure without the teaching images, you won’t be able to view 
the teaching images used to create the procedure.  

 

 

 Procedures can be created in all versions of CL-Quant. However, procedures can 
only be saved if your version has support for procedure saving. 

 
 
(2) Create and save a procedure list 

When you load multiple procedure files by drag and drop (or “File > Open”), a new procedure 
list data object will appear in the “Procedure Lists” folder (located in the data explorer under 
the “Procedures” tab), with the loaded procedures arrayed under it in a list. You can also 
create a procedure list by right clicking on the “Procedure Lists” folder and selecting “New”. 
This will create a new procedure list data object. You can then add procedures to the list by 
dragging and dropping them from their folders in the data explorer.  

You must specify the processing order of the procedures by arranging their order in the list. 
You can lock the list order by right clicking and selecting “Lock Procedure List”. When a 
procedure list is locked, it will appear as a single data object (you cannot see the 
sub-procedures), which can reduce the apparent complexity for users, and the 
sub-procedures cannot be accessed.  

To save, right click on the procedure list data object and choose “Save”, or select the data 
object and then choose “File > Save”. The procedure list will be saved to a single file on the 
file system.  
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2.2.7 Exporting FOVs 

(1) Measurements Export 

The measurements export option saves the FOV’s data to a destination directory of your 
choosing. The images are not saved, and the .csv file created cannot be reloaded. To export 
FOV’s data, select “File > Export > Measurements”. 

 

(2) FOV Export 

This option will export multi-dimensional FOV’s image frames (including masks) to individual 
files on the file system. Select “File > Export > FOV”. You can select t and z ranges and 
sampling for the export.  

 

(3) Print to Excel 

Selecting “File > Print to Excel” will export the spreadsheet of the selected FOV(s) to Excel 
format. Any displayed chart will also be exported.  

 

(4) Print Tracks to Excel 

Selecting “File > Print Tracks to Excel” will export FOVs containing track data to Excel. 

 

(5) Print Object Histogram to Excel 

This function will export existing object histograms to Excel format. 

 

(6) Save Track Locations to CSV 

This saves only the x, y, t information from tracks to a CSV format. 

 

(7) Save Track Measurements to CSV 

This function saves only the trajectory measures to CSV format. These are measures which 
are one per track, such as total length. It does not save the motility measurements which are 
one per time point. 
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  2.3 Manipulating FOVs 

An FOV can contain images, segmentation masks, field measurements, object measurements, 
object measurement statistics, and object ROIs. FOV objects may also have multiple subset or 
class memberships. Initially a FOV contains sets of images, aligned in x,y and arrayed in up to 
three dimensions; z, time and channel. 

Once an FOV is loaded, you can manipulate the FOV by manually editing its channels and 
masks, calibrating its spatial and intensity units, merging and appending multiple FOVs into one, 
and cropping the FOV in x,y and t dimensions.  

 

2.3.1 Edit FOVs 

(1) Editing channels 

You may save the selected channel, add new channels, remove unwanted ones, and rename 
them. Channels tabs are located at the bottom of the image panel in the RFrame. 

- Adding a channel 

To add a channel (be sure to have an FOV loaded), right-click on the bottom strip (in the 
blank area or on a channel tab itself) of the FOV and select “Add Channel”. 

- Inserting a channel 

To insert a channel, click on the channel tab positioned just after where you wish to insert a 
channel, right click on the channel tab and select “Insert Channel”. 

- Removing/renaming a channel 

To remove or rename a channel, simply right-click on the channel tab you wish to remove or 
rename, and select the appropriate option. 

 

(2) Editing masks 

Masks can be added, removed/deleted, and renamed. In addition, you may change the color 
of the mask.  

- Adding a mask 

To add a mask (be sure to have an FOV open), you can right-click on the mask strip (along 
the top of the image panel) of the FOV and select the only option, which is to “Add Mask”. 

 

- Removing/renaming a mask 

To remove or rename masks, simply right-click on the mask tab of the mask you wish to 
remove or rename and select the appropriate option. 
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2.3.2 Merge FOVs 

(1) Merging FOVs by channel 

It is sometimes useful to load one FOV into a destination FOV’s Channel. For example, you 
might want to combine two fluorescence channels into a single FOV for analysis. This can be 
done by a simple drag and drop operation.  

To merge the two FOVs, display the destination FOV in an RFrame, and then drag the FOV to 
be merged from the data explorer onto the channel tab of the destination FOVa new channel 
will be created automatically. The image you want to merge must have the same dimensions 
(x, y) as the existing FOV.  

 

(2) Merging FOVs by mask 

It is sometimes useful to load one FOV into a destination FOV’s mask. For example, you may 
have a mask you created from one procedure that you want to compare with another 
procedure. To bring that mask image into the destination FOV, you first need to have the 
destination FOV RFrame displayed. The image you want to merge must have the same 
dimensions (x, y) as the existing FOV.  

Simply drag the FOV to be merged onto the mask strip of the destination FOVa new mask 
will be created automatically. 

 

2.3.3 Append FOV 

Fixed point and time-lapse FOVs can be inserted along the time dimension into any other fixed 
point or time-lapse FOV. To append an FOV into the destination FOV, you first need to have the 
first FOV’s RFrame window open. The FOV you want to merge must have the same x,y 
dimensions as the destination FOV.  

You may either append the FOV before or after the current frame. You may merge as many 
FOVs into the destination FOV’s time dimension as you like. Display the destination FOV in an 
RFrame. To insert before the current frame, drag the FOV to be merged from the Data Explorer 
to the left of the time slider. To insert a movie after Frame C, drag the FOV to be merged to the 
right of the slider. 
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2.3.4 Crop FOV 

(1) X,Y crop 

FOVs can be cropped using the ROI tool. Draw a rectangle around the area you wish to crop 
to a new FOV. Right-click on the ROI frame and select “Crop ROI” from the context menu. 
This will copy the FOV (all t, z, channels, and masks) within the ROI region to a new FOV. 
Please refer to the ROI tool section on creating ROI region tools. 

Your cropped FOV will appear in the data explorer under the FOVs tab and folder. 

 

(2) Time crop 

Click on the “Crop image frames” icon (see below) on the toolbar to launch the time crop 
dialog. The time crop dialog allows you to select a range and frequency for the time crop. 

 

Once you select your options, click “OK” and a new FOV will be created. It will appear in the 
data explorer. 
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2.3.5 Image Alignment 

The software provides the capability of aligning FOVs so that objects (typically cells) in the time 
series are located at the same x and y position in the spatial “imaging system domain”. In live 
cell assays, alignment may be necessary because cells tend to move over the course of time 
making it difficult to monitor the growth or behavior of a single specific cell.  

Image alignment may also be necessary in fluorescence or other dead-cell assays when the 
mechanical system incorrectly positions a sample for microscopic analysis. In this case, 
alignment can be called upon to adjust the image so that samples taken a various times and 
positions can be aligned in the spatial domain. 

It is important to note that software image alignment always results in some degree of x, y 
cropping of the aligned images. This is because the images are shifted in x and y the exact 
amount necessary to align the two images. When an image is shifted, the pixels around the 
border of the image that previously existed outside the bounds of the original image are now 
brought into the image area. Since this data is “unknown”, the new pixels are set to zero so 
there can be no misinterpretation in the resulting image. For this reason, the aligned image will 
always contain less pixel data than either of the two images provided as input. The resulting 
aligned image will contain valid pixel information for the area where the two images intersect. 

The following three alignment tools are provided depending on the application requirements. 
The ROI-based alignment operations require at least one ROI defined anywhere within the time 
series. When multiple ROIs are specified, they must be specified at the same time index (same 
image). 

 

(1) Alignment types 

ROI-based Global Alignment ( RGA )   
RGA uses up to ten user specified statically positioned ROIs to align all images in the T series 
to the reference image containing the initial ROIs. If an image is selected in the middle of the 
time series, then RGA will propagate the alignment both backward and forward in time. All 
masks associated with the time series will also be shifted by the same amount as the 
associated image. The resulting aligned images and their associated masks will be padded 
with zeros outside the region containing valid pixel data. 

In RGA, all ROIs are statically positioned and do not move over the course of the alignment 
analysis. RGA is useful if you have an object, or series of objects, that do not move over the 
entire course of the time series. For example, a Petri dish may have a reference marker 
etched into the glass or an imperfection in the glass that can be used as a reference. In this 
case the user would select a ROI around the reference marker so RGA can align all image 
data to that reference.  

 

ROI-based Incremental Alignment ( RIA )   

RIA uses up to ten user specified dynamically updated ROIs to align each of the images in the 
T series to the reference image containing the initial ROIs. If an image is selected in the 
middle of the time series, then RIA will propagate the alignment both backward and forward in 
time. All masks associated with the time series will also be shifted by the same amount as the 
associated image. The resulting aligned images and their associated masks will be padded 
with zeros outside the region containing valid pixel data. 

In RIA, the positions of all ROIs are adjusted with each successive frame in the time series. 
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Thus, RIA is capable of tracking multiple objects that may be uniformly drifting in position 
during the course of an experiment. This alignment mechanism should not be used in 
applications where there is differential movement between the objects as the differential 
movement may send contradictory feedback to the alignment engine. 

 

Image-based Global Alignment ( IGA )   

IGA does not require the use of any user specified ROIs. This alignment mechanism uses all 
the information within the image to assess and correct for any misalignment. Unlike the 
ROI-based alignment tools, IGA only corrects for misalignment going forward through the 
times series starting with the first image of the time series. IGA adjusts the x, y position of 
each image relative to the first image in the series and makes the same corrections to the 
associated masks. 

 

 

(2) Guidelines for using ROI-based operations 

Try the following suggestions that will help improve the performance and robustness of the 
ROI-based alignment tools. 

Tips for Selecting Alignment ROIs 
- Select small objects (ROIs) rather than larger objects both for alignment robustness and 

speed. 

- Select objects that are stationary relative to all the other cells in the image (RGA only). 

- Select objects that move in unison (RIA only). 

- Select objects with good contrast over those with poor contrast. 

- Select objects that have unique size and shape characteristics. 

- When possible, select objects in the center of the field of view, so that they are less likely to 
move outside the field of view. 

- Select objects in the middle of a long movie so that overall drift is minimized. 

- Select objects that remain within the field of view the longest. 

- Select multiple objects when no single object remains within the field of view for the entire 
movie. 

- Select multiple objects to improve the accuracy and robustness of the alignment. 

 

Alignment Limitations 
Image movement must be less than a quarter of the x and y dimensions of the image. In our 
tests, the image dimensions were 1,000 x 1,000 pixels so the limit for maximum movement 
was 250 pixels. Movement between successive images greater than 250 will result in loss of 
alignment. 
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2.3.6 Modify Frames 

FOVs containing multiple frames (such as a time sequence or Z-stack) can be loaded into 
CL-Quant for analysis. The “Modify frames” function on the toolbar allows you to manipulate 
the frames of the FOVs. Click on the “Modify frames” icon on the toolbar and select an option. 

 
 Reverse T 

This option will reverse the FOV’s time dimension and the frame order of the T-series. 

 Reverse Z 

This option will reverse the FOV’s axial/Z dimension and the frame order of the Z-stack. 

 Swap T/Z dimensions 

This option will swap the FOV’s time and Z dimensions. For image sequences that contain 
only T or only Z series, this option will convert the sequence to the other dimension. 
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2.3.7 MIP Functions 

MIP functions are intensity projection operations that flatten a Z-stack image sequence into a 
single image based on specified image statistic. The MIP functions will generate a new FOV 
that contains the result output of the MIP operation. To generate an MIP image, first make sure 
you have a Z-stack image sequence loaded into CL-Quant. Click on the “MIP tool” icon on the 
toolbar (shown below) and select an option for the MIP image output. 

 

There are five types of MIP that can be generated using the MIP function. 

 

 Min Projection 

Outputs an MIP image containing the minimum intensity for each pixel over the entire Z-stack. 
(Figure 1). 

 Max Projection 

Outputs an MIP image containing the maximum intensity for each pixel over the entire Z-stack. 
(Figure 2). 

 Mean Projection 

Outputs an MIP image containing the mean intensity for each pixel over the entire Z-stack. 
(Figure 3). 

 Median Projection 

Outputs an MIP image containing the median intensity for each pixel over the entire Z-stack. 
(Figure 4). 

 HSDEF Projection 

Outputs an MIP image containing the 2D extended depth of focus (EDF) intensity projection 
image. The EDF projection combines the in-focus pixels of each Z-stack image into one 
image, ensuring that the projection output is all in focus. (Figure 5) 

 
 Figure 1 Figure 2 Figure 3 Figure 4 Figure 5 
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  2.4 Examining FOVs 

The examination toolbar contains functions related to image, mask and object region of interest 
viewing. This section describes many common and useful interface features. 

 

2.4.1 Freehand Measurement Tools 

The freehand measurement tools will show calibrated image measurement based on user input. 
Use the tool to measure straight-line length, area, and angle of a drawn object. To launch the 
annotations tool, click on the “Create annotations” icon (shown below) on the toolbar. 

 
 

When toggled, the annotation tools will be displayed in the “Annotations” tab in the Controls 
panel. 

 
 

There are three tools provided for freehand measurements: 

 Length measurement 

Measures the straight line length of a drawn line 

 Area measurement 

Measures the area of a drawn region 

 Angle measurement 

Measures the angle between two drawn lines 

Click on any of the measurement tools and start drawing on the image. The annotations will 
appear in the Fields panel in the “Annotations” tab under the measured image name. 

If the image is calibrated, users can change the measurement unit by selecting a desired unit 
from the display unit dropdown menu. 
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2.4.2 Navigate the FOV or FOV List 

FOV navigation refers to changing the displayed image pixels in the image panel. You can do 
this by moving through the x, y, z, channel, and time dimensions of the FOV. In addition, each 
image frame may have one or more masks that you can display. You can also navigate through 
multiple FOVs in an FOV List.  

 

(1) Horizontal and vertical scrollbars 

If the image is larger than the RFrame image panel, scrollbars will appear on the bottom and 
right side of the image. You may use these to navigate your image(s) in x and y directions.  

In addition, there is the “Grabber” tool which allows you to navigate in x,y by dragging your 
mouse when this tool is selected. Click and hold your mouse pointer on the image to get the 
grabber tool.  

 

 

(2) Mask tabs 

At the top of the RFrame are the zoom controls. Just below those is the mask strip where the 
mask tab appears. You may display the mask overlay by clicking on their respective tabs.  

 

 

(3) Time, M, and Z controls 

Just below the RFrame image panel are the movie controls. They are the same for navigating 
in time, m, and z. 

 
 

Each green block represents an image in the sequence. The green arrow plays the sequence. 
Next to that are controls for stepping through the sequence and advancing to the end of the 
sequence. You can adjust the playing speed using the +/- buttons or set playing speed to real 
time (R) or maximum (M) using the controls on the right. 

 

 

(4) Channel tab 

You’ll notice that the channel strip (which behaves just like the mask strip) is directly below the 
movie controls. Click on a channel tab to display the image from the next channel. If there are 
multiple channels, the combined channel will be automatically shown. You can include or 
exclude channels from the combined channel by right clicking on their channel tab.  

 

 

(5) FOV list display grid 

When you view all images in an FOV list in an RFrame, you can adjust how the display grid is 
organized by changing the number of columns and rows of FOV to show. The column and 
row display selection are located above the image in the zoom control toolbar. 
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2.4.3 Look Up Table 

To the right of the image panel is the look up table. It provides tools for enhancing the image 
display.  

 
 
Access the LUT panel by clicking on the “Toggle LUTs window” button on the zoom control 
toolbar  or pressing “Ctrl”+“Alt”+“L” on the keyboard. 
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2.4.4 Magnify Tool 

If there are features in an image that are too small to see, you may zoom into that area for a 
closer look. 

You may use the zooming features built into the RFrame, or if you just need to take a quick look 
at a particular feature in the FOV, you can use the magnify tool. The icon is found in the 
examination tools area of the tool bar. 

 

While activated, the image will be magnified while you hold down the left mouse key. 

You can also zoom to a specific region of the image using the “Zoom to Rectangle” tool on the 
toolbar. Left-click and drag over the region you wish to magnify and release the mouse button to 
zoom. The “Zoom to Rectangle” tool icon is shown below. 

 

 

2.4.5 Display Intensity Threshold 

The “Threshold” icon on the toolbar will activate the threshold tool in the controls panel. The 
tool enables you to visualize the selection of a range of values in the image. Values that fall 
within the range will be overlain in red (the color red is reserved for the threshold overlay). 

 
To use the tool simply: 

1.  Click the “Show” or “Hide” button to visualize the selected pixels in the range. 

2.  Move the slider to adjust the range. 

3.  Modify the text in the boxes to adjust the text. 

The threshold tool is described in detail in Section 3.2.1.3, “Thresholding”.  

 

Save display threshold 
The current displayed threshold can be saved to mask using the “Save threshold to mask” 
function. Click on the icon shown below (located below the “Threshold” icon in the toolbar) to 
save the threshold overlay to mask. 
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2.4.6 Line Profiler Tool 

The line profiler tool will show you a trace of the intensity values along a line you draw on the 
image.  

To access the tool click on the “Toggle line profiler tool” icon.  

 
 

When draw a line across the image, a trace of the intensity values are shown overlain on the 
image as shown in the figure below.  

 

 

2.4.7 Channel and Mask Manager 

The channel and mask manager displays a list of channels and masks that are available on the 
image. User can modify channel and mask display from the manager. To launch the channel 
and mask manager, click on the “Channel and mask manager” icon on the toolbar (shown 
below). 

 
 

The channel and mask manager can be used to display multiple masks as well as changing the 
attributes of individual channels and masks. An example of the channel and mask manager 
dialog is shown below. 

 

Channels are shown in gray with masks from the respective channels displayed in blue and 
organized under the specific channels. A lighter color indicates the channel/mask is displayed 
on the image. 
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Channel options 

 
 

To rename a channel, right-click on the channel panel and select “Rename channel” from the 
context menu. User can also specify the channel color (the color which appears in the RGB, if 
enabled) and include/exclude the channel from the RGB-combined channel using the options 
shown above. 

 

Mask options 

 
 

Multiple masks can be displayed by toggling the eye icon in the mask options. Use the slider to 
adjust the mask transparency and the mask color pulldown menu to specify mask color. User 
can opt to color individual mask component differently by enabling the Color by label option. 
Note that the Color by label option when enabled will override the displayed mask color. If a 
detection mask is used for object measurements, the primary mask for measurement will be 
indicated with the suffix “(Primary)”. 

 

2.4.8 Calibration Properties 

Calibration properties allow you to set and adjust the pixel and temporal calibration of the image. 
The pixel calibration information is displayed on the lower left hand corner of the RFrame below 
the channel tabs. 

 

 

 

Change calibration settings 
To change calibration settings, click on the “Edit calibration” icon next to the pixel calibration 
display (see above). This will launch the “Calibration Properties” dialog. 

 

Edit calibration icon
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Use the textbox provided to adjust the time and X/Y calibration settings value. Click on the 
measurement drop down menu to the right to select the calibration units, or disable calibration 
by selecting the “Uncalibrated” option from the drop down menu. 

 

2.4.9 Gallery View 

Gallery view displays thumbnails of selected objects on a grid allowing for the visualization of 
multiple objects simultaneously. Whole image is displayed alongside the thumbnail gallery 
allowing users to quickly reference and identify selected thumbnail objects. 

To launch Gallery view, you must have objects or trajectories selected. Click on the “Gallery 
View” icon on the magnification toolbar above the image. 

 
 

User interface 
The Gallery View user interface is split into three sections: 

- Whole image preview 

Displays the entire image with selected objects highlighted for quick reference 

- Thumbnail gallery 

Displays the selected objects as small thumbnails. Options are provided for sorting and 
displaying specific image statistic. 

- Filmstrip 

Allows user to “focus” on a single image thumbnail and displays the selected object at other 
time points. 
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2.4.10 BioStation CT Data Viewer 

BioStation CT (BioCT) is an automated incubator/imaging platform developed by Nikon for live 
cell imaging and analysis. BioCT has the ability to capture multiple whole-well images over time 
for extended experiments. For BioCT with the version 3.8 firmware upgrade, image file paths 
and experiment information are stored to a JSON header file which can be read in the 
BioStation CT data viewer. The BioStation CT data viewer parses the JSON header file and 
allows fine-tuned selection of experiments, plates, wells, and FOVs directly from the viewer. 

To launch BioCT data viewer, go “File > Open”, and load a BioCT JSON file. 

 
 NOTE: 

 
  
 The data explorer, along with files loaded into it, will not be accessible in the BioStation CT

data viewer mode. You must exit the BioStation CT data viewer mode to view non-JSON 
image data. 

 

User interface 
The BioStation CT data viewer has a specialized user interface that allows the user to quickly 
and easily select experiments and FOVs to view. 

There are two main panels: 

- Image panel 

Shows the stitched and loaded BioCT images. 

- FOV selection panel 

Allows the user to load and select experiments, plates, samples, and FOVs to be displayed 
in the image panel. 
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  2.5 Apply Procedure 

When you have loaded a procedure in the data explorer, activate the Controls panel at the 
bottom of the workspace and select the “Measure” tab. 

To apply a procedure: 

1. Select a procedure in the data explorer. 

2. Select the FOVs that you will apply the procedure in the image panel. 

3. Click the “Apply” button (red box) in the “Measure” tab. 

Note that for FOVs with time and z extent you can select a range and sampling for apply.  
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  2.6 Data Analysis 

CL-Quant allows the user to view measurement data and provides tools to review or gate object 
data. This section provides information on performing fixed-point analysis and kinetic analysis 
on the image. 

 

2.6.1 Fixed Point Analysis 

Fixed point analysis features data presentation, and integrated data - image - chart based 
experiment analysis. It provides object and data linking to facilitate image and data 
understanding, charting, and the manual creation, or gating, of sub-populations of objects. 

 

(1) Objects and subsets 

Objects 
When you apply object segmentation and measurement procedures to an FOV it will create 
objects. Objects are a primary unit of analysis that would likely correspond to cellular or 
subcellular phenomena depending on your application.  

An object is associated with its set of measurements, and can be represented as an ROI 
overlain on the FOV, a row in the object tab of the spreadsheet, or as a data point in the 
charts.  

Each FOV in the FOV List will have its own object tab in the spreadsheet which will contain 
the object measurements as shown in the screen capture below.  
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Subsets 
Object subsets are collections of objects from one or more FOVs. A subset can be created 
manually by gating or through the application of a decision procedure. Subset objects are not 
removed from their original FOV, they exist in the subset as well as the FOV. When a subset 
is created, a new object tab is created in the spreadsheet containing the member object data.  

 

 

 Automatic subset creation can only be done with decision procedures. Decision 
procedures can only be created if your version supports the decision module. 

 

Object linking 
Any object you select, regardless of where you selected them (e.g. image panel, chart, 
spreadsheet), will automatically be highlighted in the spreadsheet, charts, and image views. 

 

(2) Adjusting object bounding boxes 

After applying an object measurement procedure, the segmented objects are represented by 
bounding boxes. The bounding boxes enable object linking to support integrated image and 
data analysis. The image masks are used for measurement. 

 

Show/hide object bounding boxes 
To show or hide object bounding boxes, select the “Toggle objects” icon in the tool bar, 
shown below: 

 

Under the “Toggle Objects” icon, there is an icon for “Toggle selected objects”. In this 
mode, only the bounding boxes for objects selected in charts or spreadsheets will be 
displayed. 

 
 

Color objects 
Objects can be colored and identified based on their FOV or subset membership. If there are 
object subsets in the FOV, you can click on the “Controls” tab located at the bottom of the 
rightmost panel to display the object color options. 

 Color by Subset/Color By FOV 

To color by subset, click on the arrow underneath the icon and choose “Color by Subset” 
(shown below). 
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The first highlighted “F” icon adjusts color options for the color by FOV mode. 

The “S” icon will allow you to adjust the color by subset mode options. 

The checkbox in the middle turns coloring on or off. 

You can adjust the opacity of the colors by clicking on the drop-down menu (you may 
have to scroll to the right to see everything). 

 

(3) Gating 

You can manually gate a subset by selecting objects in charts, on images, or in the 
spreadsheet.  

 

 Gating of object tracks is not currently supported. 

 

 

Gate from chart 
With one or more FOVs with object data and ROIs displayed in the RFrame, select objects 
from the dot plot or bar of the histogram in the information panel. You can select objects in dot 
plots by clicking them with your mouse or dragging your mouse to cover a region in the chart. 
Once selected, the object data points will turn red.  
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You can select objects in a histogram by clicking one or more of the histogram bars, which 
turn red when selected (as shown here). To gate these objects select “Analysis > Gate” from 
the menu bar. 

 

Gate from spreadsheet 
With one or more FOVs with object data and ROIs displayed in the RFrame, select the 
objects you wish to gate in the spreadsheet by clicking the rows in the object set tab. Select 
“Analysis > Gate” from the menu bar to create the new subset. 

 

Gate from image 
With one or more FOVs with object data and ROIs displayed in the RFrame, select the ROIs 
in the image panel, then select “Analysis > Gate” from the menu bar to create the new 
subset. 
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2.6.2 Kinetic Analysis 

Kinetic analysis features include displaying object tracks, reviewing track data, charting track 
data and loading and saving FOVs with track data.  

 

 

(1) Displaying Object Tracks 

After applying a tracking procedure, you can review the object tracks. Tracks are similar to 
object ROIs, but since the object now has temporal extent, tracks show how the object moves 
over time.  

 

Viewing object tracks 
To view object tracks, click on the “Toggle objects” button on the toolbar. 

 

This will display the object tracks. Tracks are a series of connected vertices showing the 
location of the tracked object at various time points. 

 

 
The figure above shows a track overlaid in orange on a moving cell (the segmentation mask 
is also shown in cyan). The current location of the object is shown as a green, circular ROI 
(red arrow, above). The x,y location of the object at previous time points is shown as orange 
boxes connected by a colored line. 
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Adjusting tracks 
You can adjust the track length with “Track Visibility” parameter from the “Track Display 
Options” dialog. To launch the dialog, click on the “Track display options” button on the 
toolbar (shown below). 

 
 

The “Track Display Options” dialog has many options to adjust the track appearance and 
presentation. The dialog is shown below. 

 
 

 Track Display Options 

You can modify how tracks are displayed using options below: 

Thickness You can adjust the thickness of the track by selecting the desired thickness 
here. 
 

Anchors You can choose to hide all or some anchors or show all anchors. Anchor sizes 
can be adjusted by changing the track thickness. 
 

  
 

Fade You can change how long tracks are displayed to maintain same track 
appearance for all track points or to have the track fade with older track points. 

 

 Track Visibility 

When this parameter is set to 1, only the current track location, denoted by a green circle 
showing the active anchor is visible. When this parameter is set to all, the whole track is 
displayed. The pull-down menu and the slider provide precise step definition that can be 
set to show a set number of previous track points with current point. 

Hide all anchors 
Show active anchor only 
Show all anchors 
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 Show Outside of Timeframe 

Enable this option to show all tracks, including those that do not appear in the current 
time frame. 

 Link Lineage Selection 

If lineage is enabled in tracking, enable this option to display the lineage links between 
the parent and daughters tracks. 

 Show Contacts 

Use the pull-down menu to specify how the location of which two tracks intersect is 
shown. 

 Coloring 

Use the pull-down menu to specify how track colors are shown. You can specify the track 
colors by state, direction, lineage, or track number. 

 Location Map 

Use the pull-down menu to enable the display of specific location of a track at a certain 
time point. There are two location map options - first frame and last frame. 

 

(2) Reviewing Track Data 

After applying a tracking procedure, track data will appear in the FOV spreadsheet. There are 
two types of data; dynamic data and track data, which appear on separate tabs.  

 

Data types 

- Dynamic data 

 
 

As shown in the figure above, dynamic data appears in the first tab. Dynamic data 
characterizes a single time point. It could be instantaneous information, such as the 
average intensity of the object at that time point. It could also be accumulated information, 
such as the curvilinear velocity of the object from its initial time point until the current time 
point, or within a moving window t frames before the current time point.  

 

- Track data 

Track data appears in the second tab with the “-Tracks” suffix. Track data, such as total 
length, first frame, etc. characterize the entire track. 
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Spreadsheet display options 
To view spreadsheet display options, right-click anywhere in the spreadsheet panel to bring 
up the display options context menu. Here, you can change how the objects are organized in 
the spreadsheet and modify refresh options for time-lapse sequences. 

 

 Delete selected objects 

Select this option to remove selected objects from the spreadsheet. This action is 
irreversible. 

 Single Line Header 

Select this option to reduce the header width to one line; names longer than the allotted 
cell space will be truncated in this display mode. 

 Hold ZT 

By default, every time you advance one frame, the spreadsheet will update with the 
dynamic data for the current time frame, which can be inefficient. You can suspend 
spreadsheet update by selecting the “Hold ZT” option to disable automatic update. 

 Update ZT 

Select this option to display the dynamic data for the current frame. 

 Auto Advance 

Select this option to automatically advance image sequence to the first frame of when the 
selected object appeared. 
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(3) Integrated Kinetic Characterization 

Tracking analyses generate tracks and data. The integrated data and track linking feature is a 
powerful way to find objects of interest, outliers, or potential errors. Track data can be plotted 
in dot plot and histogram, and both track and dynamic data can be plotted in the trace plot.  

Track measurement in the trace plot 
The figure below shows a tracking measurement charted in the trace plot. To modify the data 
shown in the trace plot, click on the vertical measurement name (red rectangle) and choose a 
different measure. 

 

 

- Using a secondary axis 

You can plot additional measurements on the same axis by selecting additional 
measurements. To plot new measurements on a secondary axis, right-click on the charts 
panel and select “Secondary axis” from the context menu. In addition, you can change 
how the secondary measurements are displayed in the “Secondary data style” submenu. 

 

Vertical 
measurement 
name 



 
 

Chapter 2  Using CL-Quant 

2.6 Data Analysis >> 2.6.2 Kinetic Analysis 

61 
 

Click on the axis title of the secondary axis to select a measurement to plot. Measurement 
being plotted on the primary y-axis will be displayed in parentheses in the measurement 
selection menu. An example of a two-axes trace plot with acceleration and velocity 
magnitude charted is shown below. 

 

 

Track measurement in the dot plot and histogram 
Track measurements can also be shown in the dot plot and histogram. When you select the 
objects in the charts (circled below), they are also automatically selected in the image overlay 
and spreadsheet. 

 

Selected object 
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The axes value can be adjusted by clicking on the min and max values of the respective axes 
(circled below). A textbox will replace the axis labels. Enter a new value into the textbox and 
press Enter to confirm. The axis will be renumbered based on the inputs. 

 
 

 

2.6.3 Charting 

Multiple chart types are supported. To change the type of chart you are using, click on the 
“Charts” tab in the Controls panel and select the available option as shown below. 

 

 

 
 

 

 
 NOTE: 

 
  
 Charts will only become enabled after applying a recipe. Not all chart types are available for

all recipes. 

 

Chart options 
Additional chart options are shown on the charts toolbar. These options allow you to modify the 
chart appearance and export chart data. 

 

 
 

Dot plot 

Histogram 

Trace plot 

Multi trace plots 

Lineage plot 

Directional plot 

Reset axes

Copy chart data to clipboard 

Assign dot colors 

Show/hide legends 

Copy chart to clipboard 
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 Show/hide legends 
Toggles legends display on charts. 

 Assign dot colors (Dot plot only) 
Modifies the color of data points in a dot plot. This tool is available for dot plots only. 

 Copy chart to clipboard 
When selecting this option, a snapshot of the chart as displayed will be copied to the 
clipboard. 

 Copy chart data to clipboard 
Data values associated with the displayed chart will be copied to the clipboard. For 
histograms, the displayed value for each histogram bar will be copied. 

 Reset axes 
Resets chart axes to default. 

- Chart legends 

When plotting multiple objects, the plots are shown in different colors. The chart legends 
provide information about the object plots and the corresponding objects. To toggle legends 
display, click on the “Show/hide legends” icon in the charts toolbar. The legends are overlaid 
on the chart in the upper right corner of the chart. 

 
 

- Chart axes 

User can change the chart axes range by clicking on the minimum value and the maximum 
value on each axes. The cursor will change to an I-beam when hovering over the axes values 
indicating that they can be adjusted. User can reset the chart axes back to default using the 
“Reset axes” option. 
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(1) Histogram 

Histogram present data for one or more object sets (images and subsets). When you select 
the object set in the summary tab of the spreadsheet, its data will be plotted in the chart.  

Histogram bin adjustment 
The number of bins plotted is adjustable by the user from a minimum of two bins. Click on the 
chart and use your scroll wheel to adjust. 

 
 

Multiple axis scales 
“Linear”, “Log e”, “Log 2” and “Log 10” scales are supported for X and Y axes. Right click on 
the chart to choose as shown below: 
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Line plot mode 
The histogram can be plotted as a bin, or as a line. Right click on the chart and select “Line 
style” as shown below. 

 
 

(2) Dot plot 

Dot plot present data for one or more object sets (images and subsets). When you select the 
object set in the summary tab of the spreadsheet, its data will be plotted in the chart. 

 
 

Assigning dot colors 
You can assign different colors for the objects in the chart. In the above image, there are two 
separate clusters of dots differentiated by their y-axis value (mean intensity). Click on specific 
dots or hold down the left click while dragging to select multiple dots. 

To change the color of the selected dots, click on the palette icon  on the charts toolbar 
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and select a new color from the list provided or add a new color. 

 
 

(3) Trace plot 

Trace plot displays object or field measurements data plotted against time. This charting 
option is applicable to multi-frame image sequences only. A tooltip is provided when you 
hover over the trace plot to indicate measurement values at the given time point. 

 
 

Plotting multiple objects 
To plot a track, click on its trajectory on the image. Hold down the “Shift” key while clicking on 
object trajectories to select multiple objects on display. The trace plot will update 
automatically with the trace plots of the selected object. 
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Plotting multiple measurements 
Click on the Y-axis label and select from the list of available measurement to plot additional 
measurements. The axis label will turn red when you hover over it. A check mark denotes the 
measurement that is being plotted. 

   
 Two measurements colored by measure Two measurements on two Y-axes 

 

Trace plot options 
You can adjust the display of the trace plot, add a second Y-axis, or normalize the plotted 
measurements from the trace plot context menu. Available options are shown below. 

 
 

 Normalize 

Normalizes the measurement axis to a fixed scale between 0 (min) and 1 (max). 

 Reset axes 

Resets chart axis. 
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 Secondary axis 

Adds a secondary Y-axis to the trace plot on the right. You can click on the axis label in the 
secondary axis to plot secondary measurement. 

 Secondary data style 

This option allows you to change the trace plot display for the secondary axis 
measurement. 

 Color by measure 

Colors object trace plot by measurement type. 

 Color by object 

Colors object trace plot by object. 

 Color by group 

Colors object trace plot by selected multipoint or subset membership. 

 All different colors 

Colors all object trace plot with a different color. 

 All one color 

Colors all object trace plot with the same color. 

 

(4) Multiple trace plot 

If you have a multi-point image file with multiple image sequence, you can plot object trace 
plots from each of the multi-point images. Select an object in each image sequence. 

  
Object trace plot for selected trajectories in image 1 (top) and image 2 (bottom) 

As shown above, objects can be individually-selected from each of the multi-point image and 
plotted in the Multiple trace plot window. The same specified measurement trace plots are 
plotted for both the multi-point images. 

Image 1 (M = 0)

Image 2 (M = 1)
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Trace plot options 
The same trace plot options are provided in the multi-trace plot as the options in the trace 
plot. 

Adjusting chart layout 
You can adjust the way the charts are organized using the dropdown menu and the textboxes 
below the chart options. Note that the charts are limited to the display of the same 
measurements (i.e. it is not possible to plot acceleration at the top for one multi-point image 
and plot velocity at the bottom for the other multi-point image). 

 

(5) Directional plot 

Directional plot displays the X and Y displacement of selected object tracks for the duration of 
the tracks centered at a common origin. This chart can be used to investigate migration 
behavior of tracked objects. 

 
Directional plot with all anchors off 

Click on an object trajectory on the image to select and plot the track. You can plot multiple 
trajectories by holding down the “Shift” key while selecting trajectories from the image. To plot 
all object tracks on the directional plot, right-click on the chart and select the “All” option in the 
context menu to plot all objects. 
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Track display options 
The directional plot display is linked to the “Track Display Options” window which allows the 
user to adjust the appearance of the trajectory on the image. All track point anchors are 
displayed as small points on the directional plot when the “Show all anchors” option is 
selected; whereas only the current anchor is displayed as a point on the directional plot when 
the “Show active anchor only” option is selected. To disable all track point display in the 
directional plot, select the “Hide all anchors” option from the “Track Display Options” 
window. 

   
 Directional plot with current anchor only Directional plot with all anchors 

 

(6) Lineage plot 

Lineage plot traces the temporal evolution from a single ancestor track to descendant tracks 
by division in an image sequence. 
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Track measurement in lineage 
You can plot track measurement on the lineage plot. To select a track measurement to plot on 
the lineage plot, click on the X-axis label on the chart and click on a measurement to show. 
Track measurements are plotted as a function of color. The color bar below the measurement 
label provides calibration information that correlates the displayed color to measurement 
value. 

 
 

2.6.4 Object Histogram 

The object histogram function displays the intensity histogram of selected objects. Intensity 
values for all pixels in the selected object masks are plotted on the object histogram. To show 
the object histogram panel, click on the “Object Histogram” tab by the “LUT” and “Charts” tab. 
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To plot object histograms, click on the object bounding boxes or trajectories on the image. The 
intensity histograms for individual object are plotted on the histogram plot. 

 

Viewing object histogram by object 
By default, object histograms are plotted for each individual channel. You can change the object 
histogram display to show each object in a separate histogram with the intensity of each 
channel plotted. To view object histogram by objects, click on the “Channel Plot” drop down 
menu and select “Object Plot”. 

 

 

Selecting channels 
You can specify the channels in objects histogram by clicking on the dropdown menu next to the 
“Channels” label. You can select individual channels, all, or no channels from the menu and the 
object histogram plot will be adjusted accordingly. 

 

Object histogram tools 
Object histogram provides several chart options tool for manipulating the histogram chart as 
well as provide options for histogram exports. The six object histogram tools are as follows: 

 

 
 

 

 Show/hide legends 

Toggles legends display for object histograms. 

Copy histograms to clipboard 

Show/hide legends 

Copy histogram data to clipboard 

Export histogram data to Excel 

Best fit zoom for all histograms 

Zoom to histogram region 
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 Copy histograms to clipboard 

Exports object histogram as displayed to clipboard. 

 Copy histogram data to clipboard 

Exports object histogram data to clipboard. 

 Export histogram data to Excel 

Exports object histogram data to Excel spreadsheet format. 

 Zoom to histogram region 

Toggles zoom tool to zoom into highlighted histogram region. 

 Best fit zoom for all histogram 

Resets zoom level to best-fit range for all histograms. 
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  2.7 Track and Lineage Editing 

CL-Quant provides a way for the user to create new tracks or modify existing tracks and/or 
lineage in an image sequence to optimize the result. To launch the track and lineage editing 
mode, click on “Toggle trajectory editor” icon on the toolbar (below). 

 

 

2.7.1 Track Editing Grid 

Clicking on the “Toggle trajectory editor” icon will launch the Track Editing Grid below the 
image. Controls for the Track Editing Grid are shown below: 

 

 

 Track editing mode 
Enables the user to use the grid to connect and disconnect multiple tracks and to trim track 
points. 

 Lineage editing mode 
Enables the user to use the grid to view track lineages and to connect and disconnect 
lineages. 

 Snap to peak 
Enable this option to use peak detection algorithm and detect likely track point location 
when interpolating track points. 

 Undo 
Undo the previous track editing action. 

 Redo 
Redo the last undone track editing action. 

 Pin all tracks to list 
Toggle this icon to pin/unpin all tracks in the track list. 

 Cut trajectory mode 
This mode toggles the track cutting tool to split tracks. 
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 Sync time frame to image 
Synchronizes selected time frame to current frame and displays the image. 

 

Track list 
Selected tracks will appear in the track list. To remove a track from the track list, click on the 
pushpin icon ( ) next to the track name to “unpin” the track from the grid. You can also click on 
the “Pin all tracks to list” icon ( ) to unpin all tracks. An empty outline of the pushpin icon ( ) 
indicates the track is unpinned. Click anywhere on the image to remove the unpinned track from 
the track list. Note that the track will not be removed from the image, only removed from view in 
the grid. 

Timeline 
Track points of listed tracks are displayed in the timeline. Tracks appear like a “string of pearls” 
in the timeline view, showing the start and end frame of the trajectory. The green highlight 
illustrates the current time frame; double-click on a frame to change the current frame position. 

 

2.7.2 Editing Tracks on the Grid 

The user can edit tracks using the Track Editing Grid or directly manipulating track points on the 
image. This section provides information on managing track edits on the Grid. 

 

(1) Select tracks 

To begin editing tracks, select the track you wish to edit by clicking on the track in the image. 
The selected track will appear in the track list below the image. You can select additional 
tracks by clicking on other tracks, your previous selection(s) are preserved in the track list if 
the track is “pinned”. A pushpin icon ( ) next to the track name indicates the track is pinned 
to the track list. 

 
 

After selecting the tracks you wish to edit, you can begin manipulating the tracks using the 
Track Editing Grid. You can connect two tracks at different point in time or break a track into 
multiple components. Following sections will provide instructions on how to connect and 
disconnect tracks in the Track Editing Grid. 
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(2) Connect tracks 

You can connect any points on two tracks to create a new, connected track by dragging a 
track point on one track on the timeline to another track. In the example below, Track 2 and 
Track New 11 are connected end-to-front to create a continuous track. 

 

 
Two tracks can be joined together even if they do not overlap or appear in adjacent time 
frames. The software will automatically insert the missing time points and interpolate the 
position.  

There are two ways that the track point position is interpolated - by mean distance traveled or 
by peak detection. 

- Mean distance traveled: 

The intermediate points are estimated by dividing the straight line distance between two 
connecting track points by the number of frames between them. 

- Peak detection: 

The software will attempt to interpolate the intermediate points based on their most likely 
position (i.e. at locations where image intensity is the highest). You can turn on peak 
detection by toggling the magnet icon ( ) in the track editing toolbar. 

A comparison between the interpolation approaches are shown below. 

   
 Figure 1 Figure 2 

 
The mean distance traveled method (Figure 1) may place interpolated track points incorrectly 
if they are not near the linear path whereas the peak detection method (Figure 2) will attempt 
to place the interpolated point based on the pixel intensity of the image. 
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(3) Disconnect tracks 

You can break a track into multiple trajectories by dragging a track point down to an open slot 
in the track list at the time point selected. The current track will terminate at the time point 
selected and a new track beginning at the following time point will be created. You can break a 
trajectory as many times as the track length allows. 

In the example below, Track 2 is split into two separate tracks, one spanning frames 0 through 
3 and the other starting from frame 4, by dragging the track point at frame 3 down to an open 
row in the Track Editing Grid. 

 
Separate a track by dragging a track point to an open row in the Track List 

 

 
Old track will terminate at the track point selected and a new track begins in the frame after it. 

 
(4) Trimming tracks 

You can trim the trajectories by highlighting the track points you wish to remove. Press the 
“Delete” key on your keyboard to delete the selected track points. You can also remove an 
entire trajectory by double-clicking on the track and press the “Delete” key. 

 
Highlight the point you wish to remove (hold “Shift” key to select multiple points) 

 

 
Press “Delete” to remove selected track points. The track is trimmed. 
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2.7.3 Editing Tracks on an Image 

In addition to the Track Editing Grid, the user can also edit tracks directly on the image. Track 
editing on the image provides user the additional option to create new tracks, extend existing 
tracks, and move track point positions. 

(1) Create new tracks 

User can draw track trajectories by creating new tracks. This option allows the user to 
generate manual tracks that can be compared against software-generated tracks. To start 
drawing your tracks, right click on the image where you’d like to place the track point and 
select “Create New Trajectory”. 

 

When you start the process of creating a new trajectory, the time lapse sequence will advance 
by one frame automatically. A red arrow shows the direction of the cursor with respect to the 
previous track point location. Left-click on a location on the image where you’d like to set the 
track point and the sequence will advance by another frame. The drawn track will be shown 
as a red line overlaid on the image. 

 

Please note that you will not be able to modify previous track points or to skip frames when 
defining track location while you are in track creation. You may navigate the time sequence 
using the time control below the image. Further track edits are possible after the completion of 
track creation as explained later in this section. 

When you are done with drawing the track, right-click anywhere on the image and select “End 
Trajectory” from the context menu. A new track will be created. 
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(2) Extending existing tracks 

Track extension is very similar to creating a new track with the difference being that a new 
track is created as a continuation of an existing track. To begin track extension, right-click on 
any track point on a track and select “Extend Track” from the context menu. The RFrame will 
automatically navigate to the frame after the end of the selected track. 

 

 
Like in track creation, a red arrow originating from the last track point will indicate the direction 
your cursor is pointing. Left-click on the image to set the location of the track point, the 
sequence will then advance to the next frame. 

When you are done with track extension, right-click anywhere on the image and select “End 
Trajectory” from the context menu to complete the operation. For track creation and 
extension, you may also connect two tracks by right-clicking on a track point and select “End 
Trajectory” from the context menu. You will be prompted to either end the track at the 
selected track point (connect tracks) or create a new track point and maintaining the existing 
tracks. 
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(3) Move track points 

Track points are placed at the center of the tracked mask component. However, a slight shift 
in the detected mask may affect the correct placement of a track point. To move a track point, 
left-click and drag the point you wish to move. Release the left-click at the desired location. 

 
 

(4) Additional track editing options 

There are additional track editing options available by right-clicking on a track point to pull up 
the context menu. An explanation of the functions not covered above is shown below. 

 

 Delete Trajectory - Removes the entire trajectory. 

 Delete Point - Remove the selected track point. Multiple points can be selected by 

selecting two points on the same track while holding down the “Shift” key. 

 Hide Trajectory - Remove the selected trajectory from view. This may be useful when 

editing overlapping tracks. 

 Connect Lineage - Create a lineage from one parent track and two children tracks. 

 Disconnect Lineage - Disconnect children tracks lineage from the selected track. 

 
Connecting and disconnecting lineages will be further explained in the next section, Editing 
lineage. 
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2.7.4 Editing Lineage 

Certain tracking procedure allows the user to track cell division over time in the form of a 
lineage. The lineage editing tool enables the user to define and edit cell lineage plot to track 
division events. 

Enable lineage editing 
To enable lineage editing, click on the Lineage icon ( ) to get started. If you have several 
tracks of a lineage pinned to the Track Editing Grid, enabling lineage will rearrange the tracks to 
display the connected lineage. Tracks without lineage will be displayed normally. 

 
Enable lineage editing off 

 

 
Enable lineage editing on 

 
(1) Connecting lineages 

In order to connect lineages, you must have a minimum of three tracks - a parent track and 
two children tracks. The parent track must terminate before the children tracks, which must 
both start at the same frame.  

To connect a lineage, drag a point on the parent track to any point on a child track to connect. 
Unlike Track Editing, drag-and-connect will not merge the two tracks, the pending 
connections are shown as a gray dotted line connecting the parent to the child. Drag a point 
on the parent track to any point on the second child track to complete the lineage connection. 

 
Click-and-drag parent track to child track to connect 
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Pending connections shown as gray dotted line 

 

 
Click-and-drag parent track to second child track to complete lineage connection 

 

 
Completed lineage connection 

 
You can also connect lineages on the image using “Connect Lineage” option from the 
context menu. You must have three tracks selected. 

 
(2) Disconnecting lineages 

To disconnect a lineage, click-and-drag the termination point on the parent track to any open 
space in the Track Editing Grid. 

 
 

You can also right-click on a track with lineage on the image and select “Disconnect 
Lineage” from the context menu to disconnect lineage from the selected track. 
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2.7.5 Update Track Measurements 

Track measurements will need to be updated after editing to ensure accurate calculation of 
track characteristics. You may choose an existing tracking procedure (from a recipe) or load a 
new tracking procedure to update the measurements. This process will modify the track 
measurements while preserving the tracks. 

 

 
To update track measurements without exiting the track editing mode, click on the arrowhead 
icon below the track editing button in the toolbar to see additional track editor options. Select 
the tracking procedure you wish to use for the update in the drop down menu. Click the “Update 
Now” button to update the track measurements and stay in track editing mode. 

Track measurements will be updated automatically when exiting the track editing mode. 
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  2.8 Mask Editing 

CL-Quant allows the user to create new mask objects or edit existing mask objects to optimize 
segmentation. Click on the Mask Editor icon (below) to begin. 

 

(1) Draw mask regions 

Once in the mask editing mode, you can use the mouse cursor to draw mask regions on the 
image directly as shown below. Newly created mask regions will be overlaid on the image and 
masks. 

 

New mask region created using the Mask Editor 
 
 

Click on the mask region to bring up the object bounding boxes. You can move the mask 
region by holding down the left-mouse button while dragging the mask region; or resize the 
region by clicking and dragging the corners and edges of the bounding box. 

 

Mask region with object bounding box 
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Drawing tools 
User may specify a different mask drawing tool in the “Mask Edit Tool” tab. Open the 
“LUTs”/“Charts” panel and click on the “Mask Edit Tool” tab to view the available drawing 
modes. 

 

 

 

 

 Free form shape 
User can create any shape mask regions using the free-form shape. To create a region, 
hold down the left mouse button on the image and move the mouse around regions desired. 

 Polygon 
User can specify straight-edged polygons using the polygon tool. To create a region, 
left-click anywhere on the image, click once to specify a point on the polygon 

 Free form line 
User can create a free form line mask region using the free form line tool. To create a region, 
hold down the left mouse button on the image and draw the line region desired. 

 Straight line 
User can specify a straight-line mask using the line tool. To create a region, left-click 
anywhere on the image, click once to specify the end point of the line. 

For free form and polygon tools, press “Enter” or double-click on the image to complete a 
region. 

Copy mask region 
User may copy selected custom regions or all custom regions to the next time frame using the 
“Copy Selected” or “Copy All” function respectively. The mask regions will be added to the 
next time frame and the user will have the ability to add or subtract said region from mask. 

 

 

Free form line

Straight line 

Polygon

Free form shape 
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(2) Add and remove regions 

After drawing the mask region you wish to edit, you can add or subtract the manual region 
from the working mask using the context menu. 

Add regions to mask 
If your original mask appears under-segmented, you can add mask region to an existing 
mask by drawing in the filling region. Right-click on the edited region and select “Add To 
Mask” in the context menu to combine the existing mask with the new region. 

 
 

Remove regions from mask 
If your mask appears over-segmented or if false detections are included, you can remove 
mask region from an existing mask by drawing in the region you wish to subtract from the 
original mask. Right-click on the edited region and select “Remove from Mask” in the context 
menu to remove region from the existing mask. 

 

 
 

Cancel drawn region 
You can cancel/remove the drawn region from the image without editing the image mask 
using the “Cancel” option. Right-click on a drawn region and select “Cancel” in the context 
menu to remove the drawn region from the mask editor. No changes will be made to the 
existing image mask and the drawn region will be removed from the mask edit history panel. 
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(3) View mask edit history 

In the mask editor mode, user actions are tracked in mask edit history. To view mask edit 
history, open the “LUTs”/“Charts” panel and select the “Mask Edit Tool”. Mask edit history 
are displayed as a list with actions and coordinates of the mask edit, as shown below. 

 
Mask edit history 

 

Click on an action to display the hand-drawn region on the image. Mask regions that are 
added to the image are shown in green on the image and those that are removed from the 
image are shown in red on the image. Regions that are drawn, but with no actions specified 
are shown in light blue and are listed as “Drawn” in the “Action” column. 

 

(4) Update mask measurements 

Field and object measurements on the mask will need to be updated after mask editing to 
ensure accurate calculation of the mask metrics. Click on the arrowhead underneath the 
“Mask edit tool” icon and select the measurement procedure you wish to use (see below). 
Click “Update Now” to update the measurements immediately. Otherwise, the measurements 
will be updated when you exit from the Mask Editor. 
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  2.9 Action History 

Action history displays a list of all operations done on an FOV. To view action history, go to 
“Tools > View Action History”. 

 
Action History window 

The “Action History” window shows the type of operations done on the FOV and contains 
information about the completed operations. Information such as timestamp and description of 
the operations is displayed. A list of operations visible in the action history window is shown 
below. 

 
Image Mask editor Track Editor Mask Channel Recipe 

Load Add to Mask Track Move Add Add Apply 

Crop Remove from Mask Track Delete Delete Delete  

  Connect Track Insert Insert  

  Disconnect Track Rename Rename  

  Connect Lineage    

 

You can view only filter action history view by action module by selecting on the action group 
pulldown menu. 

 



 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

Chapter 3
 

 

 

 

Teaching CL-Quant



 
 

Chapter 3  Teaching CL-Quant 

Chapter Overview 

 

 90 
 

  Chapter Overview 

This chapter covers functionality used to teach CL-Quant for new applications. If you are 
interested in creating novel experimental analyses, this is the place to start.  

Two main types of teaching are supported: you can update an existing recipe (provided by 
Nikon), or create your own, new procedure list from scratch. 

Recipe Update 
Recipe update is done using the Recipe Console. The Recipe Console provides key parameters 
for updates along with instructions and guidelines. 

Procedure List Creation 
Procedure lists are functionally equivalent to recipes, but can be assembled by you from 
component procedures. For most applications, only segmentation and measurement procedures 
are needed to achieve the desired result. Partition, tracking and decision procedures provide 
additional image recognition functionality. Import and enhancement procedures provide 
additional functionality.  

- Core Procedures (teaching wizards provided) 

Segmentation procedure: This type of procedure defines objects of interest in your images 
using segmentation masks. The masks are used to quantify the 
objects.  

Partition procedure: Many times the initial segmentation mask will cover multiple objects. 
This optional procedure can be used to separate them into individual 
components.  

Measurement procedure: This procedure quantifies the objects in your images. 
 

- Additional Recognition Procedures 

Motility tracking procedure: This type of procedure is used to track objects in images over time. 
You can also specify tracking measurements (it is not necessary to 
use the measurement procedure if you use a tracking procedure). 

Decision procedure: This procedure can be used to classify objects based on their 
measurements. 

 

- Other Procedures 

FOV import procedure: This procedure automates the import of image frames into 
multi-dimensional FOVs, and also multiple FOVs into FOV lists. 

Enhancement procedure 
(teaching wizard provided): 

This procedure automates traditional image processing functions, and 
common tasks (such as adding channels, deleting channels, bit depth 
conversions, etc.). 

 

Innovative teaching wizards are provided to make it easy to create core procedures. These are 
described in the section below. You can combine multiple procedures in procedure lists and 
recipes to streamline image processing and analysis. The recipes can be edited using the Recipe 
Console described in the next section. The creation and configuration of the other types of 
procedures are described in the following sections. 

 
 NOTE: 

 
  
 Procedure creation requires that you have purchased the required functionality. Tracking is

included in the “Tracking” option, and Decision is included in the “Decision” option. 
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  3.1 Recipe Console 

The Recipe Console allows the user to view procedures and to modify key parameters within a 
recipe. The user can also disable or duplicate specific steps of a recipe to fit their image 
processing needs. 

 

 

3.1.1 Launch the Recipe Console 

First load a recipe, and then right-click on the recipe in the Data Explorer. Select the “Update 
with recipe console” from the context menu to launch the Recipe Console. 

 

The Recipe Console will prompt you to choose an image; if no image is loaded into the data 
explorer, click on the “Load” button to load an image into the Recipe Console. The Recipe 
Console provides step-by-step preview such that you can also quickly modify key parameters 
without evaluating its performance on whole image sequences. 
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3.1.2 Recipe Console Interface 

The Recipe Console interface is divided into two panels: control panel and main panel as shown 
in the figure below. An additional Descriptions window can be displayed when clicking on the “?” 
icon in the main panel. Result of adjustments to the parameters in the Recipe Console is 
previewed directly on the image. 

  

 

Control panel 
The parameter display control panel is at the top of the Recipe Console UI that allows the user to 
expand or collapse all visible parameters in a recipe. There are two buttons, as shown below: 

 
 

 Expand all 

Shows all visible parameters in the recipe steps. 

 Collapse all 

Hides all visible parameters in the recipe steps. 

 

Main panel 
The main panel (Recipe console panel) allows the user to make changes to the recipe 
step-by-step with additional descriptions to assist the user in optimizing the parameter settings. 
Each step individually can be expanded or collapsed; or user may opt to expand all or collapse 
all recipe steps by clicking on the “Expand all” or “Collapse all” button. One example of a recipe 
step box is displayed below. 

 
Collapsed recipe step box (header only) 

Control panel 
 

Recipe Console panel 
(Main panel) 

 

Recipe step header 
(with recipe step box shown) 

 
 
 
 
 
 
 

Recipe step header 
(with recipe step box hidden) 

 
 
 
 
 

Control buttons 
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Expanded recipe step box 

The recipe step headers have different number of buttons to enable easy access to description, 
apply recipe step, and recipe options depending on the configuration of the recipe step. 
Descriptions of the buttons are shown below. 

 

 

 

 

 Toggle advanced parameters 

If available, shows advanced recipe parameters. 

 Launch update wizard 

If available, launches procedure update wizards interface. 

 Show descriptions 

Shows description of the current step in a new window. 

 Apply recipe step 

Applies selected step to the entire image. 

 

Launch update wizard 

Toggle advanced parameters 

Show descriptions 

Apply recipe step
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3.1.3 Review or Update Key Parameters 

Some recipe steps will provide one key parameter for your update in the console using controls 
similar to the one shown in the figure below. The parameter panel is hidden by default. To view 
available adjustable parameters, double-click on the recipe step header to expand the recipe 
step. You can adjust the parameter using the slide bar or textbox provided. Use the pulldown 
menu to select an alternate operation for the recipe step (if available). Click on the “Show 
descriptions” button to display the description popup (not shown). The popup provides 
important information about the recipe step and description to updating key parameters. 

 
 

In some recipe steps, an additional option to modify the teaching may be available by clicking on 
the “Open” (magic wand) icon. Please refer to the Procedure update wizards section for more 
information on modifying the procedure teachings. 

When modifying a parameter, recipe changes are previewed on the image instantly. Click the 
“Apply recipe step” button to save changes to the parameters and to apply the recipe step to 
the entire image sequence. 

To revert to recipe default values, click on the “Revert” button next to the parameter textbox. 
Please note that certain functions (such as segmentation and partition updates) cannot be 
reverted. 

 

View image output 
Recipe Console has a built-in function that allows the user to view image output of the whole 
recipe without exiting the Recipe Console. Click the “Run” button at the bottom of the Recipe 
Console page to run the analysis recipe on the loaded image. All image processing steps in the 
analysis recipe will be applied to the image. 

Alternately, you can click the “Apply recipe step” button on the last step of the recipe to apply 
the whole recipe to the image. 

 

Finalize recipe update 
If you are satisfied with the recipe results, you can exit the Recipe Console and save the 
changes by clicking on the “Finish” button at the bottom of the Recipe Console page. All 
changes to the analysis recipe will be saved. 
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  3.2 Procedure Creation Wizards 

Launching procedure creation wizard 
 

To launch the procedure creation wizard, click on the “Wizard” function under the “Tools” menu 
and select the procedure type you wish to create (segmentation, measurement, partition, 
enhancement, tracking, decision, recipe). 

 

 
You can also right click on the segmentation, partition or measurement folders in the data 
explorer and select “New”. This will launch the respective wizard.  
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3.2.1 Segmentation Teaching Wizard 

A segmentation procedure is used to detect structures of interest in the microscopy image so that 
they can subsequently be quantified as field or object measurements. The detection is 
represented as a detection mask that covers pixels belonging to the structures of interest. The 
segmentation procedure creates the detection mask.  

The segmentation teaching wizard will guide you through the steps of creating a segmentation 
procedure. It provides instructions to guide you.  

The wizard is designed to create a single detection mask .To create more than one mask, just 
run the wizard again on the image with its first mask. This will then create a second procedure 
that will create a second mask on the image. 

 

3.2.1.1 Select FOVs 

Select FOVs 
The first step in the wizard is to select the FOVs you want to use for teaching. Multiple FOVs 
can be used. If the FOVs have temporal or Z extent, the first frame in T and the middle frame in 
Z will be used.  

 
 NOTE: 

 
  
 You can exit the wizard and use the FOV crop tool to extract specific frames from the 

multi-dimensional FOV, and then re-launch the wizard and use them for teaching. 

 

 The FOVs must have the channel and mask configuration to be included in the 
same wizard session. 

 

Select channel and mask 
If the FOVs have multiple channels, you will be prompted to select one channel for teaching. If 
the FOV already has one or more masks, you will be prompted to select the mask position or 
create a new mask.  

 

3.2.1.2 Soft Matching 

In this step, you will be asked if you want to perform Soft Matching, or go to thresholding.  

Soft matching is teachable image pattern recognition technology in the software. It generates 
transformed images called a confidence image with enhanced and suppressed patterns based 
on user teaching. A segmentation procedure encodes the user teaching and can be used to 
automatically transform input images in a high volume mode. The transformed confidence map 
can then be thresholded in the next step to generate the detection mask.  

Therefore the goal of segmentation teaching using soft matching technology is to teach a 
transformation where the structures of interest are cleanly separated (made either dark or 
bright) from other structures. 
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In this example above, a segmentation procedure was taught to enhance the internal cell 
patterns (such as nuclei), and suppress cell borders and bright structures. This confidence 
image can be simply thresholded and the mask counted for an accurate measure of cell count 
in the image. See the guidelines for successful soft matching in the next section. 

Steps for Soft Matching 

1. Select a single image as your teaching image 

Teaching is done one image at a time, though you can later review the result of applying the 
function to all teaching images. Select one image to get started.  

2. Draw teaching regions 

This step requires teaching regions of interest (ROI) specified by type. The types include 
“Enhance”, “Suppress”, and “Background” patterns.  

To create a teaching specification, proceed as follows: 

(1) Using the region drawing tools, draw the region(s) for one of the patterns of interest. 

Drawing Tools 

Drawing tools include freehand line tool and freehand region tool. 

- Freehand region tool: a general purpose tool 
- Freehand line tool: specialized to enhance edges 
 
To draw an ROI, simply depress the tool icon and then draw on the image frame. When 
you draw the ROI it will be active, and the segments of the ROI will appear to move 
around the region.  

 
 

(2) Assign the active (moving) regions the pattern type (Enhance, Suppress, or 
Background). 

After drawing an ROI, the user should assign a pattern type to the active ROIs. The 
pixels inside the ROIs become a teaching set for the confidence mapping operation. 

Freehand line tool Freehand region tool
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Pattern Types 

- Enhance:  
Types of image patterns that you want to isolate from the rest of the image, mask and 
quantify. 

- Suppress/Background:  
Types of patterns that you do not want to include in the mask.  

 

The “Background” pattern is processed more quickly. It can be considered as a first 
pass, “Suppress” pattern. The image is then considered more carefully to distinguish 
between “Enhance” and “Suppress” patterns.  

 

 
To assign pattern types to ROIs, click on the appropriate icon as shown above; the green 
check mark is for “Enhance” type, the red “X” is for “Suppress” type and the yellow 
square on blue background is for “Background” type. When you click on the icon, all the 
active ROIs will be assigned the type of the icon you click.  

Activating, deleting and re-assigning ROIs 

Initially when you draw the ROI, it is moving and in an active state. ROIs can only be 
assigned and deleted when they are active. After assignment, the ROI will become 
inactive. In order to re-assign or delete the ROI, click on it to activate it.  

 

 If an ROI becomes deactivated before it is assigned, and has no assignment, 
it will be removed during the soft matching process. 

 

Add/Remove region types 

You may add an additional set of “Enhancement” and “Suppression” ROI types by 
clicking on the “Add” button (circled red below). The additional types allow multiple 
simultaneous soft matching with the results combined. It can be used when one set of 
regions is inadequate for detection. Up to four sets are supported. However, each 
additional set will increase processing time.  

 
(3) Repeat for the other patterns. 

 

(4) Adjust as needed. 

Enhance 

Suppress

Background
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3. Set threshold and review confidence image 

After assigning ROIs and clicking “Next”, soft matching will create a matching model based 
on your teaching. The model is then immediately applied to the teaching image and the 
result is displayed. The results include a confidence image and a threshold overlay 
calculated using the confidence image and shown overlain on the original image as shown 
below. 
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(1) Review the confidence image 

To review the confidence image, toggle off the threshold overlay by clicking the “Hide” 
button (red rectangle), followed by the view confidence image icon (green circle). The 
confidence image will appear in the image panel.  
 

 

 

 

(2) Adjust the threshold overlay 

The threshold is a range of confidence values in the confidence image. Values that fall 
within the range will be overlain in red (red color is reserved for the threshold overlay). If 
you advance to the next step, these pixels will be saved to your segmentation mask. You 
can adjust the threshold range by typing in values or dragging the sliders. The threshold 
tool is described in Section 3.2.1.3, “Thresholding”.  

 Preview on All 

If you select this option the current procedure will be applied to all teaching images for 
your review.  

(3) Next steps 

The wizard provides several options for your next step. These are:  

 Update teaching regions  

If you are not satisfied with your result, you can choose to update the teaching regions 
using the current active image. This will take you back to the draw soft matching 
regions step described above. You can then add or delete teaching regions.  

Select to display 
the confidence 
image 

Click to hide the 
threshold overlay 
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 Teach another image 

If you have multiple images in your teaching set, you can now choose to teach on a 
second image. The teaching from multiple images can be included in the soft matching 
model. 

 Remove current teaching image 

If multiple teaching images are used in Soft Matching, you can remove the current 
teaching image using this option. Select this option to remove the last-taught image 
from the segmentation procedure. All other existing teaching images will be preserved. 

 Remove all teaching data 

Select this option to remove all teaching image and data from the segmentation 
procedure, you will be taken back to the Soft Matching teaching page. This operation 
cannot be reversed. 

 Save threshold to mask 

If the result looks good, select this option. The pixels included in the threshold overlay 
will be saved to create your segmentation mask.  
 

Soft Matching score 

Above the threshold tool settings is the soft matching score. The soft matching score is the 
difference of the mean confidence value of enhancement ROIs minus the mean confidence 
value of the suppression ROIs. A higher score indicates better separation between the 
enhancement and suppression classes. 

 
 

Improve soft matching detection 

The soft matching score can serve as a guide to improve soft teaching. Creating teaching 
regions with clearer distinction between enhancement ROIs (dotted green region) and 
suppression ROIs (red dotted region) will yield a higher score. The figure below shows an 
example of good teaching (top) and bad teaching (bottom) with their respective confidence 
maps. 

 

Good teaching
(High soft matching score) 

Bad teaching
(Low soft matching score) 
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3.2.1.3 Thresholding 

Use the threshold tool (shown below) to create a segmentation mask. The tool highlights a 
range of pixels in the image (original, processed or confidence) whose values fall between the 
parameters you select. If the pixels are within the values, they will be shown having a red 
overlay in the image panel. Thus, if you select all the possible values, then the entire image 
panel will be covered in red.  

 
 

The tool is used to select pixels for inclusion in a segmentation mask. This is the detection 
mask which will be quantified later. 

To use the tool simply: 

1. Click the “Show” or “Hide” button to visualize the selected pixels in the range 

2. Move the slider to adjust the range 

3. Modify the text in the boxes to adjust the text  

Once you select the appropriate range, click “Save threshold to mask” and the selected 
pixels (in red) will be saved to your segmentation mask.  

The threshold tool has many advanced options which are described below. To access the 
advanced options, click on the small button circled in red in the figure above. This powerful tool 
has 2 types of thresholds, 4 offset choices and 2 types of units. The default mode is a direct 
type, bi-modal offset, and levels units. The default should work fine in most cases.  
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Threshold options 

 Threshold type 

“Direct” and “Adaptive” types of thresholding are supported. The adaptive type combines 
thresholding with image processing steps into a simple one step operation.  

Direct With the direct type threshold, the values you select represent the real pixel 
values in the image (i.e. no offset). Thus if you select 0 and 100, pixels in the 
image that have values from 0 to 100 will be covered in the red overlay. This 
is the standard type of threshold in most image analysis software.  
 
NOTE: If you have performed Soft Matching, the overlay is being calculated 

using the pixels in the hidden confidence image, and displayed on 
the original, visible image. 

 
Adaptive Often objects of interest cannot be isolated within a single direct threshold. 

This could be due to intensity gradients from uneven illumination, or from 
global intensity undulations in the image due to accumulation of 
fluorescence in biological structures. For example, it is desirable to be able 
to threshold puncta in a bright region of the image as well as a darker region 
of the image using a single threshold.  
 
The adaptive threshold accomplishes this by normalizing the background 
before applying the threshold. The size parameter determines the degree of 
normalization. A low number is more normalized (to detect smaller 
structures), and a higher number is less normalized (to detect larger 
structures). The size parameter should be set to be roughly the same size 
as the structures of interest in the image (in total pixels). 
 
Comparison with direct type 

Adaptive type differs from direct type threshold in that the values you 
select for the threshold are interpreted with respect to the normalized 
image, not the displayed image in the image panel. The hidden normalized 
image will have a much smaller range of values than the original. 
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 Dynamic Offset 

Dynamic offsets enable the threshold values to adjust dynamically as a function of the image 
content. The tool supports three types of Bi-modal offsets. 

 
 

Bi-modal The tool default offset. Usually the pixel values in an image have a bi-modal 
frequency distribution corresponding to foreground (structures of interest) 
and background pixels. The software automatically determines the bi-modal 
point in the image’s pixel intensity distribution and sets that point to zero, 
thus making the threshold settings dynamic when applied to a set of images 
(each image’s threshold range will vary slightly). The threshold range is 
then set with respect to this bi-modal zero point from -255 to 255. 
 

Dark/Bright 
bi-modal 

Sometimes an application will be more likely to have occurrences of 
uni-modal or tri-modal distributions. In the uni-modal case the bi-modal 
point can move over the peak causing large changes from image to image. 
The dark or bright bi-modal offsets should be used in these cases. The 
algorithm assumes a tri-modal distribution and then sets the offset to favor 
either dark or bright detection. Select “Dark bi-modal” offset if you want to 
segment dark pixels, and “Bright bi-modal” offset if you want bright pixels. 

 

 Threshold Units 

The tool supports levels and histogram percentile scales. 

 
 

Levels This is the standard type of threshold and default unit. Here the unit is image 
gray level. So for an 8 bit image, the threshold values range from 0 to 255 
(range type) or -255 to 255 (bi-modal type). 
 

Histogram 
Percentile 

The units in this case are percentiles. The percentile is calculated with 
respect to the pixel intensity distribution of the image’s pixels. Thus the 
threshold values range from 0 to 100 (range type) or -100 to 100 (bi-modal 
type). So for example, if you increase the threshold value to accommodate 
one more unit, you will bring pixels into the overlay that corresponds to 
increased 1% selection from the pixel intensity distribution. 
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3.2.1.4 Advanced options 

The final step of the wizard prompts you to choose among advanced options: 

 Enable update for this procedure 

If checked, the procedure can be updated in the future using the segmentation teaching 
wizard interface. If unchecked, the procedure will not be updateable, but can be reviewed.  

 Save Soft Matching confidence image 

If you used Soft Matching, any soft matching confidence image will be saved to create a new 
channel if this option is checked.  
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3.2.2 Segmentation Review and Update Wizard 

Existing segmentation procedures can be reviewed and updated using the update and review 
wizard. If update was allowed for the procedure when it was created, you will be able to update 
the procedure parameters using the wizard. If update was not allowed, then you can review the 
teaching and parameters that were used. As you step through the wizard it will apply the 
procedure to the teaching images in real time and show you the steps including pre-processing 
functions, thresholding, mask refinement, and saving options. 

To update or review an existing procedure, load the procedure and right click on it in the data 
explorer and select “Review with Wizard” or “Update with Wizard” as shown below. 

 
 
3.2.2.1 Review FOVs, channels and masks 

At first the wizard will orient you to the FOVs used for teaching. It will show you the FOVs used 
for teaching, the specific channel used, and the mask position that was taught.  
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3.2.2.2 Review or update soft matching regions 

If Soft Matching was used, you will be able to review the teaching images as shown below. 

 

 
On the next page, you will be able to review the soft matching results, as well as additional 
options for updates and reviews. To review teaching data, select “Review teaching data” and 
click “Next”. 
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3.2.2.3 Review and update threshold parameters 

At this step, you can review the confidence image, review the detection mask, review the 
threshold overlay and modify the threshold overlay (which will change the detection mask). 

Steps 

1. Review default threshold overlay 

At this step, a detection mask with the threshold settings from the procedure will be 
displayed. To toggle the detection mask click on the “View overlay” icon. 

2. Review confidence image 

You can also review the confidence image by clicking the “Show Confidence Image” icon 
shown below. 

 
 

3. Adjust threshold settings 

You can adjust the threshold parameters (to make the detection mask more or less 
sensitive) by adjusting the threshold slider (green circle) and associated text box. The 
updated threshold setting is overlaid automatically on the image. The “Reset Value” button 
(red rectangle) will restore the procedure’s original setting. 

 

 

 

 
3.2.2.4 Advanced options 

Here you can change the selection for intermediate image saving (confidence image). 
Intermediate images will be saved as a channel in the FOV after the procedure is applied. 

You can also elect to make the procedure non-updateable.  

 

 

Click to restore 
the original 
settings. 

Use the slider to adjust 
the threshold 
parameter. 
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3.2.3 Partition Teaching Wizard 

A partition procedure is used to divide a segmentation mask into discrete components 
corresponding to individual structures of interest. The partition wizard will guide you through the 
steps of creating a partition procedure. It provides instructions to guide you. When completed, 
you will have created a partition procedure.  

The wizard includes the following steps: 

1. Select FOV:  
More than one FOV can be selected for teaching. 

2. Teach cell pattern:  
Teach the software what your cells look like.  

3. View teaching result:  
Based on the partition result, give the software more teaching examples to improve 
performance.  

 
3.2.3.1 Select FOVs 

Select FOVs 
The first step in the wizard is to select the FOVs you want to use for teaching. Multiple FOVs 
can be used. If the FOVs have temporal or Z extent, the first frame in T and the middle frame in 
Z will be used. The FOV must have a mask before it can be used for partition teaching.  

 
 NOTE: 

 
  
 You can exit the wizard and use the FOV crop tool to extract specific frames from the 

multi-dimensional FOV, and then re-launch the wizard and use them for teaching. 

 

Select mask 
If the FOVs have multiple masks you will be prompted to select one mask for teaching. The 
wizard can only be used to teach partitioning for one mask at a time (multiple procedures can 
be used to partition multiple masks). 
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3.2.3.2 Teach cell pattern 

Steps for teaching 

1. Soft fitting 

To teach soft fitting, use the region selection tools in the Soft Fitting section (shown below). 
You can select existing regions and define new regions using the tools. 

Tools and buttons of the Soft Fitting area 

The Soft Fitting section provides three types of region selection tools and buttons: 

  Pointer 

The pointer tool allows the user to select existing regions on the image. 

  Draw regions to cut 

Use this tool to specify the cut regions (i.e. cell boundaries) 

  Draw regions to keep 

Use this tool to specify the keep regions (i.e. cell bodies) 

 Add Image - Use this button to add a teaching image. 

 Delete Image - Use this button to delete a teaching image. 

 Smoothing kernel size - Specify the smoothing kernel size for smoothing the Soft fitting 
 confidence image. 

 Teach - Click this button to view soft fitting confidence map. 

 
Soft fitting section of Partition Wizard 

 
Select the region tool you wish to use and draw directly on the image. Soft fitting uses two 
region types - Cut and Keep - as guides for separating confluent cell regions. The Cut 
regions are shown with a red dotted border while the Keep regions are shown with a green 
dotted border. 
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Example of Soft Fitting teaching with Cut (red) and Keep (green) regions specified 

 
For best results, define a Keep region inside each Cut region to ensure optimal pattern 
recognition of the partition regions. When you are finished, click the “Teach” button to view 
the confidence image. 

2. Review confidence image 

When you click the “Teach” button, a confidence map showing the boundaries and cell 
bodies is generated in the confidence channel. Keep regions should appear bright in the 
confidence channel and should be clearly separated by dark regions that represent the Cut 
regions and background (below). 

 
Soft fitting confidence image with regions overlay 

 
As shown in the confidence image above, there are good intensity separation between the 
cell boundaries and cell bodies. At this point, you can define addition cell regions and click 
“Teach” again to generate a new confidence image. 

Next, seed masks are generated that will serve as the guide for partitioning the confluent cell 
region masks. 
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3. View seed masks 

Seed masks are used as a guide for cell partition. The masks are generated from 
thresholding the confidence image. Three seed masks will be generated for partition - large, 
small, and medium. To view the seed masks, click the “Create Seeds” button in the Partition 
section. 

 
The seed masks are generated in the confidence channel image and can be viewed by 
toggling their respective masks tab above the image. 

 
Adaptive seed mask overlay on the confidence channel 

 
You can modify the sensitivity of the seed masks by adjusting the threshold slider in the 
Partition section. A higher threshold will result in more refined seeds but may also remove 
certain seeds. For best results, use the lowest possible threshold value that will provide you 
with good small seeds for all cells. 
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3.2.3.3 View partition result 

After you have optimized the seed masks, use the cell size slider to specify the approximate 
sizes of each cut region. The Partition wizard will attempt to cut cell regions into discrete cell 
components that are within the specified cell size range. 

 

The Create Annotation tool  on the toolbar can assist you with specifying the size range. 
For best results, measure the region size of the smallest and largest cell in the image. 

To view the partition result, click “Apply”. The partition output will be generated in the 
“Output” mask in the original image channel. If you are not satisfied with the output, you can 
re-teach soft fitting by editing the teaching regions by drawing. If you are satisfied with the 
result, click “Save” to save the teaching and “Finish” to quit out of the Partition update wizard. 

Select input and output 

User can specify the input channel and mask, as well as the output channels and mask in 
the “Input & Output” tab of the Partition Wizard. 

Note that existing data in the specified output channel or mask will be overwritten by the 
Partition Wizard output. 
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3.2.4 Partition Procedure Update Wizard 

Existing partition procedures can be reviewed using the procedure review wizard. Unlike all other 
procedures, partition procedure update is not supported at this time. You can use the wizard to 
review the teaching and parameters that were used. As you step through the wizard it will apply 
the procedure to the teaching images in real time and show you the steps involved.  

To review an existing procedure, load the procedure and right click on it in the data explorer and 
select “Review with Wizard”. 

 

Steps for reviewing procedures 

1. Review FOVs, channels and masks 

At first, the wizard will orient you to the FOVs used for teaching. It will show you the FOVs used 
for teaching, the specific channel used, and the mask position that was taught.  

2. Review soft fitting teaching 

Next, the review wizard will show you the regions drawn for soft fitting teaching. At this step, 
you can add or remove additional teaching images or redraw soft fitting teaching regions. 

3. Review soft fitting confidence 

Click “Teach” to run the soft fitting algorithm on the image to generate a confidence map of cell 
body and cell boundary. 

4. Review threshold and seeds 

Click “Create Seeds” to see the seed masks that will be used as cell partition guides. You can 
modify the threshold to change seed detection sensitivity and specify desired size range. 

5. Review partition mask 

Click “Apply” to apply image partition to the detection mask. 
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3.2.5 Measurement Configuration Wizard 

A measurement procedure is used to quantify structures of interest in your images. This wizard 
will guide you through the steps of creating a measurement procedure. It provides instructions 
and tutorials to guide you. When completed, you will have created a measurement procedure for 
your application. The wizard includes the following steps: 

1. Teaching image selection 

2. Measurement type selection 

3. Measurement selection 

4. Additional options 

 
3.2.5.1 Teaching image selection 

Choose an image representative of your application. Its channels and masks must be in the 
same positions as the FOVs on which you will apply the procedure.  

 

3.2.5.2 Measurement type selection 

Choose between object or field types of measurement. 

- Object measurements:  
Calculated for discrete mask components individually. An example of an object 
measurement would be the mean intensity and area for each individual cell in an image. 

- Field measurements:  
Calculated for the entire mask. An example of a field measurement would be the wound size 
in a scratch wound assay.  

 

Specify the primary mask for object 
If you choose object type measurements and have more than one mask, you will be prompted 
to select the primary mask. The primary mask has a one to one relationship with the biological 
object in the image. For example, a nuclear stain would usually be used for a primary mask. 
One mask component in the primary mask can be associated with multiple components in the 
non primary masks. 

When you apply an object measurement procedure, ROIs will appear overlain on the image 
identifying individual objects. See Section 2.6.1, “(1) Objects and Subsets”. 

 
3.2.5.3 Measurement selection  

(1) Measurement selection for single mask 

Measurement selection is easy for most applications. The figure below shows the 
measurement selection interface for an application with two channels (Ph and Fl) and one 
mask. You simply select the morphology measures you want, and then select the intensity 
measures for each channel. The intensity measures are configured for each channel 
independently. In this case no intensity measures are selected for the Ph channel (red arrow), 
while all intensity measures are selected for the Fl channel (green arrow).  
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(2) Measurement selection for multi-mask 

Measurement selection in the multi-mask and multi-channel scenario is similar to the 
one-channel, one-mask case. However, in addition, morphological measures can be 
specified for each mask. Intensity measures can be specified for each mask on each 
channel.  

In the wizard UI, each mask has its own tab. Click on the tabs at the bottom (blue and red 
circles below) to switch between them. For each mask, specify its morphological and 
intensity measures. Intensity measures are specified for each channel individually. When you 
switch between masks, the displayed name at the top of the panel will change to display the 
current mask name (arrows).  
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(3) Measurement definitions 

The following morphology and intensity measurements are provided: 

 

Morphology measurement 
 

Area The number of pixels in the mask.  
 

Area to image size ratio The ratio of the mask area to the area of the whole image field of 
view (FOV). 
 

Centroid X The x coordinate of the mask centroid. The coordinate origin is this 
top left corner of the image frame. Centroid is essentially the 
average x location of the mask (sum of x coordinates divided by 
the total number of pixels in the mask). Centroid is only calculated 
for binary images (not using the image intensity). 
 

Centroid Y The y coordinate of the mask centroid. The coordinate origin is this 
top left corner of the image frame. Centroid is essentially the 
average y location of the mask (sum of y coordinates divided by 
the total number of pixels in the mask). Centroid is only calculated 
for binary images (not using the image intensity). 
 

Compactness A measure of the masks elongatedness and compactness. It is 
defined as perimeter2 / area. 
 

Component Count The number of discrete units in the mask.  
 

Length The length of the mask is defined as the number of pixels in the 
major axis of the best fitting ellipse to the mask.  
 

Length-width ratio The ratio of length to width.  
 

Orientation Orientation measured with respect to top left corner of image. 
Angle in radians.  
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Perimeter The boundary of the mask. It is the pixel count of the boundary 
pixels just inside the mask. Internal holes in the mask are counted. 
 

ROI Width The width of the bounding box encompassing the object. 
 

ROI Height The height of the bounding box encompassing the object. 
 

Width The width of the mask is defined as the number of pixels in the 
minor axis of the best fitting ellipse to the mask.  
 

 

Intensity measurement 
 

Coefficient of variation in 
intensity 

The coefficient of variation is defined as the ratio of the standard 
deviation of intensity to the mean of intensity.  
 

High intensity The 95% intensity value measured in the mask, measured on the 
grayscale image. 95% is the value below which 95% of the pixel 
intensity values fall. The pixels belong to the mask and are 
measured on the grayscale image. 
 

Low intensity The 5% intensity value measured in the mask, measured on the 
grayscale image. 5% is the value below which 5% of the pixel 
intensity values fall. The pixels belong to the mask and are 
measured on the grayscale image. 
 

Max intensity The maximum of the intensity values measured in the mask. The 
maximum intensity value is the highest value measured from the 
pixels in the mask on the grayscale image. 
 

Mean intensity The mean of the intensity values measured in the mask, 
measured on the grayscale image. Mean is defined as the sum of 
the intensity values in the mask divided by the number of pixels in 
the mask.  
 

Median intensity The median is the number separating the higher half of the 
sample from the lower half. Here the sample is the pixel intensity 
values in the mask measured on the grayscale image.  
 

Min intensity The minimum of the intensity values measured in the mask. The 
minimum intensity value is the lowest value measured from the 
pixels in the mask on the grayscale image.  
 

Standard deviation of 
intensity 

The standard deviation is a measure of the spread of the intensity 
values measured in the mask on the grayscale image. The 
formula for the standard deviation of a random variable is used.  
 

Total intensity The sum of the intensity values measured in the mask using the 
grayscale image.  
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3.2.5.4 Additional options 

You can create advanced measurements (derived from the base measures) and you can 
rename measurements. On the final step you can set whether the procedure can be modified 
or not. 

Measurement renaming 
The default naming convention is channelName.maskName measurementName. You can 
define your own measurement names (for both regular and derived measures) by right clicking 
on the measurement and typing a new name. When you apply the procedure, the name will 
appear just as you’ve written it.  
 

  

 

Advanced measurements 
You can derive measurements using existing measures you created in the selection step. 
Common types of derived measures include ratios and differences. When you click on the 
“Add” button, a new tab will appear in the wizard containing the derived measurement.  
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 Use an equation 

Enable this option to define a customized advanced measurement equation using “first” and 
“second” for Measurements 1 and 2 respectively. You can create temporal measurement for 
the measurement equations by modifying the time value in the square bracket following the 
measurement notations. You can click on the “Add Template” button to create an equation 
template for multiple measurements. 
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3.2.6 Measurement Procedure Update Wizard 

Existing measurement procedures can be reviewed and updated using the update and review 
wizard. If update was allowed for the procedure when it was created, you will be able to update 
the procedure measurements using the wizard. If update was not allowed, then you can review 
the teaching and parameters that were used.  

To update or review an existing procedure, load the procedure and right click on it in the data 
explorer and select “Review with Wizard” or “Update with Wizard”. 

 

Steps for reviewing and updating procedures 

1. Review teaching image 

In the first step, the wizard will show you the model image used for configuration. The 
procedure logic is tied to the FOV’s channel and mask structure.  

2. Confirm object or field measurement 

Next, you will be shown whether the procedure is a field or object measurement procedure. If 
the latter, you will be shown which mask is used as the Primary Mask (see previous section). 
Even if the procedure is updatable, you are not allowed to change these settings.  

3. Review measurements 

Here you can review the procedure’s measurements. If the procedure is updatable you may 
modify the measurements.  

4. Define advanced measurements 

Here you can review the procedure’s advanced measurements. If the procedure is updatable 
you may modify the measurements.  

5. Enable update 

Lastly you can confirm the update status of the procedure. If update is enabled, you can 
change the procedure to be non updatable. 
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3.2.7 Enhancement Procedure Wizard 

An enhancement procedure is a powerful tool that contains a large set of traditional and 
innovative image analysis functions. Advanced users and customer support can use the wizard 
interface to create custom procedures for specialized applications. The enhancement 
procedures can be incorporated into template or custom recipes for even more robust 
applications. 

This section covers how to create an enhancement procedure. Teaching an enhancement 
procedure is similar to creating a macro using other tools. Your processing order, parameters, 
inputs and outputs are recorded to the RFrame history. You can then save this history to an 
enhancement procedure and select additional advanced editing options. 

 

3.2.7.1 Basic operations 

(1) Select FOVs 

The first step in the wizard is to select the FOVs you want to use for teaching. Multiple FOVs 
can be used. Click “Next” to continue. 

 
 NOTE: 

 
  
 You can exit the wizard and use the FOV crop tool to extract specific frames from the 

multi-dimensional FOV, and then re-launch the wizard and use them for teaching. 

 

(2) Enhancement functions 

The enhancement wizard interface (shown below) is similar to the enhancement module 
interface. There are three tabs on the right to provide specific function sets for the user to 
choose from.  

 



 
 

Chapter 3  Teaching CL-Quant 

3.2 Procedure Creation Wizards >> 3.2.7 Enhancement Procedure Wizard 

 

 123 
 

- Image Enhancement: 
A selection of powerful image enhancement functions (such as background normalization 
and flatten background) which are commonly used in standard and template recipes.  

- Mask Refinement: 
A selection of powerful mask manipulation functions (i.e. partition and gating of single 
components) which are commonly used in standard and template recipes.  

- Advanced: 
The complete set of image processing functions.  

(3) Execute enhancement functions 

Select the enhancement function you’d like to apply from the list. The function parameter 
panel appears, providing a thumbnail for the input and output channel or mask. 
Drag-and-drop the channel or mask onto the input thumbnail and drag-and-drop the output 
thumbnail to an existing or new channel or mask to define the input and outputs. 
In the example below, the “red” channel (red arrow) is designated as input and output the 
operation to “Channel 3” (blue arrow). 

 
 

Some functions provide several key adjustable parameters. Use the slider bar or the textbox 
to change the parameter values. Press “Execute” (green box, above) to apply the function to 
the image. Note that the executed function is saved automatically in the operations history. 

Click “Menu” to return to the function selection screen to add new enhancement functions. 
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(4) Configure temporal parameters 

You can apply the functions between time frames by setting the temporal parameters. You 
can set an offset from either the current time point, or the beginning or end of the movie. Note 
that the enhancement procedure will be subject to any apply procedure parameters such as 
range or frequency, in which case the first and last frame of the movie would be replaced by 
the first and last frame of the apply procedure range.  

 

 
In the example above, the “green” image at the current time (in Input1) is added to the 
“green” image of the next frame (in Input2) and the resultant image is output to “Channel 3”. 
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(5) Edit enhancement functions 

 

 
 

- Delete an operation: 

To delete an operation, right-click on the item in the operations history and select “Delete” 
from the context menu. Note that changes to the image cannot be undone by deleting the 
operation. 

- Edit an operation: 

To edit an enhancement function, double-click on the operation or right-click on the operation 
and select “Edit” from the context menu. You will be taken to the edit mode where you can 
modify the input, output, and key parameters. Press “Update” to save changes to the 
function. Press “Menu” to return to the function selection screen. 

 
 NOTE: 

 
  
 You can edit another function while in the edit mode by clicking on a different operation.

 

- Apply an operation: 

To apply a specific operation, select the operations from the list. Right-click on the selected 
operations and choose “Apply” from the context menu. This function will apply the selected 
operations. 

(6) Configure additional options 

You can set additional enhancement procedure options by selecting the “Configuration” tab 
above the operations history panel. 

 Create fixed frame output 

Makes the procedure act as a single frame procedure. When applied to a time-lapse FOV, 
a single frame procedure will act only on one frame. This will create a “fixed point” channel 
or mask in the time-lapse FOV. This is a special static type of mask or channel that can be 
associated with the rest of the time-lapse FOV. This is very useful for image normalization, 
or for using a single detection mask across the time-lapse FOV. 

(7) Create the procedure 

When you have finished creating the enhancement procedure, press “Close” to return to the 
wizard screen. The enhancement procedure you have created will be executed and shown in 
the preview image on the left side.  

Click “Finish” to complete the Enhancement Wizard and return to the main screen. 
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3.2.8 Enhancement Function Definitions 

This section describes various enhancement functions for enhancement procedures. Each item 
defines a group of operations as it appears in the Enhancement Module. 

 

3.2.8.1 Image Enhancement 

Image enhancement functions provide powerful tools to enhance the input image to optimize 
detection and analysis. There are eight image enhancement functions and the function 
definitions are shown below. 

 Enhance Texture 
Adds texture to the image to better improve foreground-to-background separation. 

EnhanceTexture (image input, bool useDiscKernel, int32 discKernelSize, int32 
xKernelSize, int32 yKernelSize, int32 enhanceFactor, single downsamplePct, image 
output) 

 Flatten BG 

Normalizes the background intensity of an image to a desired value to correct tilted image 
or uneven illumination. 

  
 Figure 1 Figure 2 
 

 

 

There are three Flatten BG functions to correspond to kernel sizes: 

FlattenBG, Large 
(image input, int32 bgValue, 
image output) 

Flattens image background to the desired bgValue using a 
kernel size of 255. 
 

FlattenBG, Medium 
(image input, int32 bgValue, 
image output) 
 

Flattens image background to the desired bgValue using a 
kernel size of 65. 

FlattenBG, Small 
(image input, int32 bgValue, 
image output) 

Flattens image background to the desired bgValue using a 
kernel size of 7. 
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 Normalize Background 

Normalizes the image intensity of an input image to a desired range. This function is 
particularly useful for image sets with very different brightness. 

NormalizeBackground (image input, int32 desiredRange, int32 ReferencePercentile, 
int32 ImageHeight, image output) 

 Peak Based Segmentation 

Takes a distance-transform image and performs iterative guided partition to separate 
touching mask components. 

PeakBasedSegmentation (image input, image output, int32 StartingLevel, int32 
EndingLevel, int32 largestSeed, int32 smallestSeed, int32 step) 

 Remove Background 

Performs an open residue operation on the original image to remove the background of the 
image. 

RemoveBackground (image input, int32 kernelSize, image output) 

 Remove Bright Spots 

Removes spots that are relatively brighter than the kernel surrounding it. 

RemoveBrightSpots (image input, int32 filterSize, image output) 

 Remove Dark Spots 

Removes spots that are relatively darker than the kernel surrounding it. 

RemoveDarkSpots (image input, int32 filterSize, image output) 

 Remove Texture DS 

Performs iterative opening followed by closing to remove texture in the image. This 
function also downsamples the image. 

RemoveTextureDS (image input, int32 filterSize, image output, single percentDS, image 
output) 

 

3.2.8.2 Mask Refinement 

Mask refinement enhancement functions allow the user to refine input detection masks and 
prepare the image masks for further post-processing and analysis operations. There are six 
mask refinement functions and their function definitions are listed below. 

 Dilate 

Takes the maximum value of all pixels in the kernel neighborhood of a pixel in the input 
image and propagates the pixel maximum value to all the pixels in the kernel 
neighborhood. The height and width of the kernel is the same. 

Dilate (image input, int32 kernelSize, image output) 

 Erode 

Takes the minimum value of all pixels in the kernel neighborhood of a pixel in the input 
image and propagates the pixel minimum value to all the pixels in the kernel neighborhood. 
The height and width of the kernel is the same. 

Erode (image input, int32 kernelSize, image output) 
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 Fill Holes 

Fills in small, enclosed gaps in the input mask and stores result to output. 

FillHoles (image input, int32 sizeValue, image output) 

 Guided Partition 

Segments a contiguous binary input mask into discrete objects. Partition follows an input 
reference seed mask. Partitioned mask is stored to output. 

GuidedPartition (image input, image seed, bool fourConnected, image output) 

 Peak-Based Partition 

Performs a distance transform operation on the input mask followed by iterative guided 
partition to separate touching object masks. 

PeakBasedPartition (image input, image output, int32 StartingLevel, int32 EndingLevel, 
int32 largestSeed, int32 smallestSeed, int32 step) 

 Remove Objects 

Removes input mask objects that fall below a specified cutoff size. 

RemoveObjects (image input, int32 sizeValue, image output) 

 

3.2.8.3 Advanced 

Power users wishing to perform additional image enhancement operations may select 
enhancement functions from the “Advanced” section. All enhancement functions in the 
“Image Enhancement” and “Mask Refinement” sections can be found here along with 
additional arithmetic, logic, morphological, and more post-processing functions. 

This section will describe the advanced function in more detail. 

 

(1) 3D operations 

3D operations are used to process Z-stack images and generate intensity projection output in 
2D. 

 

 HSEDF Projection 

Takes an input Z-stack and generates a 2D extended depth of focus (EDF) intensity 
projection image. The EDF projection combines the in-focus pixels of each Z-stack image 
into one image, ensuring that the projection output is all in focus. 

HSEDF Projection(input 
image, output image) 

This uses an extended depth of focus (EDF) algorithm to 
combine in-focus pixels of all Z-stacks into one projection 
image. 
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(2) Arithmetic operations 

Arithmetic operations apply basic image arithmetic to manipulate the pixel intensity value of 
the input image. A list of arithmetic operations is shown below. 

 

 
Descriptions of operations and their sub-operations are given below, along with their input 
parameters. 

 Add 

Combines the intensity of two inputs to generate an output image. Two sub-operations are 
available: 

Add (constant) 
(image input, int32 c, image 
output, arithmeticScheme) 

This function takes an image and an integer as inputs and 
adds the integer to the pixel intensity value of the input 
image. 
 

Add (image) 
(image input1, image input2, 
image output, arithmeticScheme)
 

This function takes two images for inputs and combines 
their pixel intensity value and store results to output 
image. 

 Divide 

Divides the intensity of the first input by the second input to generate an output image. 
Three sub-operations are available: 

Divide (constant) 
(image input, int32 c, image 
output) 

This function divides the pixel intensity value of the input 
image by the integer constant c and stores result to 
output image. 

Divide (decimal constant) 
(image input, single c, image 
output) 

This function divides the pixel intensity value of the input 
image by a single precision float constant c and stores 
result to output image. 
 

Divide (image) 
(image input1, image input2, 
image output) 

This function divides the pixel intensity value of input 
image 1 by input image 2 and stores result to output 
image. 
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 Rotate 

Shifts the bits of each pixel in the input image by the number of bits specified by shiftCount. 
Two functions are available: 

LeftRotate (image input, int32 
shiftCount, image output) 

This function performs a left shift on the bits wrapped 
around from Most Significant Bit (MSB) to Least 
Significant Bit (LSB) and stores result to output image. 
 

RightRotate (image input, int32 
shiftCount, image output) 

This function performs a right shift on the bits wrapped 
around from LSB to MSB and stores result to output 
image. 
 

 Shift 

Moves the bits of each pixel in the input by the number of bits specified by shiftCount. Two 
functions are available: 

LeftShift (image input, int 32 
shiftCount, image output) 

This function performs a left shift on the bits with the MSB 
discarded and results are stored to output image. 
 

RightShift (image input, int32 
shiftCount, image output) 

This function performs a right shift on the bits with the 
LSB discarded and results are stored to output image. 
 

 Multiply 

Multiplies the intensity of the first input by the second input to generate an output image. 
Three sub-operations are available: 

Multiply (constant) 
(image input, int32 c, image 
output, arithmeticScheme) 

This function multiples the input image by an integer 
constant c and stores result to output image. 
 

Multiply (decimal constant) 
(image input, single c, image 
output, arithmeticScheme) 

This function multiples the input image by a single 
precision float constant c and stores result to output 
image. 
 

Multiply (image) 
(image input1, image input2, 
image output, arithmeticScheme)

 

This function multiplies input image 1 by input image 2 
and stores result to output image. 

 Subtract 

Subtracts intensity of the second input from the first input to generate an output image. 
Two sub-operations are available: 

Subtract (constant) 
(image input, int32 c, image 
output, arithmeticScheme) 

This function subtracts an integer constant c from the 
input image and stores result to output image. 
 

Subtract (image) 
(image input1, image input2, 
image output, arithmeticScheme)
 

This function subtracts input image 2 from input image 1 
and stores result to output image. 
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(3) Bitwise operations 

Bitwise operations perform pixel-wise boolean function to the image and generates binary 
output image corresponding to the true/false state of each pixel. The list of bitwise operations 
appears below. 

 
 

Descriptions of operations and their sub-operations are given below, along with their input 
parameters. 

 Pixel And 

Performs boolean “and” operation between the two inputs and stores result to output 
image. Two sub-operations are available: 

PixelAnd (image) 
(image input1, image input2, 
image output) 

This function performs boolean “and operation” between 
each similarly-positioned pixels in inputs 1 and 2. 
 

PixelAnd (constant) 
(image input1, int32 c, image 
output) 
 

This function performs boolean “and” operation between 
each pixel in image input and integer constant c. 

 Pixel Not 

Performs a boolean “not” operation between each pixel in the input image. This function 
inverts the image input and stores result to output image. Function input parameters are 
described below. 

PixelNot (image input, image output) 

 Pixel Or 

Performs a boolean “or” operation between the two inputs and stores result to output 
image. Two sub-operations are available: 

PixelOr (image) 
(image input1, image input2, 
image output) 

This function performs a boolean “or” operation between 
each similarly-positioned pixel in inputs 1 and 2. 
 

PixelOr (constant)  
(image input, int32 c, image 
output) 
 

This function performs a boolean “or” operation between 
each pixel in image input and integer constant c. 
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 Pixel Xor 

Performs a boolean “exclusive or” (“xor”) operation between two inputs and stores result to 
output image. Two sub-operations are available: 

PixelXor (image) 
(image input1, image input2, 
image output) 

This function performs a boolean “xor” operation between 
each similarly-positioned pixel in inputs 1 and 2. 
 

PixelXor (constant) 
(image input, int32 c, image 
output) 

 

This function performs a boolean “xor” operation between 
each pixel in image input and integer constant c. 
 

 

(4) Comparison operations 

Comparison operations perform pixel-wise comparison between two inputs to generate 
output result corresponding to the comparison metric. A list of comparison operations is 
shown below. 

 

 
Descriptions of operations and their sub-operations are given below, along with their input 
parameters. 

 Between 

Checks each pixel in input and returns true (255) if pixel intensity is between the upper and 
lower value and returns false (0) if outside the lower and upper value limits. Input 
parameters of the between function is shown below. 

Between (image input, int32 lower, int32 upper, image output) 

 Equals 

Checks each pixel in the first input and returns true of the pixel intensity is equal to the 
value of the second input. If equal, the function returns true (255) for that particular pixel 
and false (0) if not equal. Two sub-operations are available: 
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Equals (image) 
(image input1, image input2, 
image output) 

This function checks the pixel intensity of each equivalent 
pixel in input images 1 and 2 and returns true if the 
equivalent pixel intensities are equal. 
 

Equals (constant) 
(image input, int32 c, image 
output) 

This function checks the pixel intensity of each pixel in 
the image input against an integer constant c and returns 
true if the pixel intensity equals the value of c. 
 

 Greater Than 

Checks each pixel in the first input and returns true if the pixel intensity is greater than the 
value of the second input. If greater than, the function returns true for that particular pixel 
and false if value is less than or equal to the first input. Two sub-operations are available: 

GreaterThan (image) 
(image input1, image input2, 
image output) 

This function compares the pixel intensity of each pixel in 
input image 1 against the intensity of each equivalent 
pixel in image 2 and returns true if the equivalent pixel 
intensity of input 2 is less than or equal to the pixel 
intensity of input 1. 
 

GreaterThan (constant) 
(image input, int32 c, image 
output) 

This function compares the pixel intensity of each pixel in 
the input image against an integer constant c and returns 
true if c is less than or equal to the pixel intensity. 
 

 Greater Than or Equals 

Checks each pixel in the first input and returns true if the pixel intensity is greater than or 
equal to the value of the second input. If greater than or equal to, the function returns true 
for that particular pixel and false if value is less than the first input. Two sub-operations are 
available: 

GreaterThanOrEquals (image) 
(image input1, image input2, 
image output) 

This function compares the pixel intensity of each pixel in 
input image 1 against the intensity of each equivalent 
pixel in image 2 and returns true if the equivalent pixel 
intensity of input 2 is less than the pixel intensity of input 
1. 
 

GreaterThanOrEquals (constant)
(image input, int32 c, image 
output) 

This function compares the pixel intensity of each pixel in 
the input image against an integer constant c and returns 
true if c is less than the pixel intensity. 
 

 Less Than 

Checks each pixel in the first input and returns true if the pixel intensity is less than the 
value of the second input. If less than, the function returns true for that particular pixel and 
false if value is more than or equal to the first input. Two sub-operations are available: 

LessThan (image) 
(image input1, image input2, 
image output) 

This function c compares the pixel intensity of each pixel 
in input image 1 against the intensity of each equivalent 
pixel in image 2 and returns true if the equivalent pixel 
intensity of input 2 is greater than or equal to the pixel 
intensity of input 1. 
 

LessThan (constant) 
(image input, int32 c, image 
output) 

This function compares the pixel intensity of each pixel in 
the input image against an integer constant c and returns 
true if c is greater than or equal to the pixel intensity. 
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 Less Than or Equals 

Checks each pixel in the first input and returns true if the pixel intensity is less than or 
equal to the value of the second input. If less than or equal to, the function returns true for 
that particular pixel and false if value is greater than the first input. Two sub-operations are 
available: 

LessThanOrEquals (image) 
(image input1, image input2, 
image output) 

This function c compares the pixel intensity of each pixel 
in input image 1 against the intensity of each equivalent 
pixel in image 2 and returns true if the equivalent pixel 
intensity of input 2 is greater than the pixel intensity of 
input 1. 
 

LessThanOrEquals (constant) 
(image input, int32 c, image 
output) 

This function compares the pixel intensity of each pixel in 
the input image against an integer constant c and returns 
true if c is greater than the pixel intensity. 
 

 Lower Threshold 

Checks each pixel in the input image and sets pixel intensity to an integer constant c if the 
intensity is below the constant c. Pixel intensity higher than c will not be affected by this 
function. 

LowerThreshold (image input, int32 c, image output) 

 Maximum 

Compares the pixel intensity of the two inputs and stores the higher intensity value of the 
two to output. Two sub-operations are available: 

Maximum (image) 
(image input1, image input2, 
image output) 

This function compares the pixel intensity of the 
equivalent pixels of input images 1 and 2 and stores the 
higher pixel intensity of the two to output. 
 

Maximum (constant) 
(image input, int32c, image 
output) 

This function compares the pixel intensity of the input 
image and integer constant c and stores the higher value 
of the two to output. 
 

 Minimum 

Compares the pixel intensity of the two inputs and stores the lower intensity value of the 
two to output. Two sub-operations are available: 

Minimum (image) 
(image input1, image input2, 
image output) 

This function compares the pixel intensity of the 
equivalent pixels of input images 1 and 2 and stores the 
lower pixel intensity of the two to output. 
 

Minimum (constant) 
(image input, int32c, image 
output) 

This function compares the pixel intensity of the input 
image and integer constant c and stores the lower value 
of the two to output. 
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 Not Equals 

Checks each pixel in the first input and returns true of the pixel intensity is not equal to the 
value of the second input. If not equal, the function returns true (255) for that particular 
pixel and false (0) if equal. Two sub-operations are available: 

NotEquals (image) 
(image input1, image input2, 
image output) 

This function checks the pixel intensity of each equivalent 
pixel in input images 1 and 2 and returns true if the 
equivalent pixel intensities are not equal. 
 

NotEquals (constant) 
(image input, int32 c, image 
output) 

This function checks the pixel intensity of each pixel in 
the image input against an integer constant c and returns 
true if the pixel intensity do not equal the value of c. 
 

 Upper Threshold 

Checks each pixel in the input image and sets pixel intensity to an integer constant c if the 
intensity is greater than the constant c. Pixel intensity lower than c will not be affected by 
this function. 

UpperThreshold (image input, int32 c, image output) 

 

(5) Distance Transform operations 

Overview 
Distance transform functions output a topographical map of an input mask, and encode the 
pixel distance to the mask boundary. 

Given an image I, the distance transform assigns each foreground pixel (inside the mask) 
the shortest distance between the pixel and a background pixel (outside the mask).  

The distance transform can be computed sequentially by a two-pass procedure. The first 
(forward) pass scans in a left-right top-bottom raster scan order. The second (backward) 
pass scans in a reverse right-left bottom-top order. In the forward pass for a foreground 
distance transform, the output U(x,y) at pixel position (x,y) is determined by the value of input 
image I and the values at previously computed positions of U by 
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In the unbounded case, we handle the boundary condition by setting U(x,-1) = 0 and U(-1,y) 
= 0. Otherwise, we handle the boundary condition by setting U(x,-1) = 1 and U(-1,y) = 1. 

NB(x,y) is the backward neighbors of the pixel (x,y). The backward neighbor contains a 
selected set of adjacent neighbors that are already scanned in the forward pass. l(i,j) is the 
neighbor position dependent distance length. When l(i,j) = 1 for all (i, j) and NB(x,y) is the 
upper half of the 4-connected neighbor, that is, NB(x,y) = {(x-1,y), (x,y-1)}, the resulting 
distance will be a 4-connected city block distance (L1). When l(i,j) = 1 for all (i, j) and NB(x,y) 
is the upper half of the 8-connected neighbor, that is, NB(x,y) = {(x-1,y), (x-1,y-1), (x,y-1), 
(x+1,y-1)}, the resulting distance will be an 8-connected chessboard distance (L). For the 
8-connected neighbor, when l(x-1,y)=1, l(x-1,y-1)= 2 , l(x,y-1)=1, and l(x+1,y-1)= 2 , the 
resulting distance will be the Euclidean distance (L2).  
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The backward pass produces the distance transform image D by  
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NF(x,y) is the forward neighbors of the pixel (x,y). The forward neighbor contains a selected 
set of adjacent neighbors that are already scanned in the backward pass. For 4-connected 
city block distance, NF(x,y) is the lower half of the 4-connected neighbor. That is, NF(x,y) = 
{(x+1,y), (x,y+1)}. For 8-connected chessboard distance and Euclidean distance, NF(x,y) is 
the lower half of the 8-connected neighbor. That is, NF(x,y) = {(x+1,y), (x+1,y+1), (x,y+1), 
(x-1,y+1)}. 

The images in Figure 1, illustrates the three distance operators applied to a Euclidean disc. 
Figure 1(a) shows the Euclidean disc; Figure 1(b) shows the Euclidean distance transformed 
image of (a); Figure 1(c) shows the 4-connected (cityblock) distance transformed image of 
(a); Figure 1(d) shows the 8-connected (chessboard) distance transformed image of (a). 

    
 (a) (b) (c) (d) 
 

Figure 1 
 

The images in Figure 2, illustrates bounded and unbounded effect. Figure 2(a) shows a 
Euclidean disc hole; Figure 2(b) shows the Euclidean distance transformed image of (a) 
when the distance is bounded by the image boundary; Figure 2(c) shows the Euclidean 
distance transformed image of (a) when the distance is unbounded by the image boundary. 

   

 (a) (b) (c) 
 

Figure 2 
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Usage 
In CL-Quant, the three distance transform operations - 4-connected, 8-connected, and 
Euclidean - that defines how the pixel distances are measured. The list of distance transform 
operations are shown below. 

 
 

DistanceTransform (4-connected)
(image input, image output, 
boolean unbounded, 
outputDepth) 

This function outputs a topographical map of an input 
mask. Pixel distance from the mask boundary is 
measured from four adjacent pixels in the cardinal 
directions. 
 

DistanceTransform (8-connected)
(image input, image output, 
boolean unbounded, 
outputDepth) 

This function outputs a topographical map of an input 
mask. Pixel distance from the mask boundary is 
measured from eight adjacent pixels in the cardinal and 
ordinal directions. 
 

DistanceTransform (Euclidean) 
(image input, image output, 
boolean unbounded, 
outputDepth) 

This function outputs a topographical map of an input 
mask. Pixel distance from the mask boundary is 
calculated as the Euclidean distance from the boundary, 
or the square root of the sum of the squares of the x- and 
y-distances. 

 

 
 NOTE: 

 
 
 All distance transform functions now have the option of 8-bit and 16-bit output depth in the 

outputDepth dropdown menu. It is highly recommended that 8-bit depth used for object 
radius less than 255. For very large object with radius exceeding 255-px, use of 8-bit 
output will truncate the object intensity near the center. 

Application 
We will describe two typical applications of distance transform (A) Medial Axis; (B) Seeds for 
partition. 

(A) Medial Axis 
Medial axis is initially introduced for shape description. The following hypothetical 
scenario can help visualize a medial axis. Let the shape be a region of grass surrounded 
by bare soil. Simultaneously at all boundary points of the grass region light a fire that 
burns uniformly from the border of the grass region to its interior. Eventually the fire 
burning from one part of the border will meet the fire burning from another part of the 
border. Since all the grass will have been burned at the meeting place, the fire will 
quench and be extinguished. The locus of points on the arc of fire extinction is the medial 
axis of the region. Another way to think about the medial axis is as the loci of centers of 
bi-tangent circles that fit entirely within the foreground region being considered. Figure 3 
illustrates this for a rectangular shape. 
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Figure 3 
 

Each point on the medial axis has an associated value that is proportional to the time it 
took for the fire to reach the given point from the time the grass fire was set. The medial 
axis with its medial axis distance function is called the medial axis transform. It is an 
information preserving representation of shape. To see this, just consider running the 
grass fire backward. With time running in reverse, set a grass fire on each point of the 
medial axis exactly at the time the original grass fire is extinguished at that point. The 
boundary of the fire at time t=0 would be the boundary of the original given shape. 

The medial axis can be produced by first calculating the distance transform of the image. 
The medial axis then lies along the singularities (i.e. creases or curvature discontinuities) 
in the distance transform. The medial axis is often described as being the `locus of local 
maxima’ on the distance transform. If the distance transform is displayed as a 3-D 
surface plot with the third dimension representing the grayscale value, the medial axis 
can be imagined as the ridges on the 3-D surface. Figure 4 shows a rectangular region 
(a) and its Euclidean distance transformed image (b). Figure 4 (c) shows the overlay (in 
red) of the peak detection on the distance image. The peak is detected by morphological 
opening residue as follows: 

 Ipeak = Idistance - Open (Idistance, 7 X 7) 

 Moverlay = Greater Than (Ipeak, 0) 

    
 (a) (b) (c) 
 

Figure 4 
(B) Seeds for partition 

To separate overlap objects, partition method is often used (see ZOI section for details). 
The partition operation divide a mask based on the seeds. It is important to create good 
seed regions to prepare a mask for partition. For this purpose, distance transform can be 
applied to the mask and the peak (maximum regions) in the distance image could be 
used as seed regions. Figure 5 (a) shows a mask containing two overlapped circular 
regions. Figure 5 (b) shows its Euclidean distance transformed image. Figure 5 (C) 
shows the overlaid seed regions in red. They are created by  

 Iseed = Greater Than (Idistance, 81) 
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 (a) (b) (c) 
 

Figure 5 

(6) Filtering operations 

Filtering operations apply image filters to reduce image noise on the input image. The list of 
filtering operations is shown below. 

 

 
Descriptions of operations and their sub-operations are given below, along with their input 
parameters. 

 Average Filter 

Averages the pixel intensity of each pixel in the input image with its neighboring pixels 
within the filter window defined by its kernel size. Two sub-operations are available: 

AverageFilter1 (image input, int32 
kernelSize, image output) 

This function averages the pixel intensity of each pixel in 
the input image with its neighboring pixels within the filter 
window. Both dimensions of the filter window are the 
same size and defined by one integer constant. 
 

AverageFilter2 (image input, int32 
kernelWidth, int32 kernelHeight, 
image output) 

This function averages the pixel intensity of each pixel in 
the input image with its neighboring pixels within the filter 
window. The dimensions of the filter window are 
determined by two integer constants. 
 

 Binomial Filter 

Performs a binomial weighted average of the pixel intensity of each pixel in the input image 
with its neighboring pixels within the filter window defined by its kernel size. Two 
sub-operations are available: 

BinomialFilter1 (image input, 
int32 kernelSize, image output) 

This function performs a binomial weighted average of 
the pixel intensity of each pixel in the input image with its 
neighboring pixels within the filter window. Both 
dimensions of the filter window are the same size and 
defined by one integer constant. 
 

BinomialFilter2 (image input, 
int32 kernelWidth, int32 
kernelHeight, image output) 

This function performs a binomial weighted average of 
the pixel intensity of each pixel in the input image with its 
neighboring pixels within the filter window. The 
dimensions of the filter window are determined by two 
integer constants. 
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(7) Image Conditioning operations 

Image conditioning operations are enhancement operations that re-condition the image 
appearance to correct or improve specific image attributes. The list of image conditioning 
operations is shown below. 

 

Descriptions of operations and their sub-operations are given below, along with their input 
parameters. 

 Enhance Texture 

Adds texture to the image to better improve foreground-to-background separation. 

EnhanceTexture (image input, bool useDiscKernel, int32 discKernelSize, int32 
xKernelSize, int32 yKernelSize, int32 enhanceFactor, single downsamplePct, image 
output) 

 Flatten BG 

Normalizes the background intensity of an image to a desired value to correct tilted image 
or uneven illumination. 

  
 Figure 1 Figure 2 
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Three Flatten BG functions are available to correspond to the kernel size used: 

FlattenBG, Large (image input, 
int32 bgValue, image output) 

This function flattens image background to the desired 
bgValue using a kernel size of 255. 
 

FlattenBG, Medium (image input, 
int32 bgValue, image output) 

This function flattens image background to the desired 
bgValue using a kernel size of 65. 
 

FlattenBG, Small (image input, 
int32 bgValue, image output) 

This function flattens image background to the desired 
bgValue using a kernel size of 7. 
 

 Normalize Background 

Normalizes the image intensity of an input image to a desired range. This function is 
particularly useful for image sets with very different brightness. 

NormalizeBackground (image input, int32 desiredRange, int32 ReferencePercentile, 
int32 ImageHeight, image output) 

 Peak Based Segmentation 

Takes a distance-transform image and performs iterative guided partition to separate 
touching mask components. 

PeakBasedSegmentation (image input, image output, int32 StartingLevel, int32 
EndingLevel, int32 largestSeed, int 32 smallestSeed, int32 step) 

 Remove Background 

Performs an open residue operation on the original image to remove the background of the 
image. 

RemoveBackground (image input, int32 kernelSize, image output) 

 Remove Bright Spots 

Removes spots that are relatively brighter than the kernel surrounding it. 

RemoveBrightSpots (image input, int32 filterSize, image output) 

 Remove Dark Spots 

Removes spots that are relatively darker than the kernel surrounding it. 

RemoveDarkSpots (image input, int32 filterSize, image output) 

 Remove Texture DS 

Performs iterative opening followed by closing to remove texture in the image. This 
function also downsamples the image. 

RemoveTextureDS (image input, int32 filterSize, image output, single percentDS, image 
output) 
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(8) Image operations 

Image operations are applied to the entire field of view (FOV) of the image and modify its 
image property. A list of image operations is shown below. 

 

Descriptions of operations and their sub-operations are given below, along with their input 
parameters. 

 Convert Image Depths 

Converts the pixel depth of an image and mapping pixel intensity of the input image to new 
values in the output. Two sub-operations are available: 

ConvertImageDepths1 (image 
input, mappingType, image 
output) 
 

This function converts pixel depth of an image using one 
of five mapping options. 
 

ConvertImageDepths2 (image 
input, int32 sourceMin, int32 
destMin, int32 sourceMax, int32 
destMax, image output) 
 

This function converts pixel depths of an image and maps 
the source minimum and maximum pixels values to 
specified destination min and max values. 
 

 Convert RGB To HSI 

Converts an input image in the RGB (red-green-blue) color domain to the HSI 
(hue-saturation-intensity) domain and stores to output. 

ConvertRGBtoHSI (image input red, image input green, image input blue, image output 
hue, image output saturation, image output intensity) 

 Convert To 8-bit 

Converts an input image with 16-bit pixel depth to an 8-bit image. Source upper and lower 
intensity percentile in the 16-bit domain is mapped to their corresponding 8-bit values. 

ConvertTo8-bit (image input, single lowerPercentile, single upperPercentile, single 
lowerScale, single upperScale) 



 
 

Chapter 3  Teaching CL-Quant 

3.2 Procedure Creation Wizards >> 3.2.8 Enhancement Function Definitions 

 

 143 
 

 Convert To 16-bit 

Converts an input image with 8-bit pixel to a 16-bit image, allowing pixel intensity values up 
to 65535. 

ConvertTo16-bit (image input, image output) 

 Copy Image 

Creates a duplicate copy of the input image and stores to output. 

CopyImage (image input, image output) 

 Downsample 

Takes an input image and downsamples it to a new, reduced size in the output image. Four 
downsample sub-operations are available: 

DownsampleBySize (image input, 
int32 newWidth, int32 newHeight, 
bool saveOriginal, bool 
applyToAll) 
 

This function downsamples the input image to new width 
and height, measured in pixels as shown in Figure 1. 
 

DownsampleByPercent (using 
average filter)(image input, single 
percentFactor, image output) 
 

This function downsamples the input image to new width 
and height, measured in percentage with respect to its 
original resolution. 
 

DownsampleByPercent (image 
input, single percentWidth, single 
percentHeight, image output) 

This function downsamples the input image to new width 
and height, measured in percentage with respect to its 
original width and height as shown in Figure 2. 
 

DownsampleByPercent (in-place)
(image input, single 
percentWidth, single 
percentHeight, bool saveOriginal, 
bool applyToAll) 
 

This function downsamples the input image to new width 
and height, measured in percentage with respect to its 
original width and height, and stores output to the input 
image. 
 

 Fill Image 

Creates a uniform output image based on a specified statistic of pixel intensity of the input 
image. 

FillImage (image input, statistic, bool ignoreZero, image output) 

 Resample 

Takes an input image and resamples it to a new size in the output image. This function can 
be used both for up- and downsampling the input image depending on input parameters. 
Two sub-operations are available: 

Resample1 (image input, image 
output) 

This function resamples an input image or mask and 
save result to an output mask. 
 

Resample2 (image input, int32 
newWidth, int32 newHeight, 
output image) 
 

This function resamples the input image to a different 
dimension and stores result to output. 
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 Restore 

Takes an image that has been downsampled and restores the original FOV. FOV masks, 
object ROIs and measurements will be upsampled. The active FOV will be selected as its 
input as shown in Figure 3. 

Restore (image input, bool applyToAll) 

 
 NOTE: 

 
  
 The restore function recipe must be created at the same time as the downsample recipe, 

otherwise there will be no image available for restoration. These can be saved to one or 
two recipes. 

 

 Shift Image 

Translates the image from original to new position specified by x- and y-shifts and stores 
result to output. Image is not wrapped around in translation and blank pixels from the 
movement will be set to specified uniform intensity value. 

ShiftImage (image input, image output, int32 xShift, int32 yShift, int32 padValue) 

 Transpose 

Transposes the input image and stores result to output. When the function is applied, rows 
of the input image will become columns of the output and the columns from input will 
become the rows of the output. 

Transpose (image input, image output) 

   

 Figure 1 Figure 2 Figure 3 
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(9) Labeling Operations 

Labeling operations takes a binary mask as input and generates a grayscale mask output 
with pixel intensity value corresponding to its label value. The list of labeling operations is 
shown below. 

 

 

 Create Field Centroid Mask 

Generates a binary output image of one pixel at the center of mass of the entire image. 

CreateFieldCentroidMask (image input, image output, int32 pixelVal) 

 Create Object Centroid Mask 

Generates a binary output mask of one pixel at the center of mass of each binary mask 
component. 

CreateObjectCentroidMask (image input, image output, int32 pixelVal) 

 Group Objects 

Assigns labeled values to each object on the input reference mask based on the zone of 
influence. 

GroupObjects (image referenceMask, image objectMask, bool useZoi, image output) 

 Labeling (4-Connected) 

Assigns unique labeled values for each binary object in the input image and stores the 
assigned labels to output. Pixels are considered to be connected and of the same object if 
it is adjacent to a non-zero pixel in the four cardinal directions. Three sub-operations are 
available: 

Labeling 
(image input, image labeling, bool 
autoSetOutputDepth) 

 

This function assigns unique label to each 
object. 

Labeling : Morphological filter 
(image input, image labeling, int32 
maxObjects, int32 minSize, int32 maxSize, 
single minCompactness, single 
maxCompactness, bool 
autoSetOutputDepth) 
 

This function assigns unique label to each 
object that falls within particular size and 
compactness criteria. 
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Labeling : Advanced filter 
(image mask, image background, image 
labeling, int32 maxObjects, int32 minSize, 
int32 maxSize, single minMean, single 
maxMean, single minStdev, single 
maxStdev, int32 minPixelSum, int32 
maxPixelSum, bool autoSetOutputDepth) 
 

This function assigns unique label to each 
object that falls within particular size and 
image intensity criteria. 

 Labeling (8-Connected) 

Assigns unique labeled values for each binary object in the input image and stores the 
assigned labels to output. Pixels are considered to be connected and of the same object if 
it is adjacent to a non-zero pixel in the four cardinal directions and the four ordinal 
directions. Three sub-operations are available: 

Labeling 
(image input, image labeling, bool 
autoSetOutputDepth) 
 

This function assigns unique label to each 
object. 

Labeling : Morphological filter 
(image input, image labeling, int32 
maxObjects, int32 minSize, int32 maxSize, 
single minCompactness, single 
maxCompactness, bool 
autoSetOutputDepth) 
 

This function assigns unique label to each 
object that falls within particular size and 
compactness criteria. 
 

Labeling : Advanced filter 
(image mask, image background, image 
labeling, int32 maxObjects, int32 minSize, 
int32 maxSize, single minMean, single 
maxMean, single minStdev, single 
maxStdev, int32 minPixelSum, int32 
maxPixelSum, bool autoSetOutputDepth) 
 

This function assigns unique label to each 
object that falls within particular size and 
image intensity criteria. 

 Propagate ZOI Labels 

 Remove NonOverlapped Objects 

Discards objects from input 1 that do not overlap with the reference input 2 and stores 
result to output. 

RemoveNonOverlappedObjects (image input1, image input2, image output) 

 Remove Overlapped Objects 

Discards objects from input 1 that overlap with the reference input 2 and stores result to 
output. 

RemoveOverlappedObjects (image input1, image input2, image output) 
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(10) Logical Operations 

Logical operations are pixel-wise operations that generate a binary output image 
corresponding to the logic function applied. The list of logical operations is shown below. 

 

 Logical And 

Performs pixel-wise logical “and” operation between the first and second input and returns 
a binary output of non-zero pixels on both inputs. Two logical and sub-operations are 
available: 

LogicalAnd (image) 
(image input1, image input2, 
image output) 
 

This function performs a pixel-wise logical and operation 
that returns 255 if both input1 and input2 are nonzero. 
 

LogicalAnd (constant) 
(image input, int32 c, image 
output) 

This function performs a pixel-wise logical and operation 
that returns 255 if both input and integer constant c are 
nonzero. 
 

 Logical Not 

Performs pixel-wise logical “not” operation on the input image and stores binary result to 
output. This function will return a value of 255 for all zero pixels and 0 for all non-zero 
pixels. 

LogicalNot (image input, image output) 

 Logical Or 

Performs pixel-wise logical “or” operation between the first and second input and returns a 
binary output of non-zero pixels of either inputs. Two logical or sub-operations are 
available: 

LogicalOr (image) 
(image input1, image input2, 
image output) 
 

This function performs a pixel-wise logical or operation 
that returns 255 if either input1 or input2 is nonzero. 

LogicalOr (constant) 
(image input, int32 c, image 
output) 

This function performs a pixel-wise logical or operation 
that returns 255 if either the input image or the integer 
constant c is nonzero. 
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(11) Morphological Operations 

Overview 
Morphological operations process images based on shapes. It applies a structuring element 
to the input image to modify the neighborhood surrounding the pixel of interest. By choosing 
the size and shape of the structuring element, one can construct a morphological operation 
that is sensitive to specific shapes in the input image. 

The basic morphological operations are dilation and erosion. Binary erosion removes pixels 
on object boundaries while binary dilation adds pixels to the boundaries of object masks. The 
number of pixels added or removed from the object masks depends on the size and shape of 
the structuring element. 

- Binary Erosion 
Let E be a Euclidean space or an integer grid, and B a binary image in E. The erosion of B 
by the structuring element S is defined by: 

 
  { | }zB S z E S B   

 

where Sz is the translation of S by the vector z, i.e., Sz = { s + z │ s ϵ S},  z ϵ E 

The erosion of B by S can also be described by the expression: 

 

   s
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- Binary Dilation 
The dilation of B by the structuring element S can be similarly defined by: 

 

  s
s S

B S B

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Figure 1(a) shows a rectangular shape. The erosion of the rectangular shape by a disk 
structuring element (illustrated in Apricot), resulting in the Medium purple smaller 
rectangular region in (b). The dilation of the rectangular shape in (a) by the same disk, 
resulting in the addition of cyan region with rounded corners in (c). 

 

   

 

 
 (a) (b) (c) 
 

Figure 1 
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- Binary Opening 
The opening of B by S is obtained by the erosion of B by S, followed by dilation of the 
resulting image by S: 

   (   )B S B S S    

The opening is also given by,  

 

  
i

i
S B

B S S


 
 

which means that it is the locus of translations of the structuring element S inside the image 
B. In the case of the square of side 20, and a disc of radius 4 as the structuring element, 
the opening is a square of side 20 with rounded corners, where the corner radius is 4. 

- Binary Closing 
The closing of B by S is obtained by the dilation of B by S, followed by erosion of the 
resulting image by S: 

   (   )  B S B S S     

The closing can also be obtained by 

   (   )c s cB S B S    

where Pc denotes the complement of P relative to E. That is 

 { | }cP p E p P    and Ss is the symmetric of S. 

The above means that the closing is the complement of the locus of translations of the 
symmetric of the structuring element outside the image B. 

Opening together with closing are the basic workhorse of morphological noise removal. 
Opening removes small objects, while closing removes small holes. 

Figure 2(a) shows the opening of the rectangular shape in Figure 1(a) by a disk structuring 
element (illustrated in Apricot), resulting in the yellow rectangular region with rounded 
corners. Figure 2(b) shows a region of two overlapped circles. The closing of the shape (b) 
by the same disk, resulting in the addition of pink regions that fill the shape corners in (c). 

 

 

   
 (a) (b) (c) 
 

Figure 2 
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- Grayscale morphological operations  
In grayscale morphology, images are functions mapping a Euclidean space or grid E into a 
functional space of grayscale intensity. Grayscale structuring elements are also functions of 
the same format, called “structuring functions”. 

Denoting a one-dimensional image by I(x) and the structuring function by S(x), the 
grayscale dilation of I by S is given by 

 

(   )( ) { ( ) ( )}max
z S

I S x I x z S x


   
 

Similarly, the erosion of I by S is given by 

 
(   )( ) { ( ) ( )}min

z S

I S x I x z S x


   
 

Figure 3 illustrates a one dimensional profile in (a) that is processed by a structuring 
element in (b). The dilation of the profile by the structuring element resulting in the red 
profile in Figure 3(c). The erosion results in the blue profile in Figure 3(d). The closing of 
the profile by the same structuring element resulting in the yellow profile in Figure 3(e) 
where the pit is filled. The opening results in the purple profile in Figure 3(f) where the 
peaks are removed. 

       
 (a) (b) (c) (d) (e) (f) 
 

Figure 3 

 
The operations can be directly extended to 2-D images. Figure 4(a) shows a neuron growth 
cone image with bright microtubule plus tips. The dilation of the image by a rod structuring 
element of radius 7 resulting in the image in Figure 4(b) where bright spots are expanded. 
The erosion of the image by the same structuring element resulting in the image in Figure 
4(c) where bright spots are much reduced. the opening of the image by the same 
structuring element resulting in the image in Figure 4(d) where the bright spots are dimmed. 
the closing of the image by the same structuring element resulting in the image in Figure 
4(e) where the cellular background is brighter since darker textures are filled in. 
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 (a) (b) 

  
 (c) (d) 

  
 (e) 

Figure 4 
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Usage 
The list of morphological operations appears below. The variations are mostly related to 
different configurations of structuring elements. 

 
 

Descriptions of operations and their sub-operations are given below, along with their input 
parameters. 

 Angular 

Performs specified operation on the input image with structuring kernel specified by the 
angle in radians and stores result to output image. Four functions are available: 

AngularClose 
(image input, int32 kernelWidth, 
int32 kernelHeight, single 
angleInRadians, image output) 
 

This function closes the input image with structuring 
kernel at the angle specified. 

AngularDilate 
(image input, int32 kernelWidth, 
int32 kernelHeight, single 
angleInRadians, image output) 
 

This function dilates the input image with structuring 
kernel at the angle specified. 
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AngularErode 
(image input, int32 kernelWidth, 
int32 kernelHeight, single 
angleInRadians, image output) 
 

This function erodes the input image with structuring 
kernel at the angle specified. 

AngularOpen 
(image input, int32 kernelWidth, 
int32 kernelHeight, single 
angleInRadians, image output) 
 

This function opens the input image with structuring 
kernel at the angle specified. 

 Close 

Performs a dilation operation followed by an erode operation using the same structuring 
element. Two sub-operations are available: 

Close1 
(image input, int32 kernelSize, 
image output) 
 

This function performs a closing operation using a 
structuring element of the same width and height. 

Close2 
(image input, int32 kernelWidth, 
int32kernelHeight, image output)
 

This function performs a closing operation using a 
structuring element of different height and width. 
 

 Close Disc 

Performs a closing operation using a disc-shaped structuring element instead of a square 
kernel. 

CloseDisc (image input, int32 kernelSize, image output) 

 Dilate 

Takes the maximum value of all pixels in the kernel neighborhood of a pixel in the input 
image and propagates the pixel maximum value to all the pixels in the kernel 
neighborhood. Two sub-operations are available: 

Dilate1 
(image input, int32 kernelSize, 
image output) 
 

This function performs a dilation operation using a 
structuring element of the same width and height. 

Dilate2 
(image input, int32 kernelWidth, 
int32kernelHeight, image output)

This function performs a dilation operation using a 
structuring element of different height and width. 
 

 

 Dilate 3x3 

Performs a dilation operation with a 3x3 structuring element of specific arrangement and 
stores result to output image. Three dilate 3x3 operations are available: 

Dilate3x3Center 
(image input, image output) 
 

This function performs a dilation operation with a 3 x 3 
centered structuring element shown in Figure 5. 

Dilate3x3Down 
(image input, image output) 
 

This function performs a dilation operation with a 3 x 3 
down structuring element shown in Figure 6. 
 

Dilate3x3Up 
(image input, image output) 
 

This function performs a dilation operation with a 3 x 3 up 
structuring element shown in Figure 7. 
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 Figure 5 Figure 6 Figure 7 
 

 Dilate Diagonal 

Performs dilation operation with an n x n diagonal structuring element and stores result to 
output image. Two dilate diagonal operations are available: 

DilateDiagonalDown 
(image input, int32 kernelSize, 
image output) 
 

This function performs a dilation operation with an n x n 
diagonal structuring element as shown in Figure 8. 

DilateDiagonalUp 
(image input, int32 kernelSize, 
image output) 
 

This function performs a dilation operation with an n x n 
diagonal structuring element as shown in Figure 9. 
 

  
 Figure 8 Figure 9 

 Dilate Disc 

Performs a dilation operation with a disc-shaped structuring element and stores result to 
output image. 

DilateDisc (image input, int32 kernelSize, image output) 

 Erode 

Takes the minimum value of all pixels in the kernel neighborhood of a pixel in the input 
image and propagates the pixel maximum value to all the pixels in the kernel 
neighborhood. Two sub-operations are available: 

Erode1 
(image input, int32 kernelSize, 
image output) 

This function performs an erosion operation using a 
structuring element of the same width and height. 
 

Erode2 
(image input, int32 kernelWidth, 
int32kernelHeight, image output)
 

This function performs an erosion operation using a 
structuring element of different height and width. 
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 Erode 3x3 

Performs erosion operation with a 3x3 structuring element of specific arrangement and 
stores result to output image. Three erode 3x3 operations are available: 

Erode3x3Center 
(image input, image output) 
 

This function performs an erosion operation with a 3 x 3 
centered structuring element shown in Figure 5. 

Erode3x3Down 
(image input, image output) 

This function performs an erosion operation with a 3 x 3 
down structuring element shown in Figure 6. 
 

Erode3x3Up 
(image input, image output) 
 

This function performs an erosion operation with a 3 x 3 
up structuring element shown in Figure 7. 

 Erode Diagonal 

Performs erosion operation with an n x n diagonal structuring element and stores result to 
output image. Two erode diagonal operations are available: 

ErodeDiagonalDown 
(image input, int32 kernelSize, 
image output) 
 

This function performs an erosion operation with an n x n 
diagonal structuring element as shown in Figure 8. 
 

ErodeDiagonalUp 
(image input, int32 kernelSize, 
image output) 
 

This function performs an erosion operation with an n x n 
diagonal structuring element as shown in Figure 9. 
 

 Erode Disc 

Performs an erosion operation with a disc-shaped structuring element and stores result to 
output image. 

ErodeDisc (image input, int32 kernelSize, image output) 

 Open 

Performs erosion operation followed by a dilation operation using the same structuring 
element. Two sub-operations are available: 

Open1 
(image input, int32 kernelSize, 
image output) 
 

This function performs an opening operation using a 
structuring element of the same width and height. 
 

Open2 
(image input, int32 kernelWidth, 
int32kernelHeight, image output)
 

This function performs an opening operation using a 
structuring element of different height and width. 
 

 Open Disc 

Performs an opening operation using a disc-shaped structuring element instead of a 
square kernel. 

OpenDisc (image input, int32 kernelSize, image output) 
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Application 
Morphological operations are the basis for our structure-guided image processing approach. 
In the following subsections, we will describe structure-guided image feature enhancement 
and structure-guided image feature extraction. 

- Structure-guided image feature enhancement 
Image features could be noisy and could contain irrelevant information. The 
structure-guided image feature enhancement efficiently enhances image features of 
interest and removes noisy and irrelevant information. The structure-guided image feature 
enhancement is accomplished by grayscale morphological opening and closing operations 
applied alternatively to image foreground and background. Morphological opening and 
closing operations possess an increasing property that maintains inclusion relationships on 
the images they apply. If an inclusion relationship exists for structuring elements A and B, 
that is: 

 ,BA  

then combinations of opening and closing have the following property: 

 B B)I(B)A)(((I   

 B B)I(B)A)(((I   

Therefore, processing sequences that progressively apply combinations of openings and 
closings are less severe and introduce less distortion when a small structuring element is 
used before a larger one. Application domain structure information is encoded into the size 
and shape of structuring elements to achieve structure-guided enhancement using 
increasing idempotent processing sequence. Figure 10 illustrates a structure-guided 
feature enhancement processing sequence on a noisy edge intensity profile (see Figure 
10(a)). Structuring elements A and B (see Figure 10(b)), where ,BA  are used for the 
processing. 

Figure 10 (c) illustrates the effect of opening and closing by A. Note that only partial 
resulting profile is shown in the illustration. Figure 10 (d) illustrates the effect of further 
opening and closing by B. The resulting feature enhanced image is shown in Figure 10 (e). 
The feature enhancement process removes noise and preserves the structure of the 
features of interest. There is no blur, ringing, overshoot or pre-shoot normally caused by 
phase distortion of linear filtering. 

By choosing the proper structuring elements, structure-guided feature enhancement can 
be efficiently accomplished. Features of different structures can be enhanced using 
directional elongated structuring elements. The direction of the structuring element is 
chosen to align with the primary direction of the features to be enhanced. The largest size 
of the structuring element in the processing sequence should be smaller than the smallest 
size of features to be enhanced. 

The structure-guided feature enhancement process could start with grayscale opening 
followed by grayscale closing or start with grayscale closing and followed by opening. 
Opening first will enhance dark features and closing first will enhance bright features. Each 
opening and closing iteration could use the same size structuring element for detailed 
feature refinement or could use increased size structuring element for aggressive feature 
refinement. Elongated structuring element of orthogonal directions could be alternatively or 
sequentially applied in the enhancement processing sequence. 
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 (a) Input: noisy edge profile  (b) Structuring elements (c) Opening/closing by A 

 

  
 (d) Further opening and closing by B (e) Output: enhanced edge 
 

Figure 10 
 

 

- Structure-guided image feature extraction 
Image features are characterized by their grayscale intensity distributions and their spatial 
structures. Major image features include linear features such as bright edge, dark edge, 
general edge, bright line, dark line and general line. Major image features also include 
image regions such as bright region, dark region and general region, etc. Linear features 
can be arranged vertically, horizontally, and/or in different spatial directions. Regions can 
exhibit different shapes such as circular or rectangular, etc. They can be arranged in a 
given structure including relative locations, orientation or symmetry. Other image features 
include small regions or points such as corners of regions or intersection points of different 
features (linear features and/or regions). 

The structure-guided image feature extraction approach efficiently extracts image features 
of interest and removes noisy and irrelevant information. This is accomplished by a 
sequence of grayscale morphological processing that encodes structure information into 
directional elongated structuring elements that can be efficiently implemented. 

1. Image Feature Extraction 
The following sub-sections describe some feature extraction processing sequence in the 
preferred embodiment of the invention. 

(A) Bright edge extraction 
Bright edges can be extracted by a grayscale erosion residue processing sequence 
defined as: 

 I - I Θ A 

Where I is an input image and A is a structuring element. 

Figure 11 illustrates the grayscale erosion residue operation applies to a one 
dimensional ramp edge I shown in Figure 11(a). Figure 11(b) shows the structuring 
element A and Figure 11(c) shows the eroded profile of I by A. The erosion residue 
result is shown in Figure 11(d). As shown in Figure 11, grayscale morphological bright 
edge detection does not introduce undesired phase shift or blurry effect normally 
caused by linear filters. 
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 (a) Input ramp edge image: I (b) Structuring element: A 
 

   
 (c) Eroded image: I Θ A (d) Eroded residue: I - I Θ A 

Figure 11 
 

(B) Dark edge extraction 
Dark edges can be extracted by a grayscale dilation residue processing sequence 
defined as: 

 I  A - I 

Figure 12 illustrates the grayscale dilation residue operation applied to the one 
dimensional ramp edge I shown in Figure 11(a). Figure 12(a) shows the dilated profile of 
I by A. The dilation residue result is shown in Figure 12(b). As shown in Figure 12, 
grayscale morphological dark edge detection does not introduce undesired phase shift 
or blurry effect. 

   
 (a) Dilated image: I  A (b) Dilation residue: I  A - I 

Figure 12 
 

(C) General edge extraction 
General edges (both dark and bright edges) can be extracted by the difference of 
grayscale dilation and erosion defined as: 

 I  A - I Θ A 

Figure 13 illustrates the difference of grayscale dilation and erosion operation applied to 
the one dimensional ramp edge I shown in Figure 11(a). 

Figure 13 (a) shows the dilated and eroded profile of I by A. The difference of grayscale 
dilation and erosion result is shown in Figure 13(b). As shown in Figure 13, grayscale 
morphological edge detection does not introduce undesired phase shift or blurry effect. 

   
 (a) I  A (green) and I Θ A (blue) (b) I  A - I Θ A 

Figure 13 
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(D) Bright line/region extraction 
Bright lines/regions can be extracted by a grayscale opening residue processing 
sequence defined as: 

 I - I O A 

Figure 14 illustrates grayscale opening residue operation applied to a one dimensional 
image profile shown in Figure 14(a). Figure 14(b) shows the opening result of image I by 
a sufficiently large structuring element. The opening residue result is shown in Figure 
14(d). As can be seen in Figure 14(d), grayscale morphological line/region detection 
does not introduce undesired phase shift or blurry effect. 

 
(a) Input image gray level profile 

 

 
(b) Closing (orange) and opening (purple) results 

 
 

 
(c) Closing residue 

 
 

 
(d) Opening residue 

 
 

 

(e) Contrast: closing – opening 
 

Figure 14 
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(E) Dark line/region extraction 
Dark lines/regions can be extracted by a grayscale closing residue processing sequence 
defined as: 

 I ● A - I  

Figure 14 illustrates grayscale closing residue applied to the one dimensional image 
profile shown in Figure 14 (a). Figure 14 (b) shows the closing result of I. The closing 
residue result is shown in Figure 14(c). As can be seen in Figure 14(c), grayscale 
morphological line/region detection does not introduce undesired phase shift or blurry 
effect. 

(F) Region contrast extraction:  
Region contrast can be extracted by the difference of grayscale closing and opening. 
The processing sequence is defined as: 

 I ● A - I O A  

Figure 14 illustrates the difference of grayscale closing and opening applied to the one 
dimensional image profile shown in Figure 14(a). Figure 14 (b) shows the closing and 
opening results of I. The difference of grayscale closing and opening is shown in Figure 
14(e). As can be seen in Figure 14(e), the morphological region contrast extraction does 
not introduce any undesired phase shift or blurry effect. 

(G) Region boundary extraction 
Since two sides of a line are also edges, edge extraction operations will extract lines as 
well as edges. When using the same structure element, the edge extraction results, 
sub-sections A-C, include the corresponding line/region extraction results, sub-sections 
D-F. A region boundary consists of only edges that are in the boundaries of large regions 
and excludes edges from narrow lines.  

Bright region boundary can be defined as the difference between grayscale 
morphological opening and erosion: 

 I O A - I Θ A 

Similarly, dark region boundary can be defined as the difference between grayscale 
morphological dilation and closing: 

 I  A - I ● A 

And general region boundary can be defined as the difference between the summation 
of grayscale morphological opening and dilation and the summation of grayscale 
morphological erosion and closing: 

 (I O A + I  A) - (I Θ A + I ● A) 
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2. Structure-guided Feature Extraction Processing Sequence 
By choosing the proper structuring element for the feature extraction processing sequence, 
structure-guided feature extraction can be efficiently accomplished. Features of different 
structures can be extracted using directional elongated structuring elements. Directional 
elongated structuring elements are 1 pixel wide or have limited width in one of its 
dimension. The direction of the elongated structuring element is chosen to be 
approximately orthogonal to the primary direction of the features to be extracted. 

Figure 15 shows an example of the structure-guided edge extraction that extracts 
horizontal edges and another example that extracts vertical edges from an input step edge 
image using directional elongated structuring elements. Figure 15 (a) is a two-dimensional 
step edge image. To extract vertical edges, a horizontal elongated structuring element is 
used (Figure 15(b)). The general edge extraction processing sequence, difference of 
grayscale dilation and erosion, is applied and the vertical edges are extracted (see Figure 
15 (c)). Similarly, a vertical elongated structuring element is used (Figure 15(d)) for 
horizontal edge extraction and the horizontal edges are extracted (see Figure 15 (e)). In 
these examples, the width of the directional elongated structuring element is one pixel and 
the length of the structuring element determines the width of the extracted edges. Note 
that the medial axes of the extracted edge lines correspond to the position of the input step 
edge and no phase shift or blurry effect are introduced in the process.  

 

 (a) Input step edge image (b) Horizontal structuring element H (c) I  H - I Θ H 
 

 
 (d) Vertical structuring element V (e) I  H - I Θ V 

Figure 15 
 

The structure-guided processing can be applied to different feature extraction processing 
sequences as described above. Figure 16 shows an example of the structure-guided line 
extraction that extracts horizontal lines and another example that extracts vertical lines 
using directional elongated structuring elements. Figure 16 (a) is an input frame image. To 
extract vertical lines, a horizontal elongated structuring element is used (Figure 16 (b)). 
The dark line extraction sequence, closing residue, is applied and the vertical lines are 
extracted (see Figure 16 (c)). Similarly, a vertical elongated structuring element is used 
(Figure 16 (d)) for horizontal line extraction and the horizontal lines are extracted (see 
Figure 16 (e)). In these examples, the width of the directional elongated structuring 
element is one pixel and the length of the structuring element is longer than the width of 
the extracted lines. The structure-guided feature extraction allows the separate extraction 
of features of interest defined by their structures and ignore/remove irrelevant features. For 
example, if only the horizontal edges are of interest, it can be easily extracted as shown in 
Figure 15 (e) and no vertical edge components are included in the result. 
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 (a) Input frame image (b) Horizontal structuring element H (c) Closing residue: I ● H – I 
 

 
 (d) Vertical structuring element V (e) Closing residue: I ● V – I 
 

Figure 16 
 

The extraction of features from any directions can be accomplished with the 
structure-guided feature extraction approach and the features extracted from multiple 
directions can be combined by a union (maximum) of multiple directional features. 
Furthermore, two-dimensional structuring elements of different size and shape can be 
used to extract desired regions. 

(12) Noise operations 

Noise operations add a well-defined noise signal to the input image. 

 

 

 Add Gaussian Noise 

Adds noise to the field of view with distribution of pixel intensities following a normal 
distribution centered on the mean specified. Result image is stored to output. 

AddGaussianNoise (image input, int32 mean, int32 stdDev, image output) 

(13) Normalization operations 

Normalization operations re-map image intensity to make use of the full dynamic range. 

 

 Histogram Equalize 

Redistributes input image intensities to utilize the full dynamic range available. Gain for 
each gray level is separately determined by its frequency of occurrence in the input. Result 
is stored to the output image. 

HistogramEqualize (image input, image output) 
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(14) Post-Processing operations 

Post-processing operations are used to enhance initial detection masks. These operations 
allow for additional segmentation mask editing and refinement for specific image analysis. 

 

 Fill Holes 

Fills in small, enclosed gaps in the input mask and stores result to output. 

FillHoles (image input, int32 sizeValue, image output) 

 Peak Based Partition 

Performs a distance transform operation on the input mask followed by iterative guided 
partition to separate touching object masks. 

PeakBasedPartition (image input, image output, int32 StartingLevel, int32 EndingLevel, 
int32 largestSeed, int32 smallestSeed, int32 step) 

 Remove Objects 

Removes input mask objects that fall below a specified cutoff size. 

RemoveObjects (image input, int32 sizeValue, image output) 

 Soft Refine Mask 

Performs Fill Hole and Remove Object operations simultaneously on the input mask and 
stores result to output. 

SoftRefineMask(image input, int32 sizeValue, image output) 
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(15) ZOI operations 

Overview 
- Zones of Influence 

ZOI operations take a binary input image and calculate the zones of influence (ZOI) of 
individual objects. 

Figure 1 (a) shows an image consisting of 4 circular component regions. In Figure 1 (b), the 
foreground pixels in the component regions are labeled by their component labels. Its 
background (non-component regions) can be partitioned into zones of influence (ZOI) as 
shown in Figure 1 (c). In the ZOI image, each pixel is associated with a component label. 
The background pixels are labeled by the labels of the component that is closest to the pixel. 
Figure 1(d) shows the ZOI image overlaid with the component regions. 

 
 (a) (b) (c) (d) 

Figure 1 
 

- Image region partition 
The boundary of ZOI can be used as cutting lines to partition mask regions of an image. 
Figure 2 (a) shows an image mask containing two overlapped circular regions. Figure 2 (b) 
shows the overlay (in red) of two seed components created by thresholding the Euclidean 
distance transformed mask image. Figure 2(C) shows the image region partition using the 
seed component ZOI boundary as the cutting line. 

 
 (a) (b) (c) 
 

Figure 2 

Usage 
In CL-Quant, there are three ComputeZOI operations - 4-connected, 8-connected, and 
Euclidean - that defines how the ZOI distances are measured. There are two partition 
operations - Guided Partition and Multi-Guided Partition. The operations selection menu is 
shown below. 



 
 

Chapter 3  Teaching CL-Quant 

3.2 Procedure Creation Wizards >> 3.2.8 Enhancement Function Definitions 

 

 165 
 

 
 Compute ZOI 

Takes a binary input image and generates a grayscale Zones of Influence (ZOI) map 
where each ZOI is determined based on their distance between neighboring objects. 
Three sub-operations are available: 

ComputeZOI (4-connected) 
(image input, image output, bool 
bounded) 

This function generates a grayscale ZOI map based on 
distance between neighboring objects. Distance between 
masks is measured from adjacent pixels in the four 
cardinal directions. 
 

ComputeZOI (8-connected) 
(image input, image output, bool 
bounded) 

This function generates a grayscale ZOI map based on 
distance between neighboring objects. Distance between 
masks is measured from adjacent pixels in the four 
cardinal directions plus the four ordinal directions. 
 

ComputeZOI (Euclidean) 
(image input, image output, bool 
bounded) 
 

This function generates a grayscale ZOI map based on 
distance between neighboring objects. Distance between 
masks is calculated as the square root of the sum of the 
squares of the x-distance and y-distance. 
 

 Guided Partition 

Segments a contiguous binary input mask into discrete objects. Partition follows an input 
reference seed mask. Partitioned mask is stored to output. 

GuidedPartition (image input, image seed, bool fourConnected, image output) 

 Multi-Guided Partition 

Multi-guided partition function takes three reference seed masks as inputs. It also inputs a 
size range containing a lower bound and an upper bound. It stores result to output. The 
operation includes three iterations: 

(1) 1st iteration: performs guided partition on regions from the input image that is larger 
than the size lower bound using the largeSeed and retain resulting regions that are 
within the size range in the output image. The remaining regions greater than the 
upper bound will be continued partitioned in the 2nd iteration. 

(2) 2nd iteration: performs guided partition on remaining large regions using the 
smallSeed and retain resulting regions that are within the size range in the output 
image. The remaining regions greater than the upper bound will be continued 
partitioned in the 3rd iteration. 

(3) 3rd iteration: performs guided partition on remaining large regions using the 
adaptiveSeed and retain all resulting to be included in the output image. 

Multi-GuidedPartition (image input, image largeSeed, image smallSeed, image 
adaptiveSeed, sizeRange, image output) 
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  3.3 Additional Procedures 

Other types of key image recognition procedures include motility tracking and decision 
procedures. These are described in the sections below.  

 
3.3.1 Tracking Procedure Wizard 

To create a new tracking procedure, go to “Tools > Wizard”. In the wizard launch dialog, select 
“Tracking” and press “Launch”. This will launch the tracking procedure wizard. The wizard will 
guide you through setting the appropriate parameters to optimize tracking performance and will 
enable you to select track measurements to include. The following sections will assist you in 
creating your own tracking procedure. 

 
 NOTE: 

 
  
 Tracking procedure creation requires the “Live Tracking” license. 

 
3.3.1.1 Track measurements 

Track 
A track is the path traveled by a tracked object. The track links individual objects at each time 
frame. Tracking measurements characterize the tracks in several different ways: 

- Trajectory measurements:  
Characterize the track in its entirety. These are one per track for all time. For example, 
straight line length is the distance the track object travels “as the crow flies”. 

- Motility measurements:  
Characterize the track at each time point. For example, velocity angle measurement 4 in 
the figure below is the angle between the direction of the track object at frame 4 and frame 3. 

- Running window measurements:  
Summarize motility measurements within a user defined running window. For example, the 
sum of the velocity angle could be measured over a three frame running window. 

 

 

 
- Polar measurements:  

With polar measurements, the object mask is transformed from the image (x,y) coordinates 
to polar coordinates in (r, ) where r is the distance from the center of the object and  is the 
angle from the image x axis ( = 0 is parallel to the x axis). Measurements are then made on 
the mask in the polar domain. 

Curvature track path
 
Straight line length 

4 (<0, clockwise): angle change 
in degree at t4 
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3.3.1.2 Configure a motility procedure 

Motility procedures are general-purpose tracking procedures that have been extensively 
validated across multiple cell lines. Use motility for tracking large objects or objects in phase 
contrasts. 
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 Channel and Mask Selections 

The motility tracking procedure requires a segmentation mask input on each image frame. 
Use the “Channel index” and “Mask index” textboxes to specify the location index of the 
channel and mask used for tracking. 

 

 Tracking Parameters 

Sample window size Defines the width (number of frames) of a moving window in 
which measurements, such as velocity, are calculated. 
 

Min object size Objects in the segmentation mask below this size (pixels) are 
not tracked. 
 

Max search range Specifies the search radius (in number of pixels) for 
connecting track points from previous track point position. 
 

Split Threshold Threshold for split detection. A lower threshold value will bias 
toward more splits and vice versa. 
 

Merge threshold Threshold for merge detection. A lower threshold value will 
bias toward more merges and vice versa. 
 

Min frames for overlapping Minimum threshold number of image frames for which two 
touching objects are considered in an overlapped state. 
 

Min trajectory length Minimum threshold number of frames that a tracked object 
must appear in to be considered a trajectory. 

 

 Tracking Options 

Object Split Given one object, object A in the previous frame, the object A 
is split if two objects, object B1 and object B2, matches object 
A in the current frame. 

 - Allow split 
Two new tracks will be created in the current frame for a 
trajectory that satisfies the condition above. Select this option 
for cells undergoing division. 

 - Ignore split 
A new track will be created for one of the new objects in the 
current frame for a trajectory that satisfies the condition 
above; the other new object will inherit the previous trajectory.
 

Object Merge Given two objects, object A1 and object A2 in the previous 
frame, the trajectories of objects A1 and A2 are merged if one 
object, object B, matches both A1 and A2 in the current frame.

 - Merge with partition 
Object masks that satisfy the conditions above will be 
partitioned by their appearance and previous trajectories will 
continue in the current frame. 

 - Allow merge 
Object masks that satisfy the conditions above will be merged 
to a single mask and a new trajectory will be created in the 
current frame. 
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 - Ignore merge 
Object masks that satisfy the conditions above will be merged 
to a single mask and inherit the trajectory of one of the 
merged components in the current frame. 
 

Enable lineage interface 
 

When this option is checked, a track object will be ended 
when a mask component separates (i.e. cell division), and two 
new tracks (i.e. daughter cells) will be created. This option 
allows for tracking lineage (previous generation) of splitting 
cells. 
When this option is enabled, lineage measures (parent / child 
track number, generation, descendants) are automatically 
created. These measures are defined in the next section. 
 

Enable robust measurement When this option is checked, track measurements of large cell 
clusters will be separated from track measurements of 
isolated cells. 
 

Object-to-object overlap Given an object A in the previous frame and object B in the 
current frame, one of two methods is used to determine 
whether A “overlaps” B, and therefore, is a possible match for 
B: 

1) The pixels of A intersect the pixels of B, or  

2) The zone of influence (ZOI) of A intersects the pixels of 
B or the ZOI of B intersects the pixels of A. 

This option specifies which method to use. 
If this option is TRUE, method 1) is used, otherwise, the less 
restrictive method 2) is used. The default value is TRUE. 
In situations where the objects move slowly, i.e., there’s pixel 
overlap from frame to frame, then method 1) may be better 
since it is more restrictive about possible matches. In 
situations where objects move quickly and the distance 
moved between frames is larger than the size of the object 
(no pixel overlaps), then method 2) must be used. 
 

Remove short track when 
merging 

When two objects are considered in a merge state, checking 
this option will terminate the shorter track at the merging time 
point. 
 

 

When you are done with parameter configurations, click “Next” to define track measurements. 
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3.3.1.3 Track Measurement Definitions 

There are four main categories of motility measurements. 

- Motility Measurements: 
Motility measurements are state metrics for each track point at time t. 

- Trajectory Measurements: 
Trajectory measurements are metrics for the entire track up to t. 

- Running Window Stats: 
Running window stats are track measurements within the sample window size. 

- Field Measurements 
Field measurements provide metrics for counting object overlaps for all tracks combined. 

 

Motility measurement definitions 
 

Object ID For a track at time t, the Object ID is the unique identification 
number of the object on the track at time t. 
 

Predecessor For a track at time t, the Object ID of the object on the track at time 
t-1. 
 

Successor For a track at time t, the Object ID of the object on the track at time 
t+1.  
 

X X coordinate of the track object at time t.  
 

Y Y coordinate of the track object at time t.  
 

Object size Pixel count of the track object mask at time t.  
 

Average intensity Mean of the pixel values measured in the track object mask at time 
t.  
 

Median intensity The median of the pixel values measured in the track object mask 
at time t. The median is the number separating the higher half of 
the pixel values from the lower half.  
 

Top 5% intensity The top (or high) 5% intensity value measured in the track object 
mask at time t.  
 

Top 10% intensity The top (or high) 10% intensity value measured in the track object 
mask at time t.  
 

Top 15% intensity The top (or high) 15% intensity value measured in the track object 
mask at time t.  
 

Top 20% intensity The top (or high) 20% intensity value measured in the track object 
mask at time t.  
 

State Sometimes internal states are calculated by the tracking algorithm 
and will be reported if this measurement is selected.  
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Overlap State This reports whether a mask object is touching/overlapping 
another mask object (10) or not (0). 

Velocity magnitude The displacement of the track object from t-1 to t divided by the 
time increment.  
 

Velocity angle The angle between the track object from t-1 to t. 
 

Acceleration The change in the velocity magnitude from t-1 to t. 
 

Match score This is the matching confidence over time. 1 is perfect confidence. 
As a cell touches other cells or enters into a cluster of cells its 
match score will fall.  
 

Compactness The square of the perimeter of the track object mask divided by 
the object size. 
 

Major to minor ratio The ratio of the major axis of the track object mask to the minor 
axis of the track object mask. 
 

Ellipse fitting angle Angle of fitting ellipse (of the object mask) to x axis of FOV. 
 

Max polar radius Maximum radius of the points along the mask from the origin 
(object center) when transformed in polar coordinates. 
 

Min polar radius Minimum radius of the points along the mask from the origin 
(object center) when transformed in polar coordinates. 
 

Norm mean radius Mean polar radius divided by maximum polar radius. 
 

Process count Number of peaks in the track object mask in polar coordinates. 
 

Norm process mean radius Mean of all process max polar radii, divided by the track object’s 
max polar radius. 
 

Relative process angle 
mean 

Mean of the relative process angle divided by the track object 
ellipse fitting angle.  
 

Relative process angle std The standard deviation of the relative process angles.  
 

Polar local maximum radii Local maximum radii of points along the mask centered at the 
origin when transformed into polar coordinates. A maximum of ten 
(10) local maxima may be displayed. 
 

Polar local minimum radii 
 

Local minimum radii of points along the mask centered at the 
origin when transformed into polar coordinates. A maximum of ten 
(10) local minima may be displayed. 
 

 

Trajectory measurement definitions 
 

Total Time Total time span of a track (from starting to end point) 
 

First Frame Time of the track starting point 
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Last Frame Time of the track end point 

 
Sum Vx Sum of incremental velocity in x direction over the whole track 

 
Sum Vy Sum of incremental velocity in y direction over the whole track 

 
 

SqSum Vx Sum of square of incremental velocity in x direction over the whole 
track 
 

SqSum Vy Sum of square of incremental velocity in y direction over the whole 
track 
 

Straight Line Length Length of the straight line connecting track starting and end points
 

Straight Line Velocity Straight line length divided by Total Time 
 

Total Length Total incremental distances of curvature track path 
 

Curvilinear Velocity Total Length divided by Total Time 
 

Curvature Rate Sum of angle change within the length of the track, it includes the 
sign to reflect the direction of change 
 

Track Linearity Percentage Ratio of Straight Line Velocity to Curvilinear Velocity 
 

Bounding Box Area 
 

The area of a bounding box generated from the minimum and 
maximum values of x- and y-coordinates over track lifetime. 
 

Overlapped Frame Count 
 

Total number of frames of which clustering of two masks is 
observed. 
 

Overlapped Frame 
Percentage 
 

Ratio of Overlapped Frame Count to length of image sequence. 

Non-overlapped Frame 
Count 
 

Total number of frames of which no clustering occurs. 

Non-overlapped Frame 
Percentage 
 

Ratio of Non-overlapped Frame Count to length of image 
sequence. 

Mean Overlapped Velocity 
 

Mean velocity of clustered mask objects in the overlapped state. 
 

Mean Non-overlapped 
Velocity 
 

Mean velocity of standalone mask objects. 

StdDev of Overlapped 
Velocity 
 

Standard deviation of the velocity of clustered mask objects in the 
overlapped state. 

StdDev of Non-overlapped 
velocity 
 

Standard deviation of the velocity of standalone mask objects. 
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Running window stats 
Statistics such as minimum, maximum, average, sum, difference with previous frame, and 
difference from start can be calculated for all selected measurements within the sample 
window. For example, if you select “Sum” from the running window statistics and set the 
running window to five frames, the sum of the measurement for the current and prior four 
frames will be reported. So for the “velocity magnitude” measurement in this case, sum 
(velocity magnitude) would report the total displacement of the track object of the object in the 
current and preceding four frames. 

Field measurement definitions 
 

Overlapped Count Total number of tracked objects in overlapped state. 
 

Overlapped Pct 
 

Percent of tracked objects in overlapped state in all tracked 
objects. 
 

Non-overlapped Count 
 

Total number of tracked objects in non-overlapped state. 
 

Non-overlapped Pct Percent of tracked objects in non-overlapped state in all tracked 
objects. 
 

Mean Overlapped Velocity Mean velocity of all tracked objects in overlapped state. 
 

Mean Non-overlapped 
Velocity 
 

Mean velocity of all tracked objects in non-overlapped state. 
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3.3.2 Decision Procedures 

The decision module contains CL-Quant’s next generation, teachable, phenotype classification 
tools. Decision teaching refers to creating a decision tree based classifier. This can be done 
directly in the images. Decision teaching can only begin after you have calculated measurements 
by applying a measurement procedure. Decision teaching can be done on more than one image 
simultaneously. It consists of the following steps: 

1. Create and load a decision template 

2. Create a teaching set by labeling 

3. Create a decision procedure 

 
 NOTE: 

 
  
 Decision procedure creation requires the Decision module license configuration. Decision 

procedures cannot be applied to classify trajectories. 

 
3.3.2.1 Select user image 

To start decision teaching, you will need to load a user image. Select the image you want to 
use for decision teaching by clicking on the image in the image selection dialog. Only images 
with objects can be used in the decision wizard. Click on the “Load more images” button to 
load additional images. 

 
 

 Load more images button
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3.3.2.2 Create category names 

On the “Select Category Labels” page, you can create a new decision template for teaching. 
The template labels will be saved to the decision procedure. 

Add labels to a decision template 
Here you define the names and colors for your classification categories. To create a category, 
just click on the “Add Label” icon (red circle). 

 

 
The category name can be modified, and the category can be removed (by clicking the red X 
icon under the “Add Label” icon). At least two categories are required for creating a decision 
procedure. When you are finished creating your classification categories, click “Next.” 

 
3.3.2.3 Create a teaching set by labeling 

On this page you can teach the decision tree or review previously-taught trees. In teaching 
mode, any object ROI you click on will be assigned the selected class in the control window. In 
the example below the selected class (arrow) is the Responders class. 

 

Edit Labels 
Create a teaching set by highlighting a class in the control window, and clicking on object ROIs 
(this process is called labeling). When you click on a ROI, that object is assigned the 
highlighted class. Click on the ROI a second time to un-assign the class, or you can assign the 
“None” class. You can label objects in as many FOVs as you want.  

In this example, we have labeled several representative object ROIs for each class (yellow is 
“Responders” and green is “Non-responders”). These labeled objects comprise the teaching 
set. The software will use this information to create decision rules.  

Click to 
create a 
category. 
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Edit Training Image 
You can review original image or add/remove new teaching image(s) using the options found in 
the “Edit Training Image” section beneath the decision template. 

 

 
If you are satisfied with your decision teaching, click “Next” to continue and to finish the 
decision wizard. 
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3.3.2.4 Understanding the decision tree 

The decision tree is a set of classification rules, developed using the measurements calculated 
by the measurement procedure. The decision procedure represents these rules as a decision 
tree. The tree is visible in the configuration tab of the procedure, and is easy to understand and 
explore. Specialized charts and graphs facilitate knowledge discovery. 

(1) Transparent tree structure 

The figure below shows an example decision tree. The tree is created automatically based on 
user labeling of the teaching set of objects. It creates the tree that can best distinguish the 
labeled classes. The tree is transparent and amenable to user review and update. 

 

 

In this example, the tree has three classes, “Responder”, “Non Responder”, and “Artifact”. 
The tree is able to classify the user labeled teaching set with 1.64% error. Each node in the 
tree is a rule. The rule is applied to the incoming objects. If the answer to the rule is yes, then 
the object moves down to the next node below, if the answer is no, then the object moves up 
to the next node above. The object moves through the tree in this fashion until it reaches a 
terminal node where its classification class (as opposed to its taught or labeled class) is 
assigned. Note that each class can have more than one terminal node. 

 

 

The figure above shows the first rule in the tree, Rule 78. If an object’s Cytoplasm - Nucleus 
Area difference is greater than -14.0, it will move down to the next rule, rule 23. Otherwise it 
will move up to the next rule, Rule 33. The node statistics tell you the total number of samples 
in the node, and the number belonging to each of the three classes. The order corresponds 
to the class listing at the top of the tree panel. Here, the order is “Responder”, “Non 
Responder”, then “Artifact” class. The additional 0 spots are for unused classes. Since this is 

Node statisticsContent of the rule

The tree has three classes.
Classification error rate for the 
tree is 1.64%. 

The first node of 
the tree 

One of the terminal nodes 
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top node, all the statistics for the teaching set are shown. 61 total objects were labeled, 29 
Responder class, 29 Non Responder class and 3 Artifact class. 

Clicking on any node in the tree will highlight the objects overlays on the images.  

 
 NOTE: 

 
  
 The tree only shows the classification performance on the teaching set objects where 

the truth is known. The error rate tells you how well the tree performs given that you 
know “the truth”. To ascertain the tree performance on all the FOV objects you must 
apply the procedure to the training FOVs to classify all the objects (shown below). 

 
The figure below shows one of the tree’s terminal nodes. Objects that arrive in this terminal 
node are classified as “Non Responder”. In this case, there are 23 teaching set objects in the 
node. Of these 0 were taught as “Responder”, 22 were taught as “Non Responder” and 1 was 
taught as an “Artifact” (this is the only error in the tree). 

 

 

(2) Tree charts and graphs 

The decision recipe also provides a specialized table and chart to assist with tree 
understanding. Click on the charts button at the bottom of the information panel to bring up 
the charting window. There you will see the contingency table icon and the parallel coordinate 
plot icon.  

Contingency table 

 

 
The contingency table presents the tree’s overall classification accuracy on the teaching set. 
Read from left to right along the rows, it tells you the classification error for the labeled 
teaching sets. Read from top to bottom down the columns, it tells you the classification error 
for the classes. The tree only has one misclassified object, but its error can be thought of in 
these two different ways. Reading along the row we see that of three labeled “Artifacts”, one 
was mis-classified. Reading down the column we see that of 30 classified “Non Responders”, 
one was actually an “Artifact”. 

 

To understand the error case better, we can go to the parallel coordinates plot. 

Contingency Table icon 
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Parallel plot 

 

 
You can populate the plot objects by clicking on a node in the tree. The example plot below 
shows the objects in the terminal node shown above, which contains the tree’s only error. As 
described above this node contains 23 objects classified as “Non Responders”, of these 1 
object was labeled as “Artifact”.  

The vertical bar represents the measurement used at the decision nodes leading to the 
terminal node. Since this node is in a shallow position, there are only two measurements 
used to reach it. The parallel coordinate plot enables you to see the distribution of the node 
objects with respect to the measurements. Each object is represented by a line. The “Non 
Responder” labeled objects are shown in green, and the “Artifact” object is shown in red. The 
shading on the bars represents a histogram of the entire teaching set population distribution 
for the measurement; darker shading indicates a higher frequency of occurrence.  

 

 

(3) Manual Tree Modifications 

Manual tree modifications include pruning and changing the node label. When a terminal 
node is pruned, the tree performs as if the node has been removed. However, pruned nodes 
will be recovered after save and reload. To permanently remove pruned nodes you must 
select “Remove Pruned Nodes” from the context menu.  

Right clicking on the tree will bring up the context menu for manual tree modifications as 
shown below. The first two entries will toggle the contingency table and parallel coordinate 
plot. The remaining items are described below.  

Parallel Plot icon 
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 Auto Prune 
This operation will automatically prune the tree. 

 Remove Pruned Nodes 

Will permanently remove pruned nodes. 

 Recover Pruned Nodes 
Re-activates pruned nodes to normal status.  

 Change Node Label 

Allows the user to manually re-assign a node to a different class.  

 Prune Child Nodes 
Prunes all the nodes below this one.  

 Recover Two Child Nodes 

Recovers this node’s child nodes, but their children remain pruned.  

 Recover All Sub-nodes 
All nodes below the current node are recovered.  
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  3.4 Other Procedure 

CL-Quant provides additional utility procedures such as basic enhancement procedures and 
FOV import procedures. 

 
3.4.1 FOV Import Procedure 

An FOV import procedure can be executed to either: import an FOV list from FOVs on the file 
system, or create a time-lapse FOV from image frames on the file system.  

To create the procedure, right click on the “FOV import procedures” folder in the data explore 
and select “New”. This will create a new import procedure data object. Double click on the data 
object to launch the procedure in a new window. 

The FOV import procedure has the same organization as the FOV RFrame except that the FOV 
list panel is treated differently. In the normal FOV RFrame, the FOV list panel shows the FOVs in 
an RFrame list. In this case, the panel shows the folder or images on file that will be imported to 
the channel or mask. To specify individual images or folders for importing to the FOV, simply drag 
and drop them from the Windows Explorer. Most supported image types can be used.  

For example, say you want to create a three-channel movie. On the file system you have the 
individual files arranged in folders. To create an import procedure, you simply drag and drop the 
first folder from file into the FOV list panel. The folder on file will be associated with Channel 0, 
and when you execute the procedure, images from that folder will be loaded into Channel 0. To 
create the second channel, right click on the channel strip and select “Add Channel”. Repeat the 
same steps as for Channel 0 until all the channels are created, and their import directories or 
images defined.  

You can add masks to the channels in the same way, but first be sure to click on the mask strip 
and select “Add Mask”. You’ll notice when you click on the new mask tab that the image list 
panel is now blank. After adding files from file system, the image list panel will show the images 
associated with Mask 0 (if you click on the “Channel 0” tab, it will show the images associated 
with Channel 0). To create a second mask, just right click on the mask strip and select “Add 
Mask”. Masks can be added, removed/deleted, and renamed. In addition, you may change the 
color of the mask. When the procedure is executed the imported masks will be assigned the 
selected color.  

At any time, you may click on “Clear List” or “Cancel” to erase your channel or mask import 
specification.  

 Relative path 

You may also check the “Relative path” box. In this mode, the directory structure will be 
interpreted relative to the location of the import procedure. This allows you to create movable 
procedures which do not rely on the absolute file system path. If it is kept unchecked, the 
procedure will always import files from the same absolute file path.  

 Load all channels of multi-channel images 

When you check the load all channels option, all the channels of the input images will be 
loaded. If unchecked, only the first channel of the input image will be loaded.  

 Load as FOVs 

When this option is checked, the files will be loaded into FOVs or an FOV list. If unchecked, 
they will be loaded into a single time-lapse FOV. 
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 Load as T Movie 

When this option is selected (red box) the files will be loaded into a single time-lapse FOV in T 
series. Note that the dimension of the images imported must be the same to use this option. 

 Load as Z Movie 

When this option is selected (red box) the files will be loaded into a single time-lapse FOV in Z 
series. Note that the dimension of the images imported must be the same to use this option. 

 

 

 Use folder name as field name 

In this mode, the folder name will be used for the FOV name. When multiple FOVs are 
imported as an FOV list in this mode, the name of all individual FOVs will be the same as the 
folder name. 

 Execute procedure after loading 

When this option is checked, you may select an action procedure to execute on each image 
after it is imported. An action procedure is a previously loaded procedure or procedure list that 
is already in your procedure data explore panel.  

To finalize the procedure, click “Save”. 
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No Symbol for kildesortering i europeiske land
Dette symbolet indikerer at produktet skal kildesorteres.
De nedenstående punktene gjelder for alle europeiske brukere.
• Dette produktet skal kildesorteres og innleveres til dedikerte innsam-

lingspunkter. Må ikke kastes med normalt husholdningsavfall.
• For mer informasjon, ta kontakt med din forhandler eller lokale myn-

digheter.

Se Symbol för separat upphämtning i euopeiska länder
Den här symbolen anger att produkten måste hämtas separat.
Följande gäller bara användare i europeiska länder.
• Den här produkten är avsedd för separat upphämtning vid ett lämpligt 

uppsamlingsställe. Produkten får inte kastas i hushållsavfall.
• För mer information, kontakta återförsäljaren eller de lokala myndig-

heter som ansvarar för avfallshantering.

Fi Erillisen keräyksen merkki Euroopan maissa
Tämä merkki osoittaa, että tuote kerätään erikseen.
Seuraavat maininnat koskevat vain eurooppalaisia käyttäjiä.
• Tämä tuote kerätään erikseen asianmukaisista keräyspisteistä. Älä 

hävitä tuotetta talousjätteiden mukana.
• Lisätietoja saat jälleenmyyjältä tai paikallisilta jätehuoltoviranomaisilta.

Ru Символ сортировки мусора, использующийся в европейских странах
Данный символ означает, что этот продукт должен 
утилизироваться отдельно от других.
Приведенная ниже информация касается только пользователей 
из стран Европы.
• Данный продукт должен утилизироваться отдельно от других в 

соответствующих приемных пунктах. Не выбрасывайте данный 
продукт вместе с бытовым мусором.

• Дополнительную информацию Вы можете получить у продавца 
или у местных властей, отвечающих за утилизацию мусора.

Gr Σύµ��λ� για την �ε�ωριστή απ�κ�µιδή απ�ρριµµάτων στις Ευρωπαϊκές �ώρες
Αυτ� τ� σύµ��λ� υπ�δηλώνει �τι η απ�κ�µιδή αυτ�ύ τ�υ πρ�ϊ�ντ�ς 
πρέπει να γίνει �ε�ωριστά.
Τα κάτωθι απευθύν�νται µ�ν� σε Ευρωπαί�υς �ρήστες.
• Αυτ� τ� πρ�ϊ�ν είναι σ�εδιασµέν� έτσι ώστε να γίνεται η 

απ�κ�µιδή τ�υ σε ειδικά σηµεία. Μην τ� πετάτε µα�ί µε τα 
υπ�λ�ιπα απ�ρρίµµατα.

• Για περισσ�τερες πληρ���ρίες, επικ�ινωνήστε µε τ�ν διαν�µέα 
τ�υ πρ�ϊ�ντ�ς ή µε τις υπεύθυνες τ�πικές αρ�ές για θέµατα 
δια�είρισης απ�ρριµµάτων.

Pl  Symbol oznaczający segregowanie odpadów, stosowany w krajach Europy
Ten symbol oznacza, że produkt musi być wyrzucany oddzielnie.
Poniższe uwagi mają zastosowanie tylko dla użytkowników z Europy.
• Ten produkt jest przeznaczony do oddzielnej utylizacji i powinien być 

dostarczony do odpowiedniego punktu zbierającego odpady.  Nie 
należy go wyrzucać z odpadami gospodarstwa domowego.

• Aby uzyskać więcej informacji, należy skontaktować się z 
przedstawicielem przedsiębiorstwa lub lokalnymi władzami 
odpowiedzialnymi za zarządzanie odpadami.

Hu Európai országokban érvénes “Elkülönített hulladékgyűjtés” jelzése
Ez a jelzés azt jelenti, hogy ezt a terméket elkülönítve kell gyűjteni.
Az alábbiak csak az európai országokban élő felhasználókra érvényes.
• Ezt a terméket a megfelelő hulladékgyűjtőhelyen, elkülönítve kell 

gyűjteni. Ne dobja ki háztartási hulladékként.
• További információkért forduljon a forgalmazóhoz, vagy a helyi 

hatóság hulladékgyűjtésért felelős részlegéhez.

Cz Symbol pro oddělený sběr odpadu platný v evropských zemích
Tento symbol znamená, že tento produkt se má odkládat odděleně.
Následující pokyny platí pro uživatele z evropských zemí.
• Tento produkt se má odkládat na místě sběru k tomuto účelu určeném. 

Neodhazujte spolu s domácím odpadem.
• Více informací o způsobu zacházení s nebezpečným odpadem vám 

podá příslušná místní instituce.

Jp

•

•

This symbol is provided for use in the People’s Republic of China, 
for environmental protection in the fi elds of electronic information 
products.
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住所 ／ ADDRESS 
産業機器 ／ Industrial Instruments  バイオサイエンス ／ Bioscience 

株式会社ニコン  株式会社ニコン 
〒100-8331  〒100-8331 
東京都千代田区有楽町 1-12-1 新有楽町ビル  東京都千代田区有楽町 1-12-1 新有楽町ビル 
インストルメンツカンパニー 産業機器マーケティング部 営業課  インストルメンツカンパニー バイオサイエンスマーケティング部 営業課 
電話：（03）3216-2384  電話：（03）3216-2375 
インストルメンツカンパニー 産業機器マーケティング部 販売促進課  インストルメンツカンパニー バイオサイエンスマーケティング部 販売促進課 
電話：（03）3216-2371  電話：（03）3216-2360 
   
   
株式会社ニコンインステック  株式会社ニコンインステック 
本     社  本     社 
〒100-0006  〒100-0006 
東京都千代田区有楽町 1-12-1（新有楽町ビル 4F）  東京都千代田区有楽町 1-12-1（新有楽町ビル 4F） 
電話：（03）3216-9171 （産業機器）  電話：（03）3216-9163 （バイオサイエンス） 
   
名古屋営業所  札幌営業所 
〒465-0093  〒060-0051 
名古屋市名東区一社 3-86（クレストビル 2F）  札幌市中央区南 1 条東 2-8-2（SR ビル 8F） 
電話：（052）709-6851 （バイオサイエンス・産業機器）  電話：（011）281-2535 （バイオサイエンス） 
   
関 西 支 店  仙台営業所 
〒532-0003  〒980-0014 
大阪市淀川区宮原 3-3-31（上村ニッセイビル 16F）  仙台市青葉区本町 1-1-1（三井生命仙台本町ビル 19F） 
電話：（06）6394-8802 （産業機器）  電話：（022）263-5855 （バイオサイエンス） 
   
九 州 支 店  名古屋営業所 
〒913-0034  〒465-0093 
福岡市東区多の津 1-4-1  名古屋市名東区一社 3-86（クレストビル 2F） 
電話：（092）611-1111 （バイオサイエンス・産業機器）  電話：（052）709-6851 （バイオサイエンス・産業機器） 
   
  関 西 支 店 
NIIKON INSTRUMENTS INC.  〒532-0003 
1300 Walt Whitman Road, Melvile, N.Y. 11747-3064, U.S.A.  大阪市淀川区宮原 3-3-31（上村ニッセイビル 16F） 
tel. +1-631-547-8500  電話：（06）6394-8801 （バイオサイエンス） 
   
NIKON INSTRUMENTS EUROPE B.V.  九 州 支 店 
Tripolis 100, Burgerweeshuispad 101, 1076 ER Amsterdam,  〒913-0034 
The Netherlands  福岡市東区多の津 1-4-1 
tel. +31-20-7099-000  電話：（092）611-1111 （バイオサイエンス・産業機器） 
   
NIKON INSTRUMENTS(SHANGHAI)CO.,LTD.   
tel. +86-21-6841-2050  NIIKON INSTRUMENTS INC. 
  1300 Walt Whitman Road, Melvile, N.Y. 11747-3064, U.S.A. 
NIKON SINGAPORE PTE LTD  tel. +1-631-547-8500 
tel. +65-6559-3618   
  NIKON INSTRUMENTS EUROPE B.V. 
NIKON MALAYSIA SDN BHD  Tripolis 100, Burgerweeshuispad 101, 1076 ER Amsterdam, 
tel. +60-3-7809-3688  The Netherlands 
  tel. +31-20-7099-000 
NIKON INSTRUMENTS KOREA CO.,LTD.   
tel. +82-2-2186-8410  NIKON INSTRUMENTS(SHANGHAI)CO.,LTD. 
  tel. +86-21-6841-2050 
NIKON INDIA PRIVATE LIMITED   
tel. +91-124-4688500  NIKON SINGAPORE PTE LTD 
  tel. +65-6559-3618 
NIKON CANADA INC.   
tel. +1-905 602 9676  NIKON MALAYSIA SDN BHD 
  tel. +60-3-7809-3688 
NIKON FRANCE S.A.S.   
tel. +33-1-4516-45-16  NIKON INSTRUMENTS KOREA CO.,LTD. 
  tel. +82-2-2186-8410 
NIKON GMBH   
tel. +49-211-941-42-20  NIKON INDIA PRIVATE LIMITED 
  tel. +91-124-4688500 
NIKON INSTRUMENTS S.p.A.   
tel. +39-55-3009601  NIKON CANADA INC. 
  tel. +1-905 602 9676 
NIKON AG   
tel. +41-43 277-28-67  NIKON FRANCE S.A.S. 
  tel. +33-1-4516-45-16 
NIKON UK LTD.   
tel. +44-208-247-1717  NIKON GMBH 
  tel. +49-211-941-42-20 
NIKON GMBH AUSTRIA   
tel. +43-1-972-6111-00  NIKON INSTRUMENTS S.p.A. 
  tel. +39-55-3009601 
NIKON BELUX   
tel. +32-2-705-56-65  NIKON AG 
  tel. +41-43 277-28-67 
NIKON METROLOGY, INC.   
12701 Grand River Avenue, Brighton, MI 48116 U.S.A.  NIKON UK LTD. 
tel. +1-810-220-4360  tel. +44-208-247-1717 
sales_us@nikonmetrology.com   
  NIKON GMBH AUSTRIA 
NIKON METROLOGY EUROPE NV  tel. +43-1-972-6111-00 
Geldemaaksebaan 329, 3001 Leuven, Belgium   
tel. +32-16-74-01-00  NIKON BELUX 
sales_europe@nikonmetrology.com  tel. +32-2-705-56-65 
   
NIKON METROLOGY GMBH   
tel. +49-6023-91733-0   
sales_germany@nikonmetrology.com   
   
NIKON METROLOGY SARL   
tel. +33-1-60-86-09-76   
sales_france@nikonmetrology.com   
   
NIKON METROLOGY UK LTD.   
tel. +44-1332-811-349   
sales_uk@nikonmetrology.com   
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